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C H A P T E R  1  

Introduction 

Parallels Workstation Extreme enables you to use the hardware resources of your Intel-based 
Windows® or Linux® computer more efficiently by sharing them between multiple virtual 
machines running on it. 

In This Chapter 
About Parallels Workstation Extreme................................................................................... 8 
About This Guide.................................................................................................................. 9 
Getting Help .......................................................................................................................... 11 
Feedback ............................................................................................................................... 11 
Acknowledgements ............................................................................................................... 12
 
 

 



 Introduction 8 
 

About Parallels Workstation 
Extreme 

Parallels Workstation Extreme is a virtualization solution that enables you to create virtual 
machines on computers with Intel® processors (1.66 GHz and faster) and a Windows or Linux 
operating system installed. You can install a Windows, Linux, or another supported guest 
operating system in each of your virtual machines and work with them and their applications 
side by side with the applications of the primary operating system installed on the physical 
computer. 

When installed on computers with Intel VT-d support, Parallels Workstation Extreme can even 
better utilize the physical hardware by allowing virtual machines to use their own physical PCI 
Express (PCIe) devices without sharing them with the host computer. The VT-d hardware 
assistance built into Intel's chipsets enables you to assign physical devices directly to the virtual 
machine, making them invisible to the host computer they are physically plugged into. Owing to 
this technology, Parallels virtual machines can achieve a very high level of performance. 

 

Built on Parallels’ hypervisor-based virtualization technology, Parallels Workstation Extreme 
enables you to: 

 create powerful and easy-to-use virtual machines 
 use Windows and Linux applications side by side with the primary operating system 

applications 
 directly connect PCIe graphical and network cards to your virtual machines (if your host 

computer's processor supports the Intel VT-d technology) 

To enhance your experience of running more than one operating system on your physical 
computer, Parallels Workstation Extreme includes several add-on utilities: 

 Parallels Transporter® for migrating physical computers and third-party virtual machines to 
Parallels virtual machines 

 Parallels Image Tool for maintaining the capacity and other properties of your virtual hard 
disks 

 Parallels Compressor® for compressing the data stored on Windows virtual hard disks 
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About This Guide 
This Guide is aimed at a wide range of users who want to use Parallels Workstation Extreme to 
create, configure, and run Parallels virtual machines. 

Abbreviations used in the text 

In the present guide, the following abbreviations are used: 

 OS is used instead of operating system in long sentences where using it will not change the 
meaning of the sentence. 

 VM is used instead of virtual machine  in long sentences where using it will not change the 
meaning of the sentence. 

Definitions 

Primary operating system (primary OS): In this Guide this term is used to refer to the operating 
system that controls the I/O devices of the computer and that is loaded when the physical 
computer is turned on. 

Guest operating system (guest OS): The term is used to refer to an operating system that runs 
under the virtual machine control. 
 

Organization of This Guide 
This guide is organized into the following chapters: 

 Introduction (p. 7) (you are reading it now). Provides basic information about the product 
and this guide. 

 Virtual Machine Technology Basics (p. 13). Provides information on the specification and 
technologies of virtual machines. 

 Installing Parallels Workstation Extreme (p. 16). Provides instructions on product installation. 
 Principles of Working With Parallels Workstation Extreme (p. 30). Provides basic information 

on how to work with Parallels Workstation Extreme. 
 Setting Up a Virtual Machine (p. 57). Provides instructions on creating a new virtual machine, 

adding an existing one, and installing Parallels Tools in guest OSs. 
 Working in a Virtual Machine (p. 84). Provides basic information on how to work with virtual 

machines. 
 Configuring a Virtual Machine (p. 109). Provides information on how to change the virtual 

machine configuration. 
 Managing Virtual Machines (p. 178). Provides basic information on how to manage your 

virtual machines. 
 Using Parallels Add-ons (p. 196). Provides information on how and when you can use 

Parallels Transporter, Parallels Compressor, and Parallels Image Tool. 
 Troubleshooting and Limitations (p. 208). Provides the solutions for some of the known 

issues. 
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Documentation Conventions 
Before you start using this guide, it is important to understand the documentation conventions 
used in it. 

The table below presents the existing formatting conventions. 

Formatting convention Type of Information Example 
Items you must select, such as 
menu options, command 
buttons, or items in a list. 

Go to the Resources tab.  

Special Bold 

 Titles of chapters, sections, and 
subsections. 

Read the Basic Administration chapter. 

Italics Used to emphasize the 
importance of a point, to 
introduce a term or to designate 
a command-line placeholder, 
which is to be replaced with a 
real name or value. 

These are the so-called EZ templates. 

To destroy a Container, type vzctl 
destroy ctid. 

Monospace The names of commands, files, 
and directories. 

Use vzctl start to start a 
Container. 

Preformatted On-screen computer output in 
your command-line sessions; 
source code in XML, C++, or 
other programming languages. 

Saved parameters for Container 
101 

Monospace Bold What you type, as contrasted 
with on-screen computer 
output. 

# rpm –V virtuozzo-release 

Key+Key Key combinations for which 
the user must press and hold 
down one key and then press 
another. 

Ctrl+P, Alt+F4 

Besides the formatting conventions, you should also know about the document organization 
convention applied to Parallels documents: chapters in all guides are divided into sections, 
which, in their turn, are subdivided into subsections. For example, About This Guide is a section, 
and Documentation Conventions is a subsection. 
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Getting Help 
Parallels Workstation Extreme offers several options for accessing the necessary information: 

 Parallels Workstation Extreme User's Guide. This document contains extensive information 
about the product, its usage and, troubleshooting. You can access the guide by choosing 
Parallels Workstation Extreme Help from the Parallels Workstation Extreme Help menu. 

 Online documentation. The PDF documentation for Parallels Workstation Extreme and 
other Parallels products, such as Parallels Transporter, Parallels Image Tool, and Parallels 
Compressor. To open the online documentation page, choose Online Documentation from the 
Help menu. 

 Parallels Command Line Reference Guide. This document contains information on using the 
prlctl command line utility designed to manage Parallels Workstation Extreme and its 
virtual machines from command line. To access the document, go to the Online 
documentation (http://www.parallels.com/products/desktop/stm40_docs-en_US) page on our 
website. 

 Parallels API references and the SDK programmer's guide. These guides are aimed at IT-
professionals mainly and can be found on the Online documentation 
(http://www.parallels.com/products/desktop/stm40_docs-en_US) page on our website. 

 Context-sensitive help. You can open a help page for the active window by pressing F1. 
 Parallels website (http://www.parallels.com). Explore the Support web page that includes 

product help files and the FAQ section. 
 Parallels Knowledge Base (http://kb.parallels.com/). This online resource comprizes 

valuable articles about using Parallels Workstation Extreme and other Parallels products. 
 

Feedback 
If you spot a typo in this guide, or if you have thought of a way to make this guide better, you 
can share your comments and suggestions with us by completing the feedback form at the 
Parallels documentation feedback page (http://www.parallels.com/en/support/usersdoc/). 

 

 
 

 

http://www.parallels.com/products/desktop/stm40_docs-en_US
http://www.parallels.com/products/desktop/stm40_docs-en_US
http://www.parallels.com/
http://kb.parallels.com/
http://www.parallels.com/en/support/usersdoc/
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C H A P T E R  2  

Virtual Machine Technology Basics 

This chapter provides a brief description of Parallels virtual machines, their specifications, and 
the underlying technologies. 

In This Chapter 
Virtual Machine Technology Overview................................................................................ 13 
Parallels Virtual Machine...................................................................................................... 14
 
 

Virtual Machine Technology 
Overview 

The Parallels Workstation Extreme software is based on the virtual machine technology that 
allows you to share the hardware resources of the physical computer between the primary 
operating system (the operating system installed on this physical computer) and multiple virtual 
machines running on this computer. 

The virtual machine technology can be successfully used on computers that support the Intel 
virtualization technology (Intel VT-x). This technology allows Parallels Workstation Extreme to 
emulate virtual processors inside virtual machines. 

Intel VT-x implemented in the architecture of the new Intel processors is specially developed for 
platforms running multiple operating systems. VT-x processors allow more precise emulation of 
virtual processors. To learn more about Intel virtualization technology, visit the Intel website. 
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Parallels Virtual Machine 
Taking the best from the virtual machine and Intel virtualization technologies, Parallels 
Workstation Extreme enables you to create virtual machines with a variety of virtual hardware 
devices. 

A Parallels virtual machine works like a stand-alone computer with the following hardware: 

CPU Up to 12-core Intel CPU 

Motherboard Intel i965 chipset based motherboard 

RAM 

Up to 64 GB of RAM 

 

Video Adapter VGA and SVGA with VESA 3.0 compatible Video Adapter 

Video RAM Up to 256 MB of Video RAM 

Floppy Disk Drive 
1.44 MB Floppy Disk Drive mapped to an image file or to a 
physical floppy drive. 

IDE Devices Up to 4 IDE devices 

 Hard Disk Hard Disk Drive mapped to an image file (up to 2 TB each) 

 CD/DVD-ROM Drive 
CD/DVD-ROM drive mapped to a physical drive or to an 
image file 

SCSI Devices Up to 15 SCSI devices 

 Hard Disk Hard Disk Drive mapped to an image file (up to 2 TB each) 

 Generic SCSI Device Generic SCSI device 

Network Interfaces 
Up to 16 Network interfaces: including Ethernet virtual 
network card compatible with RTL8029 

Serial (COM) Ports 
Up to 4 Serial (COM) ports, mapped to a socket or to an 
output file 

Parallel (LPT) Ports 
Up to 3 Parallel (LPT) ports, mapped to output file, to a real 
port, or to a printer 

Sound Card AC'97-compatible Sound Card, sound recording support 

Keyboard Generic PC keyboard 

Mouse PS/2 wheel mouse 
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USB Up to 8 USB 2.0 and up to 8 USB 1.1 devices 

PCIe via VT-d Up to 8 PCIe devices: video or network adapters 

Each virtual machine is stored in the primary OS as a bundle of files (.pvm) that contains the 
virtual machine configuration file (.pvs), the virtual hard disk file (.hdd), and other files of the 
virtual machine. 

A virtual machine may have the following files: 

.pvm A bundle that contains the virtual machine files. 

.pvs A virtual machine configuration file. It defines hardware and resources 
configuration of a virtual machine. The configuration file is generated 
when the virtual machine is created. 

.sav A file created when the virtual machine is suspended. It contains the 
state of the virtual machine and its applications for the moment the 
suspend was invoked. 

.mem A file containing memory dump for the suspended virtual machine. For 
a running virtual machine, it is a temporary virtual memory file. 

.hdd A bundle of files that represents a virtual hard disk of a Parallels virtual 
machine. When you create a virtual machine, you can create it with a 
new virtual hard disk or use an existing one. 

.iso An image file of a CD or DVD disc. Virtual machines treat ISO images 
as real CD/DVD discs. 

 

.fdd A floppy disk image file. Virtual machines treat FDD images as real 
diskettes. 

If you install a Windows guest OS in the Express Windows installation 
mode, Parallels Workstation Extreme creates the unattended.fdd 
floppy disk image file and places it to the virtual machine folder. The 
file is required for Windows Server 2003, Windows XP, and Windows 
Vista installation. 

.txt Output files for serial and parallel ports. The output .txt files are 
generated when a serial or parallel port connected to an output file is 
added to the virtual machine configuration. 
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C H A P T E R  3  

Installing Parallels Workstation Extreme 

This chapter lists the system requirements and provides all the information required to install 
Parallels Workstation Extreme in Linux or Windows operating systems. 

In This Chapter 
System Requirements............................................................................................................ 17 
Installing Parallels Workstation Extreme.............................................................................. 18 
Activating Parallels Workstation Extreme............................................................................ 24 
Updating Parallels Workstation Extreme.............................................................................. 25 
Removing Parallels Workstation Extreme ............................................................................ 28
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System Requirements 
Before installing Parallels Workstation Extreme, please make sure that your computer complies 
with the hardware and software requirements listed here. 

Hardware Requirements 
 Minimum 1.66 GHz x64 (64-bit) CPU with the Intel VT-x hardware virtualization 

technology support. 

Note: To be able to assign PCI Express (PCIe) devices directly to your virtual machines, 
you will need a processor that supports the Intel VT-d technology. 

The support for Intel VT-x and VT-d may be disabled by default in some computers that 
actually support Intel VT-x and VT-d. To enable these features, you should usually enter 
BIOS, go to System Settings > Virtualization Support, and select the Enable Intel 
Virtualization and Enable Intel VT for Direct I/O checkboxes. 

For detailed infomation on enabling the Intel VT-x and VT-d features in BIOS, please refer 
to the OEM supplier's documentation. 

 2 GB RAM minimum. 4 GB RAM or more is recommended. 
The recommended amount of memory assigned to a virtual machine is 1-2 GB (you can 
assign up to 64 GB of RAM). 

 200 MB of hard disk space for the Parallels Workstation Extreme installation. 
 About 30 GB of hard disk space for each virtual machine. 

To store a virtual machine's temporary files, you need to have twice as much free disk space 
as the overall amount of this virtual machine's memory (memory + video memory) +150 
MB. 

 CD-ROM or DVD-ROM drive (optional). 
 Ethernet network adapter. 

If you want to use a directly connected PCIe video card in your virtual machine, you will also 
need: 

 Two PCIe video cards. One video card for your host computer and the other – for the virtual 
machine. 
Parallels Workstation Extreme officially supports the NVIDIA Quadro® FX 3800, 4800, and 
5800 video cards for virtual machines. For these video cards, use the latest drivers (starting 
from 182.65 for Windows and 180.51 for Linux) available on the manufacturer's website. 

Direct assignment of PCIe video cards requires an NVIDIA Video BIOS version of 
62.00.62.00.01 or later. If you have a supported video card which does not have this BIOS 
level, please contact your OEM supplier. 

Software Requirements 

Parallels Workstation Extreme officially supports host computers with the following operating 
systems installed. 

64-bit operating systems 
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 Windows 7 
 Windows Vista SP2 
 Windows XP SP2 
 RHEL 5.3 

In Linux operating systems, make sure the following software packages are installed: 

 kernel development packages 

Note: In RedHat-based systems, such packages are called kernel-
<kernel_version>-devel, in Debian-based systems - linux-headers-
<kernel_version>. 

 gcc of the version with which the host kernel was compiled 
 32-bit version of glibc 2.3.6 or later 
 make or gmake 

For 64-bit systems, it is also desired to have 32-bit alsa-lib installed in RedHat-based systems or 
lib32asound in Debian-based systems. 

If you do not have any of the aforementioned packages installed on your Linux-based physical 
computer, the Parallels Workstation Extreme installer will try to install it automatically. 
 

Installing Parallels Workstation 
Extreme 

This section contains complete information about installing Parallels Workstation Extreme in 
any of the supported Windows and Linux operating systems. 
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Installing Parallels Workstation Extreme in Windows 
Before installing Parallels Workstation Extreme on a Windows computer, make sure that it 
complies with the system requirements (p. 17). 

Note: You must have administrator's rights to install Parallels Workstation Extreme in a 
Windows operating system. 

To install Parallels Workstation Extreme in Windows, you will need the Parallels Workstation 
Extreme setup file. The setup file is available: 

 in the Parallels Workstation Extreme installation package that can be downloaded from the 
Parallels website 

 on the Parallels Workstation Extreme installation disc included in the boxed version of 
Parallels Workstation Extreme 

To install Parallels Workstation Extreme in Windows: 

1 Locate the ParallelsWorkstationExtreme-4.0.xxxx.xxxxxx.exe file and 
open it. 

2 Parallels Workstation Extreme will connect to the Parallels update server and check for 
available updates. If there is a newer version of Parallels Workstation Extreme available, 
you will be offered to install the most recent version of Parallels Workstation Extreme. If 
you do not want to install the most recent version, you may choose to install the version 
from the installation media. 

 If you click Install existing version, Parallels Workstation Extreme will be installed from 
the installation media. 

 If you click Download and install new version, the latest version of Parallels Workstation 
Extreme will be downloaded and installed on your computer. 

If there are no updates available or your host computer is not connected to the Internet, 
Parallels Workstation Extreme will be installed from the current installation source. 

3 In the installation wizard Welcome window, click Next. 
4 In the License Agreement window, read carefully the entire agreement. Select I accept the 

terms in the license agreement, and click Next. 
You may print the license agreement for your records using the Print button. 
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5 In the Customer Experience Program window, you can choose to participate in the program 

that will help us improve Parallels Workstation Extreme according to your experience. Read 
carefully the information about the program and decide whether you want to participate in it 
or not. Click Next when finished. 
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6 In the Destination Folder window, specify the folder where Parallels Workstation Extreme 
will be installed and click Next. If you do not want to install to the default folder, click the 
Change button to specify another one. 

Note: Parallels Workstation Extreme must be installed on the boot volume. 

 
7 In the Ready to Install the Program window, click Install to start the Parallels Workstation 

Extreme installation or click Back to return to the previous steps. 

8 You can see the installation progress shown in the Installing Parallels Workstation Extreme 
window. 

9 When Parallels Workstation Extreme is installed, the Setup Wizard Completed window 
appears. Click Finish to exit the installer. 
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Installing Parallels Workstation Extreme in Linux 
Before installing Parallels Workstation Extreme on a Linux computer, make sure that the 
packages and libraries listed in the system requirements (p. 17) for Linux primary OSs are 
installed in your system. 

Note: You must have the root privileges to be able to install Parallels Workstation Extreme in 
a Linux operating system. 

To install Parallels Workstation Extreme in Linux, you will need a RUN installation package. 
The RUN package is available: 

 in the Parallels Workstation Extreme installation package that can be downloaded from the 
Parallels website 

 on the Parallels Workstation Extreme installation disc included in the boxed version of 
Parallels Workstation Extreme 

To install Parallels Workstation Extreme in Linux: 

1 Double-click the Parallels Workstation Extreme RUN package. This will open a terminal 
and start the installation. 

2 Parallels Workstation Extreme will connect to the Parallels update server and check for 
available updates. If there is a newer version of Parallels Workstation Extreme available, 
you will be offered to install the most recent version of Parallels Workstation Extreme. If 
you do not want to install the most recent version, you may choose to install the version 
from the installation media. 

Note: If the host computer is accessing the Internet only via a proxy server, configure the 
proxy server settings to allow Parallels Workstation Extreme to check for available updates 
during the installation process. For more information on how to configure the proxy server 
settings, refer to the Troubleshooting subsection below. 

 If you click Next, the most recent version of Parallels Workstation Extreme will be 
downloaded and installed. 

 If you click Cancel, Parallels Workstation Extreme will be installed from the current 
installation media. 

If there are no updates available or your host computer is not connected to the Internet, 
Parallels Workstation Extreme will be installed from the current installation source. 

3 The Parallels Workstation Extreme Installation wizard starts. In the Welcome screen, click 
Next.  

4 In the License Agreement screen, read the license agreement scrolling it by pressing 
Spacebar on your keyboard. To accept the agreement, click the Accept button. 

5 In the CEP Agreement screen, you can choose to participate in a program that will help us 
improve Parallels Workstation Extreme according to your experience. Read carefully the 
information about the program and click the Yes button if you want to participate in it. 
Otherwise click No. 

6 When the installation is completed, the Parallels Workstation Extreme Installation completed 
screen appears. Click the Exit button to close the wizard.  

7 To exit the terminal, enter: 
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exit 

Troubleshooting 

If the host computer is accessing the Internet only via a proxy server, you should configure the 
proxy server settings to allow Parallels Workstation Extreme to check for available updates 
during the installation process. To this effect, begin the Parallels Workstation Extreme 
installation as follows: 

1 Launch a terminal, locate the Parallels Workstation Extreme installation package, and 
execute the following command to start the installation: 

sudo ./parallels-workstation-extreme-4.0.xxxx.xxxxxx.run -- -p 
proxy_server_host_name:port 

or 
sudo ./parallels-workstation-extreme-4.0.xxxx.xxxxxx.run -- -p ip_address:port 

where proxy_server_host_name stands for the proxy server host name, 
ip_address stands for the proxy server IP address, and port stands for the proxy server 
port. 

2 Continue the installation as it was described above. 

If the proxy-server requires authentication, you will be prompted to enter your name and 
password in one of the steps. 

 

 



 Installing Parallels Workstation Extreme 24 
 

Activating Parallels Workstation 
Extreme 

To fully run Parallels Workstation Extreme, you should activate it with an activation key. If you 
purchased a boxed version of the program, you can find the activation key printed on the 
installation CD sleeve. If you purchased the program online, the activation key was sent to your 
e-mail. If you downloaded a copy of Parallels Workstation Extreme to evaluate it before buying, 
you can get a trial activation key valid for a certain period of time. 

After you activate your copy of Parallels Workstation Extreme, you can run virtual machines, 
install operating systems and various applications in them. 

Activating Your Copy of Parallels Workstation Extreme 

To activate Parallels Workstation Extreme: 

1 Choose Activate Product from the Help menu. 

2 In the Activate Product dialog, specify your name and your company name in the Name and 
Organization fields (optional) and type the activation key into the Product Key field: 

 To get a trial activation key, click the free trial activation key link. 

 To buy a permanent activation key, click purchase a permanent activation key. 

 
Click OK when finished. 

Now that your copy of Parallels Workstation Extreme is activated, you can create virtual 
machines, install operating systems in them, and work with the virtual machines' applications 
side by side with the applications of your primary OS. 
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Updating Parallels Workstation 
Extreme 

Parallels Workstation Extreme includes an updating feature that helps you keep your Parallels 
Workstation Extreme installation up-to-date. You can use the update feature only if your 
computer is connected to the Internet. 

Update checks can be performed either automatically or manually. 

 We recommend that you turn on automatic updating to be notified when an update is 
available. Parallels Workstation Extreme will regularly check for updates available and 
inform you about them. 

 In addition to automatic updating, you can start the updating manually at any time. 

Note: To be able to update Parallels Workstation Extreme in a Linux primary operating system, 
you must have root privileges or be a sudo user. To update Parallels Workstation Extreme in 
a Windows primary operating system, you must have administrator or power user rights or just 
know the administrator or power user name and password and provide them when prompted. 
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Automatic Updating 
To use the automatic updating feature, your host computer should have a stable Internet 
connection. 

Parallels Workstation Extreme enables you to set up an automatic check for updates and 
determine the frequency for this checking. 

To set up automatic update checking: 

1 Launch Parallels Workstation Extreme. 

2 In the File menu select Preferences and go to the Update pane. 

3 In the Update pane, you can define the necessary settings. To set up automatic checking for 
new versions, just select the Check for updates option and define the checking frequency. 
The system can search for new updates once a day, once a week, or once a month. With 
these options set, Parallels Workstation Extreme will access the Parallels update server and 
notify you when an update is available. If you do not need automatic checking, you can 
easily turn it off by clearing the Check for updates check box. 

Checking for new updates may take some time and, if you do not want to have the process 
window on top of your desktop, you can hide it to the background. To do that, enable the 
Check in background option. 

Select the Download updates automatically option if you want all new available updates to be 
downloaded at once without showing you the Download dialog. 

From the Update pane, you can also perform a manual instant search for updates. To do that, 
just click the Check Now button. The updates available for your version of Parallels 
Workstation Extreme will be displayed in the Download dialog. Choose the update(s) you 
want to install and click the Download button. If your version of Parallels Workstation 
Extreme is up to date, you will see the corresponding message. 

 
4 When you finish, click OK to save the changes and close the dialog. 
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Manual Updating 
Parallels Workstation Extreme also enables you to check for updates manually whenever you 
want. 

To check for updates manually: 

1 Launch Parallels Workstation Extreme. 

2 From the Help menu, choose Check for Updates. The program will immediately start the 
search for updates. 

While the updater accesses the Parallels update server and compares the available updates 
with the installed version, you can hide this window by selecting Check in background. 

3 If there is one or more updates available, they will be listed in the Parallels Update window. 
Select the update to install and click Install. 
You can also download the update by clicking the Download button. To change the 
download folder, type the path into the Download folder field or use the Choose button to 
locate the folder. 

Note: You can install the downloaded update later by locating it in the download folder and 
launching the installer. 

4 Click OK to start the installation. 

5 Follow the Parallels Workstation Extreme installer's instructions to install the update. 

Note: If the installer displays a list of conflicting applications, quit these applications to be 
able to proceed with the installation. 

6 When the update is installed, click Close to quit the installer. 
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Removing Parallels Workstation 
Extreme 

Uninstalling Parallels Workstation Extreme does not delete any files that have been created 
using Parallels Workstation Extreme, such as configuration files, virtual hard disks, floppy 
.fdd images, and serial or parallel port output files. 

In Windows 

Note: You must have power user or administrator rights to uninstall Parallels Workstation 
Extreme in a Windows primary operating system. 

The procedure may be slightly different in different Windows versions. To remove Parallels 
Workstation Extreme follow these steps: 

1 Open the Windows Start menu, select Control Panel, select Add /Remove Programs, and then 
select Parallels Workstation Extreme. 

2 Click the Remove button to begin uninstalling. 

3 Click Yes when prompted: "Are you sure you want to remove Parallels 
Workstation Extreme from your computer?" 

If you purchased the program from the Parallels Online store 
(http://www.parallels.com/en/buyonline) or downloaded a trial version, you can also remove 
Parallels Workstation Extreme with the help of the ParallelsWorkstationExtreme-
4.0.xxxx.xxxxxx.exe file. Just locate this file and open it. The wizard will lead you 
through the process of deinstallation. 

In Linux 

Note: To uninstall Parallels Workstation Extreme in a Linux primary operating system you need 
the root privileges. 

To uninstall Parallels Workstation Extreme in Linux: 

1 Launch a terminal. 

2 To gain the root privileges, enter the following command: 
su 

Enter the password for the root account when prompted. 

3 Locate the parallels-workstation-extreme-4.0.xxxx.xxxxxx.run file that 
you used during the Parallels Workstation Extreme installation and issue the next command: 

sh parallels-workstation-extreme-4.0.xxxx.xxxxxx.run 

4 The Parallels Workstation Extreme Installation wizard starts. In the welcome screen, click 
Next.  

5 In the Upgrade Components screen, click the Remove button. 

 

http://www.parallels.com/en/buyonline
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6 When the uninstallation is completed, the Parallels Workstation Extreme Uninstalation 
completed screen appears. Click the Exit button to close the wizard. 
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C H A P T E R  4  

Principles of Working With Parallels 
Workstation Extreme 

This chapter provides basic information about how to work with Parallels Workstation Extreme. 

In This Chapter 
Starting Parallels Workstation Extreme ................................................................................ 30 
Interface Basics ..................................................................................................................... 31 
Setting Parallels Workstation Extreme Preferences.............................................................. 38 
Using Multiple Displays ....................................................................................................... 54
 
 

Starting Parallels Workstation 
Extreme 

To start Parallels Workstation Extreme in Windows: 

 From the Windows Start menu, choose Programs > Parallels > Parallels Workstation Extreme 
> Parallels Workstation Extreme. 

 You can also start Parallels Workstation Extreme by double-clicking its icon on the desktop. 

To start Parallels Workstation Extreme in Linux: 

 From the Applications menu, choose System Tools > Parallels Workstation Extreme. 
 Enter the following command in a terminal: 
parallels-workstation 
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Interface Basics 
When you launch Parallels Workstation Extreme, the Parallels Workstation Extreme window 
opens. The Parallels Workstation Extreme window consists of several parts: 

Menus - contain all the controls available for Parallels Workstation Extreme and its virtual 
machines. For detailed information, see the Menus subsection (p. 32). 

Toolbar - comprises buttons that can be used to manage the virtual machine and its appearance. 
For detailed information, see the Toolbar subsection (p. 33). 

Sidebar - contains the list of all virtual machines registered in Parallels Workstation Extreme. If 
you right-click a virtual machine name in the list, you can use a set of commands for managing 
the virtual machine from the virtual machine context menu. 

Virtual Machine window - acts as the virtual machine display or shows the properties and main 
operations of the virtual machine you selected in the sidebar. It consists of three tabs: 

 The Summary tab displays the main information about the virtual machine (its name, 
location, OS, state and description), the main operations you can perform on it, and the 
virtual machine configuration. This tab is always available. 

 The Console tab is available when the virtual machine is running and acts as the virtual 
machine's display. 

 The Performance tab shows the CPU and memory usage when the virtual machine is 
running. 

Status Bar - displays the devices information when the virtual machine is running. For detailed 
information, see the Status Bar subsection (p. 36). 
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Menus 
The Parallels Workstation Extreme menus contain all the controls available for Parallels 
Workstation Extreme and its virtual machines. 

There are the following menus: 

 The File menu allows you to: 
 create a new virtual machine (p. 57) 

 add an existing virtual machine to Parallels Workstation Extreme (p. 70) 

 remove the virtual machine from the Parallels Workstation Extreme sidebar (p. 181) 

 delete the virtual machine (p. 182) 

 download Parallels Virtual Appliances (p. 83) 

 clone the virtual machine (p. 179) 

 clone the virtual machine to a template (p. 186) 

 convert the virtual machine to a template (p. 186) 

 deploy the template to a virtual machine (p. 188) 

 convert the template to a virtual machine (p. 188) 

 quit Parallels Workstation Extreme 

The Run Parallels Transporter command allows you to migrate the information from other 
computers or virtual machines with the help of Parallels Transporter. This menu also lets 
you set Preferences (p. 38). 

 The View menu includes commands for switching between different view modes: the Full 
Screen and Window mode. You can also customize how you view the Parallels Workstation 
Extreme window, enable or disable automatic changes of the virtual machine screen 
resolution, and make screenshots of the guest OS window. 

 The Virtual Machine menu allows you to: 
 manage the virtual machine (p. 84) 

 edit the virtual machine configuration (p. 109) 

 install Parallels Tools (p. 74) 

 update Parallels Tools (p. 81) 

 launch Parallels Compressor (p. 204) 
 The Devices menu is available only when the virtual machine is running. It allows you to 

configure certain devices and shared folders at runtime. 
 The Window menu allows you to choose the application window you want to appear on top. 

This menu simplifies the navigation between the virtual machines. 
 The Applications menu enables you to manage certain elements of the Windows desktop 

such as the Start menu, the Windows taskbar and recycle bin. 

Note: The Applications menu is available only for Windows XP or Windows Vista guest 
OSs. 

 The Help menu allows you to: 
 open Parallels Workstation Extreme Help 
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 activate Parallels Workstation Extreme (p. 24) 

 check for updates (p. 27) 

 report problems (p. 209) 

It also displays the About Parallels Workstation Extreme dialog. 
 

Toolbar 
The Parallels Workstation Extreme toolbar has buttons for the most frequent commands used to 
start, stop, and otherwise manage a virtual machine and its window appearance. 

Most of the toolbar buttons become enabled only when you start the virtual machine. If you 
click a toolbar button, it becomes visibly pressed. 
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The default toolbar buttons: 

 Start. Use this button to start the virtual machine if it is stopped, paused or suspended. 

 Shut Down. Use this button to shut down your guest OS correctly. 

 Suspend. Use this button to put your virtual machine into the sleep mode for a certain 
period of time. If you need to restart the host computer, you may temporarily suspend your 
virtual machines and easily resume them after the restart. 

 Detach Console. Use this button to show the Console tab of the Parallels Workstation 
Extreme window in a separate window. 

 Full Screen. Use this button to switch the virtual machine to the Full Screen mode. To 
return back to the Window mode, press Alt+Enter. The key combination for switching to the 
Full Screen mode and back can be changed in the Preferences dialog available from the File 
menu. 

You can easily add other buttons to the toolbar: just right-click the toolbar, choose Customize 
Toolbar (p. 35) from the shortcut menu, and drag the items you need to the toolbar: 

 Restart. Use this button to restart the fully loaded guest operating system. 

 Pause. Use this button to pause the virtual machine. Use this button when you need to 
instantly release the primary OS resources used by this virtual machine. 

 Stop. Use this button to stop the virtual machine in cases when the machine does not run 
properly and prevents you from shutting it down. 

Note: If you click this button when the virtual machine is running, you may lose all the unsaved 
data. To turn off the virtual machine, use the shutdown procedure specified for the guest OS 
installed in it or use the Shut Down button. 

 Reset. Use this button for hard reset of your virtual machine in cases when the machine 
does not run properly and prevents you from resetting it properly. 

 Safe Mode. Use this button to run the virtual machine in Safe Mode (p. 105). 
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 Configure. Use this button to open the Virtual Machine Configuration dialog (p. 109). 

If you often work with snapshots, you can drag any of the three snapshot buttons to the toolbar 
as well: 

 Take Snapshot. Use this button to create a snapshot for the virtual machine. 

 Revert to Snapshot. Use this button to roll back the changes made to the virtual machine 
since the moment the last snapshot was made. 

 Snapshot Manager. Use this button to open Snapshot Manager. For more information, 
refer to the Working with Snapshots section (p. 191). 
 

Customizing Toolbar 

To change the appearance of the toolbar items, right-click the toolbar and use the shortcut menu 
commands: 

 Icon & Text. Use this command if you want the toolbar to display both the button icons and 
their names. 

 Icon only. Use this command if you want the toolbar to display only the button icons. 
 Text only. Use this command if you want the toolbar to display only the button names. 
 Use Small Size. Use this command if you want the toolbar buttons to appear in a smaller 

size. 
 Remove Item. Point to a toolbar item and use this command if you want to remove this item 

from the toolbar. 
 Customize Toolbar. This command opens the toolbar settings pane. See the description 

below. 

To customize the set of toolbar buttons and their appearance, right-click the toolbar and choose 
Customize Toolbar from the shortcut menu. This will open the toolbar settings pane. You can use 
this pane to: 

 add new buttons to the toolbar by dragging them from the settings pane to the toolbar 
 remove buttons from the toolbar by dragging them from the toolbar to the settings pane 
 add separators to the toolbar by dragging them from the settings pane to the toolbar 
 add spaces to the toolbar by dragging them from the settings pane to the toolbar 
 change the current toolbar buttons set to the default one by dragging it to the toolbar 
 select the toolbar buttons view mode in the Show list 

To apply the changes you have made to the toolbar settings pane, click Done. 
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Status Bar 
When the virtual machine is running, the status bar of its window displays the information about 
devices connected to the virtual machine. 
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The following devices have the icons on the status bar: 

 keyboard  

 floppy disk drive  

 CD/DVD-ROM  

 hard disk  

 network adapter  

 serial port  

 parallel port  

 sound card  

 USB controller  

 assigned PCIe video adapter  

 shared folders  

If you see the  icon in the status bar, it means that Parallels Tools are installed in your virtual 
machine. 

You can connect or disconnect some of the virtual machine devices at runtime by clicking their 
icons in the status bar and choosing the respective commands from the shortcut menu. The 
picture below shows the shortcut menu for the CD/DVD-ROM drive. 

 

You can connect ISO images of CD/DVD discs to the virtual machine CD/DVD-ROM drive or 
connect floppy images to its floppy disk drive in the following way: drag the required image file 
over the CD/DVD-ROM drive icon or the floppy disk drive icon in the status bar. For more 
information, please refer to the Changing Configuration at Runtime section (p. 93). 
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Parallels Workstation Extreme Tray Icon 
When working with Parallels Workstation Extreme, you can use the Parallels Workstation 
Extreme tray icon to: 

 easily manage your running and paused virtual machines. For detailed information, refer to 
Managing Virtual Machines From the Tray (p. 190). 

 bring the Parallels Workstation Extreme window to focus. To this effect, double-click the 
tray icon or right-click it and choose Show Main Window. 

 set the Parallels Workstation Extreme window to be minimized to the tray. To this effect, 
right-click the tray icon and choose Minimize to tray. Now, if you click the minimize button 
on the Parallels Workstation Extreme window, it will be minimized to the tray. 

Note: Minimizing main window to tray does not quit Parallels Workstation Extreme. 

 quit Parallels Workstation Extreme. To this effect, right-click the tray icon and choose the 
corresponding item. 

To enable the Parallels Workstation Extreme tray icon, select Show tray icon option in the 
General pane (p. 39) of Parallels Workstation Extreme Preferences. 
 

Setting Parallels Workstation 
Extreme Preferences 

Common preferences for the Parallels Workstation Extreme application and its virtual machines 
can be configured using the Preferences dialog. You can open this dialog by choosing 
Preferences from the File menu. 

The preferences on the Memory and Network tabs affect all the users that work on the computer 
and all the virtual machines. The other preferences may be different for each user. 
 

 



 Principles of Working With Parallels Workstation Extreme 39 
 

General Preferences 
In the General pane of Parallels Workstation Extreme Preferences, you can do the following: 

 change the default location for storing the folders with the files of virtual machines 
 enable the Minimize main window to system tray on closing option 
 change the sidebar position 
 restore hidden messages 

Note: The settings available in this pane can be configured individually for each user of the 
physical computer. 
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Changing the Default Folder for Virtual Machines 

The Default folder for virtual machines field displays the default location where Parallels 
Workstation Extreme stores the files and folders of all virtual machines you create on the host 
computer. You can change the default location by typing the path to another folder in this field 
or clicking the Choose button and navigating to the necessary folder. After changing the default 
location, all newly created virtual machines will be saved in the folder specified in the Default 
folder for virtual machines field. However, this does not affect the files of virtual machines that 
already exist: their files will remain in the original default folder. 

Managing Parallels Workstation Extreme from the tray 

If you want to be able to manage Parallels Workstation Extreme and the running or paused 
virtual machines from the tray, select the Show tray icon option. For more details, refer to 
Parallels Workstation Extreme Tray Icon (p. 38) and Managing Virtual Machines From the Tray (p. 
190). 

If you want the Parallels Workstation Extreme window to be hidden when minimized, select the 
Minimize to tray option. 

Note: Minimizing main window to tray does not quit Parallels Workstation Extreme. 

Changing the sidebar position 

In the Sidebar position list, you can choose the sidebar location. It can be located in the right or 
in the left part of the main window. 

Resetting Hidden Messages 

A number of Parallels Workstation Extreme dialogs and wizard windows are provided with the 
Do not show this message again option. If you select this option, the corresponding dialog will 
not appear next time you perform the same operation. Using the Reset Hidden Messages button, 
you can reset all dialogs and wizard windows with this option selected so that they would be 
displayed again each time you initiate the corresponding operation. 

Restoring default settings 

The Restore Defaults button enables you to restore the default settings for all options available in 
this pane. 
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Keyboard Preferences 
In the Keyboard pane of Parallels Workstation Extreme Preferences, you can set keyboard 
shortcuts for certain commands. 

Note: The keyboard shortcuts can be configured individually for each user of your physical 
computer. 

 

You can define two hot key combinations: 

 For switching a guest OS window to the Full Screen mode and back. The default hot key 
kombination is Ctrl+Alt+Enter. 

 For releasing the keyboard and mouse input to the primary OS. The default hot key 
combination is Ctrl+Alt. 

You can set your own hot key combinations for each case. The key combination must include a 
key and one or several modifier keys (Ctrl, Alt, or Shift). 

To define new key combination, do the following: 

1 Select one or several modifier keys. 

2 To add an ordinary key, double-click the Key field and press the corresponding key on the 
keyboard.  

Note: If you installed Parallels Tools, you can release the mouse and the keyboard input to the 
primary OS without pressing the hot key combination. See the Capturing and Releasing the 
Keyboard and the Mouse section (p. 88). 

Restoring default settings 

The Restore Defaults button enables you to restore the default settings for all options available in 
this pane. 
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Memory Preferences 
The Memory pane of Parallels Workstation Extreme Preferences allows you to adjust the 
maximum amount of physical memory (RAM) that the system will reserve for all virtual 
machines running on your physical computer. 

Note: You must have the root privileges to change the memory settings of Parallels 
Workstation Extreme in a Linux primary OS. 

 

By default, the Automatically option is selected. In this case, the total amount of RAM to be 
allocated to all running virtual machines is automatically calculated by the system based on the 
following main factors: 

 the total amount of memory installed on your physical computer and 
 the amount of memory required by the primary operating system for its operation. 

The allocated amount of memory is shared among all running virtual machines. You can 
configure the amount of physical memory for a particular virtual machine on the Memory tab in 
Virtual Machine Configuration (p. 109). 

You can redefine the default behavior and manually set the amount of memory to be reserved 
for all active virtual machines. To this effect, select the Manually option and specify the needed 
value by: 

 dragging the slider, or 
 using the spin box arrows, or 
 typing the value directly into the field. 

Restoring default settings 

The Restore Defaults button enables you to restore the default settings for all options available in 
this pane. 
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Network Preferences 
The Network pane of Parallels Workstation Extreme Preferences allows you to configure a 
number of network-related settings for Parallels Workstation Extreme and your virtual 
machines. 

Note: You must have the root privileges to change the network settings of Parallels 
Workstation Extreme in a Linux primary OS. 
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You can configure the range of IP addresses to be assigned to your virtual machines when they 
are operating in the shared (p. 173) and host-only (p. 176) networking modes. 

To edit the host-only networking settings: 

1 Select Host-only networking in the Connection type list. 

2 Select the Enable DHCP Server option to enable the Parallels DHCP server. This server will 
automatically assign IP addresses to your virtual machines operating in the host-only 
networking mode from the IP addresses range defined in the appropriate fields below this 
option. 

3 If necessary, configure the start and end IP addresses in the Start address and End address 
fields and specify the network mask in the Subnet mask field. 

For more information on configuring the host-only networking parameters, refer to Host-
Only Networking (p. 176). 

To edit the shared networking settings: 

1 Select Shared networking in the Connection type list. 

2 Select the Enable DHCP Server option to enable the Parallels DHCP server. This server will 
automatically assign IP addresses to your virtual machines operating in the shared 
networking mode from the IP addresses range defined in the appropriate fields below this 
option. 

3 If necessary, configure the start and end IP addresses in the Start address and End address 
fields and specify the network mask in the Subnet mask field. 

For more information about configuring shared networking, refer to Shared Networking (p. 
173). 

The Start address and End address values determine the first and the last IP addresses with the 
first address usually assigned to the DHCP server itself. The second address is usually given to 
the host OS. Other addresses are assigned to virtual machines. The scope of IP addresses defined 
should belong to the same subnet. 

Port Forwarding 

Normally, virtual machines set to operate in the shared networking mode cannot be accessed 
from external computers. The port forwarding functionality allows computers on your local 
network and on the Internet to transfer data to any of your virtual machines that use the shared 
networking mode. The data sent to a specific port on the host computer will be redirected to a 
specific port of your virtual machine according to a port-forwarding rule. 

To add a new port forwarding rule: 

1 Click the Add button  below Port forwarding list. 
2 In the displayed window, do the following: 

 In the Port Type field, specify the port type you want to use for establishing network 
connections. You can choose between the TCP or UDP port types. 

 In the Incoming Port field, provide the port number on the host computer you want to use 
for data transfer. 

 In the IP Address field, indicate your virtual machine's IP address. 
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 In the Destination Port field, type the virtual machine's port the data will be transferred 
to. 

 
3 Click OK to add the rule. 

When the rule is added, use the following IP address combination for external connections to 
your virtual machine: <your physical computer IP address>:<Incoming 
port>. 

 

To edit an existing port forwarding rule, select it in the Port forwarding list table, click the Edit 
button , and modify the necessary parameters in the displayed window. 

To remove a port forwarding rule, select it in the Port forwarding list table and click the Remove 

button . 

Restoring default settings 

The Restore Defaults button enables you to restore the default settings for all options available in 
this pane. 
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USB Preferences 
In the USB pane of Parallels Workstation Extreme Preferences, you can specify how to connect 
USB devices that are plugged into your physical computer. 
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General Behavior 

You can choose a general action to perform when a new USB device is plugged into the host 
computer by choosing one of these options: 

 Connect it to the host computer. If you select this option, the USB device plugged into the 
host computer will be connected to the host computer. 

 Connect it to the active virtual machine. If you select this option, the USB device plugged 
into the host computer will be automatically connected to the virtual machine that is 
currently running on the host computer. When no virtual machine is running, the USB 
device will be connected to the primary OS. 

 Ask me what to do. If you select this option, you will be prompted to choose how to connect 
the USB device each time a new USB device is plugged into the host computer. 

Permanent Assignments 

You can also set permanent assignments for certain USB devices. These assignments are 
displayed in the Permanent assignments list. 

To add a new assignment: 

1 Click the Add button  below the Permanent assignments list. 

2 Click the device field in the USB Device column to choose a USB device from the list. 

3 In the Connect To column, double-click the destination field to open the list of available 
destinations and choose the virtual machine you want to connect this device to. If you want 
to connect this USB device to the host computer, choose Computer. 

Note: To be able to use the USB device in a virtual machine, you may need to install the 
necessary drivers in its guest OS. By default, such drivers can be obtained from the 
manufacturers of this device. 

4 Click OK to apply the changes. 

Note: You can connect up to eight USB 2.0 devices and up to eight USB 1.1 devices to each 
virtual machine. 

You can change an assignment by editing the device and destination in the USB Device and 
Connect To fields. 

To remove an existing assignment, select it in the Permanent assignments list and click the 

Remove button . 

For more information about using USB devices in a virtual machine, refer to Using USB Devices 
in a Virtual Machine (p. 103). 

Restoring default settings 

The Restore Defaults button enables you to restore the default settings for all options available in 
this pane. 
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Update Preferences 
In the Update pane of Parallels Workstation Extreme Preferences, you can set preferences for the 
frequency of update checks. 

Note: The settings available in this pane can be configured individually for each user of the 
physical computer. 
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The Check for updates section defines the policy for updating the Parallels Workstation Extreme 
software. By default, Parallels Workstation Extreme is set to automatically check for available 
updates once a week, provided that the Parallels Workstation Extreme application is launched 
and your physical computer is connected to the Internet. You can specify another interval for 
updates checking by selecting the necessary value in the Check for updates list. The following 
options are available: 

 Once a day. Select this option if you want Parallels Workstation Extreme to perform the 
update check every day. 

 Once a week. Select this option if you want Parallels Workstation Extreme to perform the 
update check every week. 

 Once a month. Select this option if you want Parallels Workstation Extreme to perform the 
update check every month. 

Checking for new updates may take some time and, if you do not want to have the process 
window on the top of your Desktop, you can hide it to the background. To do that, enable the 
Check in background option. 

Select the Download updates automatically option if you want all new available updates to be 
downloaded at once without showing you the Download dialog. 

You can also check for available updates manually at any time you want by clicking the Check 
Now button: 

 If any updates are available for you version of Parallels Workstation Extreme, you will see 
them in the Download dialog. Choose the updates you want to install and click the Download 
button. 

 If your version of Parallels Workstation Extreme is up to date, you will see the 
corresponding message. 

Restoring default settings 

The Restore Defaults button enables you to restore the default settings for all options available in 
this pane. 
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Feedback Preferences 
Using the Feedback pane, you can join the Parallels Customer Experience Program. 

 

If you choose to participate in the program, Parallels will collect information about your host 
computer and virtual machines configuration. The collected information will help us to make the 
product better fit your needs. 

If you join, only the following types of data will be collected: 

 hardware configuration of the host computer; 
 software configuration of the host computer and virtual machines (the names and versions 

of the operating systems and software installed in them); 
 configuration files of virtual machines; 

Any types of private information like your name, e-mail, address, phone number, and keyboard 
input will not be collected. 

For more details, visit the Customer Experience Program page at the Parallels website (follow 
the link in the pane). 

Restoring default settings 

The Restore Defaults button enables you to restore the default settings for all options available in 
this pane. 
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Intel VT-d Preferences 
In the Intel VT-d pane of Parallels Workstation Extreme Preferences, you can assign some of the 
host computer's PCI Express (PCIe) video and network adapters to your virtual machines. 

Note: This pane appears in Parallels Workstation Extreme Preferences only if your host 
computer supports the Intel VT-d technology and the Intel VT-d support is enabled in BIOS. 

 

The PCI Device column of the Specify the PCI devices assignments table lists all PCIe video and 
network adapters available on your physical computer. In the Assignments column, you can see 
the assignments of your PCIe devices. There are two types of assignments: 

 Host Computer. If you select this assignment, the device will be available to your host 
computer only. 

 Virtual Machines. If you select this assignment and click OK, Parallels Workstation Extreme 
will automatically install an appropriate pass-through driver in the primary operating system. 
This driver will make the PCIe device invisible to the primary operating system. It will 
enable you to assign this device directly to the virtual machine. To use the device in a virtual 
machine, you should add it to your virtual machine configuration with the help of Add 
Hardware Wizard (p. 150). 

To change the assignment of a device, select it in the PCI Devices list, double-click the 
corresponding field in the Assignment column and select the desired assignment. Changing the 

assignment of devices marked by  will require the host computer restart. 

Note: If you have only one PCIe video adapter, its name will be grayed out in the PCI Devices 
list and you will not be able to allocate it to your virtual machines. 

Restoring default settings 

The Restore Defaults button enables you to restore the default settings for all options available in 
this pane. 
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Proxy Server Preferences 
The Proxy Server pane of Parallels Workstation Extreme Preferences allows you to configure a 
number of proxy server-related settings. 
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If you do not want Parallels Workstation Extreme to use a proxy server for network connections, 
select the Do not use proxy server option and click OK. 

If you want Parallels Workstation Extreme to use a proxy server for network connections, you 
have the following possibilities: 

 You can choose the Specify a proxy server option and provide the proxy server settings 
manually. 
If you chose the Specify a proxy server option, you should specify the address and port of the 
proxy server. If this proxy server requires authentication, select the Proxy server requires 
authentication option and type the corresponding credentials in the User Name and Password 
fields. Choose the Use a different proxy server for SSL connections option if you want to use 
an SSL proxy server for your secure connections. Click the SSL Proxy button and provide 
the SSL proxy server address and port in the SSL Proxy window. In this window, you can 
also provide the credentials for accessing this server if needed. If you clear the Use a 
different proxy server for SSL connections option, the first proxy server specified in this pane 
will be used for all connections. 

 In a Windows primary OS, you can choose the Use Internet Explorer proxy settings option to 
import the proxy sever setting from the Connections settings of Internet Explorer. 
If you chose the Use Internet Explorer proxy settings option, click OK to apply the changes. 

 In a Windows primary OS, you can also choose the Use automatic configuration script 
option to automatically configure the proxy server settings. 
If you chose the Use automatic configuration script option, you should provide the path to 
this script in the Address field. Than click OK to apply the changes. 

Restoring default settings 

The Restore Defaults button enables you to restore the default settings for all options available in 
this pane. 
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Using Multiple Displays 
This version of Parallels Workstation Extreme enables you to use separate displays for your host 
computer and your virtual machines and freely move the mouse pointer between them. To be 
able to use this feature, your host computer and virtual machines should comply with the 
following requirements: 

 The host computer should support the Intel VT-d technology and the Intel VT-d support 
should be enabled in BIOS. 

 The host computer configuration should have at least one free PCIe video adapter (p. 17) (in 
addition to the PCIe video adapter used by the host computer) with a display connected to it. 

 At least one PCIe video adapter should be allocated to virtual machines in Parallels 
Workstation Extreme Preferences (p. 51) and included in the configuration of one of your 
virtual machines (p. 163). 

Note: To ensure this PCIe video adapter proper functioning, you should install the latest driver 
into the guest OS. The latest drivers are available on the manufacturer's website. 

 An up-to-date version of Parallels Tools (p. 74) should be installed in the virtual machine 
that uses this PCIe video adapter. 

 If you use two monitors with your Linux host computer, enable either the Xinerama or 
TwinView mode in the operating system to ensure the proper multi-monitor support. If you 
use two monitors with your Linux virtual machine, enable either of the two modes in the 
guest operating system. 

You can easily arrange the displays (p. 55) allocated to your host computer and virtual machines 
using Display Manager. To launch Display Manager: 

1 Start the virtual machine that has the directly assigned PCIe video adapter with a separate 
display connected. 

2 Choose Display Manager from the File menu. 
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Display Manager 
If you use separate displays for the host computer and virtual machines, Display Manager allows 
you to specify the order according to which the mouse pointer will flow from one display to 
another. 

To launch Display Manager, start the virtual machine that has the directly assigned PCIe video 
adapter with a separate display connected and choose Display Manager from the File menu. 

The Parallels Display Manager window shows the displays used by the host computer and virtual 
machines. If you have two displays connected to one PCIe video card, they are joined into one 
display group. 

To make the explanation more vivid, let us assume that you have the "XP x64" and "Vista" 
virtual machines running on the host computer and three displays: one for the host computer, the 
second for "XP x64", the third for "Vista". If you launch Display Manager, its window 
may look like as follows: 
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The displayed arrangement of monitors means the following order of mouse pointer movements: 

 If you are working with the host computer and move the mouse pointer to the right, it will 
set against the border. 

 If you are working with the host computer and move the mouse pointer to the left, it will 
appear on the display used for the "Vista" virtual machine. 

 If you are working with the "Vista" virtual machine and move the mouse pointer to the 
right, it will appear on the display used for the host computer. 

 If you are working with the "Vista" virtual machine and move the mouse pointer to the 
left, it will appear on the display used for the "XP x64" virtual machine. 

This order of mouse pointer movements is inconvenient if, for example, in reality the display 
used for the host computer is betwresolutioneen the displays used for the virtual machines. In 
this case, in the Parallels Display Manager window, you should rearrange the order of displays to 
place them in accordance with the reality. 

To rearrange the displays or display groups: 

1 Click on the display or display group you want to move or select it in the Computer drop-
down list. 

2 Drag this display or display group to the desired position. 

3 To apply the changes, click OK. Otherwise, click Cancel. 

The positions of displays in a display group cannot be rearranged in Display Manager. You can 
change the layout and  of each display or display group by editing the display settings in the 
operating system of your host computer or the respective virtual machine. 

Before managing your virtual machines via Display Manager, make sure they meet the 
following requirements: 

 They should be running or paused. 
 They should have a PCIe video adapter with a separate display connected. For the detailed 

information on how to assign a PCIe video adapter to a virtual machine, refer to Adding a 
Video Adapter (p. 163). 

 They should have the latest version of Parallels Tools installed. See Updating Parallels Tools 
(p. 81). 

 They should have the Automatically capture and release the mouse pointer option enabled. 
This option is usually enabled by default. You can make sure if it is enabled or not and 
enable it if necessary in the Services pane (p. 118) of the Virtual Machine Configuration 
dialog (p. 109). 
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C H A P T E R  5  

Setting Up a Virtual Machine 

The process of creating a virtual machine comprises the following steps: 

 creating a virtual machine configuration 
 installing a guest operating system 
 installing Parallels Tools 

In This Chapter 
Supported Guest Operating Systems..................................................................................... 57 
Creating a New Virtual Machine .......................................................................................... 57 
Adding an Existing Virtual Machine .................................................................................... 70 
Installing a Guest Operating System..................................................................................... 72 
Installing Parallels Tools....................................................................................................... 74 
Downloading Virtual Machines ............................................................................................ 83

 
 

Supported Guest Operating 
Systems 

The current version of Parallels Workstation Extreme officially supports the following guest 
operating systems. 

32-bit guest operating systems: 

Windows: Windows XP SP3 

64-bit guest operating systems: 

Windows: Windows 7; Windows XP SP2 

Linux: RHEL 5.3; RHEL 4.7 

Note: Parallels Workstation Extreme does not provide users with OS ISO images or OS 
installation discs. You should purchase an OS installation disc or an OS ISO image if you do not 
have any. 
 

Creating a New Virtual Machine 
This section describes how to create a virtual machine using New Virtual Machine Wizard. 
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New Virtual Machine Wizard 
The wizard offers several installation modes. You can choose the mode that better fits your 
needs or your experience with Parallels Workstation Extreme. Regardless of what method you 
select, you will be able to change the configuration of your virtual machine later using the 
Virtual Machine Configuration dialog (p. 109). 

Express Windows Installation 

This installation mode is available only for the following guest operating systems: Windows 7, 
Windows Vista, Windows XP, and Windows Server 2003. 

Note: Not all Parallels products support these guest operating systems. 

New Virtual Machine Wizard not only creates a virtual machine configuration, but also 
automatically installs the corresponding guest OS in it. It is the easiest way to make a new 
virtual machine: you only need to insert a Windows 7, Windows Vista, Windows XP, or 
Windows Server 2003 installation disc or specify the path to its image file, and New Virtual 
Machine Wizard will do the rest (including the installation of Parallels Tools). In this mode, 
virtual machines are created with typical configurations (see Typical Configurations for details) 
and placed to the default folder (see below). 

For more information on this installation mode, see Express Windows Installation Mode (p. 60). 

Typical Installation 

This installation mode is designed for new users and for fast virtual machine creation. You only 
have to specify the type and version of the guest operating system that you wish to install and 
where you wish to store the virtual machine files. New Virtual Machine Wizard creates a typical 
(for the selected guest OS) virtual machine configuration and starts the installation of the guest 
OS as interactive installation. 

For more information on this installation mode, see Typical Installation Mode (p. 63). 

Custom Installation 

This installation mode is intended for experienced users only. It allows the user to create 
configurations other than the typical ones. In this mode, the user is prompted to specify such 
options for the basic hardware as the amount of RAM, the size and format of a virtual hard disk, 
and networking parameters. Additional devices can be added later, using the Virtual Machine 
Configuration dialog (p. 109). After New Virtual Machine Wizard creates a virtual machine 
configuration, it starts installing the guest OS if such an option was selected. 

For more information on this installation mode, see Custom Installation Mode (p. 65). 

Default Folders for Virtual Machines 

By default, Parallels Workstation Extreme is configured to create a new virtual machine folder 
in the home folder of the user who created it: 
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 In Windows XP: C:\Documents and Settings\<User_Name>\My 
Documents\Parallels\ 

 In Windows Vista: C:\Users\<User_Name>\My Documents\Parallels 

  In Linux: /<User_Name>/Parallels/ 

Where <User_Name> stands for the user's home folder. 

However, you can select another folder that will be used as the default folder for your virtual 
machines. 

To specify another default destination for saving virtual machines, do the following: 

1 Choose Preferences from the File menu. 

2 In the Preferences window, click the General tab, and specify the default destination for new 
virtual machines in the Default folder for virtual machines field. 

Note: You can also specify a folder for a virtual machine during its creation. An existing virtual 
machine can also be moved to a different folder after it is created. 
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Express Windows Installation 
1 Start Parallels Workstation Extreme and launch New Virtual Machine Wizard by choosing 

New Virtual Machine from the File menu. 

2 In the Introduction window, click Next to proceed with the virtual machine creation. 

3 In the Select Operating System Type and Version window, select the Windows 7, Windows 
Vista, Windows XP, or Windows Server 2003 guest OS and click Next. 

Note: Not all Parallels products support these guest operating systems. 

4 In the Virtual Machine Type window, select Express Windows and click Next. 
5 In the Express Windows Installation window, specify your user details and the Windows 

product key necessary for the Windows guest OS installation. 

Note: If you do not enter the Windows product key in this step, you will have to provide it 
later when the Windows guest OS installation starts. 

If you click the Advanced button, you can set the number of CPUs and the amount of RAM 
to your future virtual machine. 

Click Next. 
6 In the Name and Location window, define the name and location for your virtual machine: 

 Name. Indicate an arbitrary name to be assigned to the virtual machine. By default, the 
virtual machine gets the same name as the operating system that will be installed inside 
this virtual machine. If a virtual machine with such a name already exists, you will be 
prompted to indicate another name. The name must not exceed 50 characters. 

 Location. Use the Choose button if you want to change the default location of the virtual 
machine-related files. 
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If you click the Advanced button, you can set the number of CPUs, the amount of RAM, and 
the virtual hard disk capacity to your future virtual machine. 

Click Create. 

After the virtual machine is created, in the Prepare to Install Operating System window, 
specify the source of installation files and click Start. You can use the following types of 
installation media: 

 Real CD/DVD-ROM Drive. Select this option to use a disc inserted into the CD/DVD drive 
of the computer. Choose the drive to use from the Drive list. 

 CD/DVD Image. Select this option to use a CD/DVD disc image connected to the virtual 
machine's CD/DVD drive. Type the path to the file in the File field or use the Choose 
button to locate the file. 

Note: Parallels Workstation Extreme does not provide users with OS ISO images or OS 
installation discs. You should purchase an OS installation disc or an OS ISO image if you do 
not have any. 
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7 After you click Start, New Virtual Machine Wizard will automatically start the new virtual 
machine and install the guest operating system in it. After the guest OS has been 
successfully installed, Parallels Workstation Extreme installs Parallels Tools. 

During the unattended installation, Parallels Workstation Extreme creates an administrator 
account with a blank password. When the guest OS installation is complete, we recommend that 
you change the password in order to protect the safety of your data. 

To change the administrator password in Windows Vista: 

1 Click the Start menu, then select Control Panel -> User Accounts and Family Safety -> Change 
your Windows password. 

To change the administrator password in Windows XP (Professional Edition): 

1 Click the Start menu, then select Control Panel -> Administrative Tools -> Computer 
Management. 

2 In the Computer Management window, open System Tools -> Local Users and Groups -> 
Users. Right-click the Administrator account and choose Set Password from the context 
menu. 
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Typical Installation Mode 
To create a typical virtual machine: 

1 Start Parallels Workstation Extreme and launch New Virtual Machine Wizard by choosing 
New Virtual Machine from the File menu. 

2 In the Introduction window, click Next to proceed with the virtual machine creation. 

3 In the Select Operating System Type and Version window, select the operating system you 
are planning to install inside your virtual machine and click Next. 

4 In the Virtual Machine Type window, select Typical and click Next. 
5 In the Name and Location window, define the name and location for your virtual machine: 

 Name. Indicate an arbitrary name to be assigned to the virtual machine. By default, the 
virtual machine gets the same name as the operating system that is planned to be 
installed inside this virtual machine. If a virtual machine with such a name already 
exists, you will be prompted to indicate another name. The name must not exceed 50 
characters. 

 Location. Use the Choose button if you want to change the default location of the virtual 
machine-related files. 
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If you click the Advanced button, you can set the number of CPUs, the amount of RAM, and 
the virtual hard disk capacity to your future virtual machine. 

Click Next. 
6 After the virtual machine is created, in the Prepare to Install Operating System window, 

specify the source of installation files and click Start. You can use the following types of 
installation media: 

 Real CD/DVD-ROM Drive. Select this option to use a disc inserted into the optical drive of 
the computer. Choose the drive to use from the Drive list. 

 CD/DVD Image. Select this option to use a CD/DVD disc image connected to the virtual 
machine's CD/DVD drive. Type the path to the file in the File field or use the Choose 
button to locate the file. 

Note: Parallels Workstation Extreme does not provide you with operating systems 
installation media. You should purchase an OS installation disc or an image of it if you do 
not have any. 

 
If you do not want to install the guest OS and start the virtual machine, click Done. When the 
installation is complete, install Parallels Tools if they are available for the guest OS you 
have just installed. Refer to the Installing Parallels Tools section (p. 74). 
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Custom Installation Mode 
To create a custom virtual machine: 

1 Start Parallels Workstation Extreme and launch New Virtual Machine Wizard by choosing 
New Virtual Machine from the File menu. 

2 In the Introduction window, click Next to proceed with the virtual machine creation. 

3 In the Select Operating System Type and Version window, select the guest OS you plan to 
install inside your virtual machine and click Next.  

4 In the Virtual Machine Type window, select Custom and click Next. 
5 In the CPU and Memory Options window, specify the number of CPU(s) and the amount of 

RAM for the virtual machine and click Next. You may use the slider or arrow buttons to set 
the value or simply type it into the corresponding field. 
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6 In the Hard Disk Options window, select the type of virtual hard disk you want to use and 
click Next. You can create a new hard disk image, use an existing one, or create a virtual 
machine without any hard disk at all. You may need a virtual machine without a hard disk to 
work with live CDs/DVDs (CDs or DVDs containing a bootable operating system). 

 
7 If you have selected the No hard disk option, go to Step 8. 

If you chose to create a new virtual hard disk in the previous step, in the New Virtual Hard 
Disk window, specify the capacity and type for the disk and click Next. If you have chosen to 
use an existing image file, in the Existing Virtual Hard Disk window, specify the hard disk 
image to be connected, its interface type and position. Click Next. 
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8 In the Networking Type window, select the type of networking you want to use in the virtual 
machine and click Next. 
 Shared Networking. If you select this option, the virtual machine will use the host 

computer's network connections and will be visible only for the host computer and other 
virtual machines registered on this server. 

 Bridged Networking. If you select this option, the virtual machine will be visible on the 
network as a separate computer. 

 Host-Only Networking. If you select this option, the virtual machine will access only the 
host computer and the virtual machines running on it. 

 Direct Assignment (using Intel VT-d). If you select this option, the virtual machine will be 
able to access the local network and Internet through a PCIe network adapter. This 
option is available only if you have a PCIe network adapter and the Intel VT-d 
technology is enabled in your host computer. 

 No Networking. If you select this option, the virtual machine will have no network 
adapter. 

Note: You may reconfigure the networking settings after the virtual machine is created, 
using the Virtual Machine Configuration dialog (p. 109). 

9 If you have selected the Shared Networking, Host-Only Networking, or No Networking option, 
go to Step 10. 

If you selected Bridged Networking, on the next step you will need to select the network 
adapter to be used by the virtual machine: 

 Default Adapter. Select this option to use the adapter specified as default in the primary 
OS. 

 Parallels Shared Networking Adapter. Select this option to use Parallels Shared 
Networking adapter installed together with Parallels Workstation Extreme. 

 Parallels Host-Only Networking Adapter. Select this option to use Parallels Host-Only 
Networking adapter installed together with Parallels Workstation Extreme. 

The host computer network adapters included in this list are also available for selecting. 
Select the Connected option if you want the virtual machine to start up with this network 
adapter connected. 

If you selected the Direct Assignment (using Intel VT-d) option, on the next step select the 
PCIe network adapter you want to use. Before using the PCIe adapter in your virtual 
machine, you will need to assign it to your virtual machines in the Intel VT-d pane (p. 51) of 
Parallels Workstation Extreme Preferences and install the manufacturer's driver for this PCIe 
device inside the virtual machine. The driver should support the Intel VT-d technology. For 
detailed information, see Networking Using a PCIe Adapter (p. 177). 

10 In the Optimization Options window, select the optimization mode you prefer and click Next. 
The available options are: 

 Virtual machine (Recommended). Select this option to allocate more host computer 
resources to the virtual machine and its applications. 

 Host Computer. Select this option to allocate more resources to the host computer and its 
applications. 

11 In the Name and Location window, define the name and location for your virtual machine: 
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 Name. Indicate an arbitrary name to be assigned to the virtual machine. By default, the 
virtual machine gets the same name as the operating system that will be installed inside 
this virtual machine. If a virtual machine with such a name already exists, you will be 
prompted to indicate another name. The name must not exceed 50 characters. 

 Location. Use the Choose button if you want to change the default location of the virtual 
machine-related files. 
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12 After the virtual machine is created, the wizard invites you to install the guest OS in it. For 
these purposes in the Prepare to Install Operating System window, select the Connect the 
installation media check box, specify the source of installation files, and click Start. You can 
use the following types of installation media: 

 Real CD/DVD-ROM Drive. Select this option to use a disc inserted into the CD/DVD drive 
of the computer. Choose the drive to use from the Drive list. 

 CD/DVD Image. Select this option to use a CD/DVD disc image connected to the virtual 
machine's CD/DVD drive. Type the path to the file in the File field or use the Choose 
button to locate the file. 

Note: Parallels Workstation Extreme does not provide users with OS ISO images or OS 
installation discs. You should purchase an OS installation disc or an OS ISO image if you do 
not have any. 

 
If you do not want to install the guest OS and start the virtual machine now, click Done. 

When the installation is complete, install Parallels Tools if they are available for the guest OS 
you just installed. Refer to the Installing Parallels Tools section (p. 74). 
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Adding an Existing Virtual Machine 
If you already have a virtual machine stored on your physical computer but it is missing from 
the list of virtual machines registered in Parallels Workstation Extreme, you can easily add it 
with the help of Add Existing Virtual Machine Wizard. 

To add an existing virtual machine 
1 Choose Add Existing from the File menu to start Add Existing Virtual Machine Wizard.  

2 In the Introduction window, click Next. If you do not want the Introduction window to appear 
in future, select Always skip introduction. 

3 In the Select a Virtual Machine window, you should locate the virtual machines you want to 
add: 

 You can set the path to a specific virtual machine's configuration file (config.pvs). 
Select the Add a specific virtual machine option and type the path in the File field or click 
the Choose button and navigate to the necessary file. Click Add and go to Step 5. 

 You can find all virtual machines in a specific folder. Select the Search for virtual 
machines in this folder option, type the path to the the necessary folder in the Start from 
field or click the Choose button, and navigate to it. Click Search. 
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4 If you chose Search for virtual machines in this folder, in the next window the wizard 
displays all the virtual machines found in the specified folder that are not registered in 
Parallels Workstation Extreme. Select the virtual machines you want to add. 

If you want to select all items at a time, click the Select All button  displayed below the 
list. 

If you want to clear all items at a time, click the Clear All button  displayed below the list. 

Review the selection and click Add. 

 
5 Click Finish to exit the wizard. 
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Installing a Guest Operating System 
You can install a guest operating system in a virtual machine from a CD or DVD, or from an 
image file of such CD/DVD. Some operating systems are available on CD/DVD disc images 
only. 

In some cases, the installation cannot be performed from a real CD/DVD disc because of disc 
reading problems. In such cases, it is recommended that you try to install the operating system 
from a CD/DVD disc image of this disc. ISO images of CD/DVD discs can be created using a 
third party imaging utility. 

In this version, you can also install the guest operating system using a PXE server via network. 

Some operating systems are installed only from floppy disks. If your computer does not have 
floppy drives, you can install such operating systems using images of installation diskettes or 
using real floppy disk drives inserted into an external USB floppy disk drive. You can create 
floppy disk images using third-party applications. 

Installing from a CD/DVD disc or its image 
1 Select the virtual machine and make sure that it is stopped. 

2 To connect the installation medium, open Virtual Machine Configuration by: 

 right-clicking the machine and choosing Configure from the shortcut menu, or 

 choosing Configure from the Virtual Machine menu. 

3 Open the CD/DVD-ROM settings and configure the virtual CD/DVD-ROM drive settings. 

 If you are installing from a real CD/DVD: 

Select the Real Device option and specify the real drive to connect in the CD/DVD-ROM 
list. 

Insert the CD/DVD disc with the operating system files into the appropriate drive of the 
computer. 

 If you are installing from an image file: 

Select the Image file option and specify the path to the image file in the File field. 

Note: You can use ISO and DMG images for installing the guest operating system. CUE and 
CCD images may be also supported. 

4 Click OK in Virtual Machine Configuration to save the changes. 

5 Start your virtual machine by clicking Start . 

The installation will launch soon after the virtual machine is started. 

Note: If you need to press any keys inside the virtual machine during the guest OS installation, 
first click inside the virtual machine window to capture the keyboard and mouse input and than 
press the corresponding keys. To release the keyboard and mouse input back to the host OS, 
press Ctrl+Alt. For more information, refer to Capturing and Releasing the Keyboard and the 
Mouse (p. 88). 
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Installing from the network 
1 Choose Configure from the Virtual Machine menu to open Virtual Machine Configuration. 

2 Click the Add button  in the bottom part of the Virtual Machine Configuration dialog to 
launch Add Hardware Assistant. 

Note: The Add button is disabled when the virtual machine is running. You need to shut 
down the virtual machine before you can use this button. 

3 Add a network adapter (p. 161) to your virtual machine configuration. 

4 Open the Boot Order pane in Virtual Machine Configuration and change the boot sequence 
to make the virtual network adapter the first device in the sequence. To this effect, select 
Network Adapter in the list and use the arrow buttons to move it to the top of the list. 

5 Click OK to apply the changes. 

6 Start the virtual machine by clicking Start . 

Soon after your virtual machine is started, a list of available PXE servers appears. 

During the installation, when the guest OS reboots for the first time, or after the installation, 
return the boot sequence to booting from the hard disk. 

Installing from a floppy disk image 
1 Select the virtual machine and make sure that it is stopped. 

2 To connect the installation medium, open Virtual Machine Configuration by: 

 right-clicking the machine and choosing Configure from the shortcut menu, or 

 choosing Configure from the Virtual Machine menu. 

3 Open the Floppy DIsk pane and specify the path to the floppy image disk file in the Image 
File field. 

4 Click OK to apply the changes 

5 Start the virtual machine by clicking Start . 

The installation will launch soon after the virtual machine is started. 

Reinstalling the guest OS 

The procedure of reinstalling the guest OS is the same as the procedure of installing the guest 
OS: provide the installation media or its image, connect it to the virtual machine, and start the 
virtual machine. The reinstallation will launch soon after the virtual machine is started. 

Note: You can reinstall the guest OS of the same type only. However, you are free to choose the 
guest OS version. 

Keep in mind that in some cases, it is easier just to create a new virtual machine, install the guest 
OS, and delete the old machine after moving all the necessary data to the new one. 
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Installing Parallels Tools 
Parallels Workstation Extreme includes a set of specially developed utilities that help you use 
your virtual machines in the most comfortable and efficient way. 

Parallels Tools are located on the disc images that are installed along with Parallels Workstation 
Extreme. There is a separate Parallels Tools disc image for each type of the supported guest 
operating systems. 

 prl-tools-win.iso - disc image with Parallels Tools for Windows guest operating 
systems. 

 prl-tools-lin.iso - disc image with Parallels Tools for Linux guest operating 
systems. 

These disc images can be found in the following folder: 

 In 64-bit Windows: C:\Program Files (x86)\Parallels\Parallels 
Workstation Extreme\Tools\ 

 In Linux: /usr/share/parallels-workstation/tools/ 
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Parallels Tools Overview 
Parallels Tools are a suite of special utilities that help you use your virtual machines in the most 
comfortable and efficient way. With Parallels Tools, you can move the mouse seamlessly 
outside the guest OS window without pressing any key, change the virtual machine's screen 
resolution by simply resizing its window, synchronize your virtual machine's time and date 
settings with the time settings of the host computer, and share the host computer disks and 
folders with its virtual machines. 

Parallels Tools include the utilities listed below. Many of these utilities are available for the 
most popular Windows and Linux operating systems. 

Mouse Synchronization Tool Windows, 

Linux 

Mouse Synchronization Tool captures the mouse 
input in the virtual machine each time the pointer 
moves over to the guest OS window and 
automatically releases the input when the pointer 
moves out of the guest OS window. 

Time Synchronization Tool Windows, 

Linux 

Time Synchronization Tool enables you to customize 
your virtual machine and the host computer time 
settings. With this tool, you can: 

 Automatically synchronize the time settings of 
your virtual machine with the host computer time 
settings. 

 Set up and maintain the time difference between 
your host computer and the guest OS installed in 
your virtual machine. 

Clipboard Synchronization 
Tool 

Windows, 

Linux 

Clipboard Synchronization Tool enables you to easily 
exchange texts between: 

 different virtual machines irrespective of the 
guest operating systems installed in them. 

 a virtual machine and the physical computer 
hosting this virtual machine. 

Dynamic Resolution Tool Windows, 

Linux 

Dynamic Resolution Tool enables you to work with 
dynamic resolution. When you resize the guest OS 
window by dragging its lower right corner, the guest 
OS window resolution changes automatically. 

Note: If dynamic resolution does not work when 
switching to the Full Screen mode in virtual 
machines with Linux guest operating system 
installed, go to the Video pane (p. 129) of Virtual 
Machine Configuration and increase the amount 
of video memory available to the virtual 
machine's video card up to 16 MB. 

Shared Folders Tool Windows, 

Linux 

Shared Folders Tool enables you to share the primary 
OS folders to access them from the guest OS. With 
this tool, you can access the host computer shared 
folders from the virtual machine. 

Shared Profile Tool Windows Shared Profile Tool enables you to map some of the 
folders in the physical computer home folder to your 
user folders in the virtual machine, which allows you 
to access the physical computer home folders right 
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from your virtual machine. 

Parallels Compressor Windows The Parallels Compressor utility enables you to 
reduce the size of your virtual machine's hard disk. 

After the Parallels Tools installation, the following features are available for settings up in 
Parallels Workstation Extreme. 

SmartMount Windows, 

Linux 

SmartMount feature enables the automatic detection 
and mounting of removable devices in your virtual 
machines. 

Parallels Tools can be installed in all Windows and Linux guest operating systems officially 
supported by Parallels Workstation Extreme. 
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Installing Parallels Tools in a Windows Guest OS 
If you created your virtual machine using the Express Windows mode, Parallels Tools were 
installed automatically after the installation of the Windows guest operating system. 

If your virtual machine was created in the Typical or Custom mode, do the following to install 
Parallels Tools in it: 

1 Start the virtual machine and log in to the guest operating system. 

2 When the guest OS boots up, connect the Parallels Tools ISO image by choosing the Install 
Parallels Tools option from the Virtual Machine menu. 

Note: If the Install Parallels Tools option is grayed out, make sure that Parallels Tools can be 
installed in your guest operating system. To see the list of guest OSs supported by Parallels 
Tools, refer to the Parallels Tools Overview section (p. 75) in Parallels Workstation Extreme 
Help available through the Help menu. 

3 In the Welcome window, click Install. The wizard will start the automatic installation. 

4 When the installation is complete, click Reboot to exit the wizard and restart the virtual 
machine. 

If the Parallels Tools installation does not start automatically, you can launch it manually: 

1 Start the virtual machine and log in to the guest operating system. 

2 When the guest OS boots up, connect the Parallels Tools ISO image by right-clicking the 
CD/DVD-ROM icon in the virtual machine's window status bar and choosing Connect 
Image. 

3 Open the following folder: 

 In 32-bit Windows: C:\Program Files\Parallels\Parallels 
Workstation Extreme\Tools\ 

 In 64-bit Windows: C:\Program Files (x86)\Parallels\Parallels 
Workstation Extreme\Tools\ 

Select the prl-tools-win.iso file, and click Open to connect it to the virtual machine. 

4 In the virtual machine, open My Computer and double-click the Parallels Tools disc icon to 
expand its contents. 

Note: If the installation wizard does not launch automatically, right-click the disc, choose 
Open from the shortcut menu, and double-click Setup.exe to launch the installer. 

5 Follow the wizard's instructions to complete the installation. 

To edit the settings of Parallels Tools installed in your virtual machine, use the Services pane (p. 
118) of the Virtual Machine Configuration dialog. 

How to check if Parallels Tools are installed 
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If you are not sure whether Parallels Tools are installed, you can easily check this. Start your 
virtual machine and look at the status bar of its window: if the tip "Press Ctrl + Alt to 
release the mouse and keyboard" appears in the status bar of the virtual machine's 
window, this means that Parallels Tools are not installed. When Parallels Tools are installed, 
you do not need to press any key to release the mouse and keyboard - they are released 
automatically. 
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Installing Parallels Tools in a Linux Guest OS 
Before installing Parallels Tools in a Linux guest OS, perform the following actions: 

 Close all applications in the guest operating system. 
 Disable the 3D accelerated window manager if you use any. 
 Make sure that you have the gcc package and kernel sources installed. If these packages are 

not installed, the Parallels Tools installer will inform you about this you. The kernel sources 
package name depends on the type of Linux operating system you use: it can be kernel-
devel, or kernel-headers, or something else. For more information about the kernel 
sources, refer to the Installing the GCC package and Kernel Sources in Linux (p. 213) 
section. 

Note: To install Parallels Tools in your virtual machine, you must have the root privileges.  

Installing Parallels Tools in the most recent versions of Linux guest OSs 

If you have one of the most recent versions of Linux OSs (Ubuntu, Fedora) in your virtual 
machine, the prl-tools-lin.iso image file will be mounted automatically after you 
connect it to the CD/DVD drive. To install Parallels Tools, do the following: 

1 Start the virtual machine. 

2 When the guest OS boots up, click the Virtual Machine menu and choose Install Parallels 
Tools. 

Note: If the Install Parallels Tools option is grayed out, make sure that Parallels Tools can be 
installed in your guest operating system. To see the list of guest OSs supported by Parallels 
Tools, refer to the Parallels Tools Overview section (p. 75) in Parallels Workstation Extreme 
User's Guide. 

3 The prl-tools-lin.iso image file will be connected to the virtual machine's 
CD/DVD drive and mounted. 

You can connect and mount the Parallels Tools ISO image file manually. Right-click the 
CD/DVD-ROM icon in the virtual machine's window status bar and choose Connect Image. 
Open the following folder: 

 In 32-bit Windows: C:\Program Files\Parallels\Parallels 
Workstation Extreme\Tools\ 

 In 64-bit Windows: C:\Program Files (x86)\Parallels\Parallels 
Workstation Extreme\Tools\ 

 In Linux: /usr/share/parallels-workstation/tools/ 

Select the prl-tools-lin.iso file, and click Open to connect it to the virtual machine. 

4 Start a terminal in your Linux guest OS. Type the following command to gain the root 
privileges: 

su 

5 Change the directory to the CD/DVD drive directory using 
cd /media/cdrom/ 

Note: In some of the Linux operating systems, the mount point for the virtual CD/DVD 
drive may appear as /media/Parallels\ Tools/. 
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6 In the CD/DVD drive directory, enter the following command to launch Parallels Tools 
installation: 

./install 

7 Follow the Parallels Tools Installer instructions to complete the installation. 

8 When the installation of Parallels Tools is complete, restart your virtual machine. 

Installing Parallels Tools in other versions of Linux guest OSs 

To install Parallels Tools in the older versions of Linux OSs, you have to mount the prl-
tools-lin.iso image file manually. Do the following: 

1 Start the virtual machine. 

2 When the guest OS boots up, click the Virtual Machine menu and choose Install Parallels 
Tools. 

Note: If the Install Parallels Tools option is grayed out, make sure that Parallels Tools can be 
installed in your guest operating system. To see the list of guest OSs supported by Parallels 
Tools, refer to the Parallels Tools Overview section (p. 75) in Parallels Workstation Extreme 
User's Guide. 

The prl-tools-lin.iso image file will be connected to the virtual machine's 
CD/DVD drive. 

3 Start a terminal in your Linux guest OS. Type the following command to gain the root 
privileges: 

su 

4 Check if the Parallels Tools CD image is mounted by entering 
mount | grep iso9660 

If this command does not return anything, proceed to the next step. 

If this command returns anything like 
/dev/cdrom on /media/cdrom type iso9660 (ro,exec,nosuid,nodev,uid=0), 

skip the next step and proceed to the following one. 

If this command returns anything like 
/dev/cdrom on /media/cdrom type iso9660 (ro,noexec,nosuid,nodev,uid=0) 

with the noexec option present in parentheses, you need to unmount the disc using the 
following command and then proceed to the next step: 

umount /dev/cdrom 

5 To mount the Parallels Tools installation disc image, enter the following: 
mount -o exec /dev/cdrom /media/cdrom 

Note: /dev/cdrom is the virtual machine's CD/DVD drive and /media/cdrom is the 
mount point for this device. In some of the Linux operating systems the virtual CD/DVD 
drive may appear as /dev/hdb and the mount point /mnt/cdrom. Some Linux OSs do 
not have the CD/DVD drive mount point. In this case, you should create the mount point 
directory manually. 

6 When the installation disc image is mounted, change the directory to the CD/DVD drive 
directory using 

cd /media/cdrom/ 

7 In the CD/DVD drive directory, enter the following to launch Parallels Tools installation: 
./install 
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Note: You must have the root privileges to run this command. 

8 Follow the Parallels Tools Installer instructions to complete the installation. 

9 When the installation of Parallels Tools is complete, restart your virtual machine. 

How to check if Parallels Tools are installed 

If you are not sure whether Parallels Tools are installed, you can easily check this. Start your 
virtual machine and look at the status bar of its window: if the tip "Press Ctrl + Alt to 
release the mouse and keyboard" appears in the status bar of the virtual machine's 
window, this means that Parallels Tools are not installed. When Parallels Tools are installed, 
you do not need to press any key to release the mouse and keyboard - they are released 
automatically. 
 

Updating Parallels Tools 
The procedure of updating Parallels Tools depends on the guest operating system they are 
installed in. 

In a Windows guest OS 

Parallels Workstation Extreme automatically checks for new Parallels Tools updates when you 
start your virtual machine. 

If a newer version of Parallels Tools is available, you will see the corresponding message 
offering you to download and update the tools. Click Yes to download Parallels Tools from the 
Parallels Update server and install them into your virtual machine. Updating will start right after 
the download finishes and will prompt you to restart the virtual machine when it is complete.  

If you do not want to update Parallels Tools or want to do it later, click No. You will be able to 
update them later by using the Update Parallels Tools option from the Virtual Machine menu.  

Note: If you revert to a snapshot that was made when you had an earlier version of Parallels 
Tools in your virtual machine, you will also be offered to update them. 

If Parallels Tools are up-to-date but you want to reinstall them, select the Reinstall Parallels 
Tools option from the Virtual Machine menu.In a Linux guest OS 

In Linux guest operating systems, you should manually check for Parallels Tools updates from 
time to time. 

To update Parallels Tools: 

1 Start the virtual machine. 

2 To update Parallels Tools, you should mount the prl-tools-lin.iso image and launch 
Parallels Tools Installer. See Installing Parallels Tools in a Linux Guest OS (p. 79) for detailed 
information how you can do it. 

3 Follow the Parallels Tools Installer instructions. When prompted to choose the action to 
perform, select Update and press Enter. 

4 When the updating is complete, restart your virtual machine. 
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Removing Parallels Tools 
Parallels Tools can be removed through a general procedure of removing applications from the 
operating system installed in your virtual machine.  

Removing from a Windows guest OS 
1 Start the virtual machine and log in to the guest OS. 

2 From the Windows Start menu, choose Control Panel > Add or Remove Programs. In 
Windows Vista, choose Control Panel > Programs and Features. 

3 Select Parallels Tools in the list and click Remove. 

4 When Parallels Tools are removed, restart the guest operating system. 

Removing from a Linux guest OS 
1 Start the virtual machine. 

2 To remove Parallels Tools, you should connect and mount the prl-tools-lin.iso 
image and launch Parallels Tools Installer. See Installing Parallels Tools in a Linux Guest OS 
(p. 79) for detailed information how you can do it. 

3 Follow the Parallels Tools Installer instructions. When prompted to choose the action to 
perform, select Remove and press Enter. 

4 When Parallels Tools are successfully removed, press Enter to close the window. 
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Downloading Virtual Machines 
If you do not have enough time to create a new virtual machine with the required configuration, 
you can download a ready-to-use virtual machine with a predefined configuration. Besides the 
basic configuration, pre-built virtual machines also may have a set of applications installed in 
the guest OS, so that you do not have to spend time on installing and setting up the required 
software. 

Such pre-built virtual machines with target services and applications installed in the guest OS 
are called Parallels Virtual Appliances. Virtual appliances are built by the Parallels experts and 
are available for downloading at the Parallels Technology Network page. You can also access 
the virtual appliances online storage via the Parallels Workstation Extreme menu by choosing 
Download from the File menu. Parallels Workstation Extreme redirects you to the Parallels 
Technology Network page where you will be able to choose the virtual machines that suit you 
most. 

To start using a Linux virtual appliance, do the following: 

1 On the Parallels Technology Network page, click the virtual appliance's title to view 
configuration details and the guest OS administrative credentials. 

2 Download the desired virtual appliance by clicking the GET APP link and choosing the 
download link with the suitable archive file format. 

3 When the virtual appliance file is downloaded, open it and double-click the PVS file to start 
the virtual machine. 
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C H A P T E R  6  

Working in a Virtual Machine 

This chapter explains how to start, stop, suspend or pause a virtual machine. It also provides the 
information on actions you can perform with the virtual machine while the guest operating 
system is running. 

In This Chapter 
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Performing Main Operations on the 
Virtual Machine 

Starting Your Virtual Machine and Shutting It Down 

Starting the Virtual Machine 

To start the virtual machine, select it in the Parallels Workstation Extreme sidebar and 

 click the Start button  on the Parallels Workstation Extreme toolbar or 
 choose Start from the Virtual Machine menu. 

After starting the virtual machine, it will boot into the guest operating system installed in this 
virtual machine. If no guest operating system is installed in the virtual machine, you will see the 
following message: "No boot device is available...". 

Notes: 1. The virtual machine can be powered on only if you activated your copy of Parallels 
Workstation Extreme with permanent or trial activation key. See the Activating Parallels 
Workstation Extreme section (p. 24) in Parallels Workstation Extreme User's Guide. 

2. It is not recommended that you start your virtual machines from an external storage device, 
this may result in low performance and unsteady operation. 

Shutting Down the Virtual Machine 

To turn off the virtual machine, you can: 

 use the standard shutdown procedure for the guest operating system installed in your virtual 
machine, 

 click the Shut Down  button in the Parallels Workstation Extreme toolbar, or 
 choose Shut Down from the Virtual Machine menu. 
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Suspending and Pausing Your Virtual Machine 
Starting and shutting down virtual machines may take a considerable amount of time. Instead of 
performing these operations, you can suspend or pause a virtual machine for the required time 
and quickly resume it later. 

Note: Close the Virtual Machine Configuration (p. 109) window before changing the virtual 
machine state. 

Suspending a Virtual Machine 

Suspending a virtual machine is similar to putting a real computer into the sleep mode. When 
you suspend a virtual machine, you save its current state (including the state of all applications 
and processes running in the virtual machine) to a special file on the host computer. When the 
suspended virtual machine is resumed, it continues operating at the same point the virtual 
machine was at the time of its suspending. 

Suspending your virtual machine may prove efficient if you need to restart the host computer, 
but do not want to: 

 quit the applications running in the virtual machine 
 spend much time on shutting the guest operating system down and then starting it again 

To suspend a virtual machine, do one of the following: 

 choose Suspend from the Virtual Machine menu or 

 click the Suspend button  in the Parallels Workstation Extreme toolbar. 

Note: You can view the configuration of the suspended virtual machine in read-only mode. To 
be able to modify the suspended virtual machine configuration, you should stop the virtual 
machine. 

To resume a suspended virtual machine, click the Resume button  in the Parallels 
Workstation Extreme toolbar or choose Resume from the Virtual Machine menu. 

Pausing a Virtual Machine 

Pausing a virtual machine releases the resources, such as RAM and CPU, currently used by this 
virtual machine. The released resources can then be used by the host computer and its 
applications or by other virtual machines running on the host computer. 

Note: Only the amount of RAM used by the guest OS will be released. The memory used by the 
Parallels Workstation Extreme application will still be locked. 

To pause a virtual machine, do one of the following: 

 click the Pause button  in the Parallels Workstation Extreme toolbar or 
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 choose Pause from the Virtual Machine menu. 

When a virtual machine is paused, its window is grayed out. To continue running the virtual 

machine, click the Resume button  in the Parallels Workstation Extreme toolbar or choose 
Resume from the Virtual Machine menu. 

Parallels Workstation Extreme is designed to operate like an ordinary computer application. 
This means that you do not have to change the virtual machine's state from running to paused, 
suspended, or stopped before putting the host computer to sleep. In sleep mode, the host 
computer does not allocate any resources to the running applications (including Parallels 
Workstation Extreme and all virtual machines) so that they are stopped automatically. As you 
start the host computer, all the applications are automatically up and running again. 
 

Stopping and Resetting Your Virtual Machine 

Stopping a Virtual Machine 

If the guest operating system cannot be shut down for some reason or another, you can forcibly 
stop the virtual machine by doing one of the following: 

 clicking the Stop button  in the Parallels Workstation Extreme toolbar 
 choosing Stop from the Virtual Machine menu. 

Warning: If you forcibly stop the virtual machine, you may lose all unsaved data. 

Resetting a Virtual Machine 

If some program error has caused your virtual machine to hang, you may wish to reset the 
virtual machine. 

To reset the virtual machine, do one of the following: 

 Click the Reset button  in the Parallels Workstation Extreme toolbar. If this button is 
absent from the toolbar, refer to the Customizing Toolbar subsection (p. 33) of Parallels 
Workstation Extreme User's Guide. 

 Choose Reset from the Virtual Machine menu. 

Warning: If you reset the virtual machine, you may lose all unsaved data. 
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Using Keyboard and Mouse 

Capturing and Releasing the Keyboard and Mouse 
To start working in a virtual machine, you need first to capture the keyboard and mouse input in 
the virtual machine. To this effect: 

1 move the mouse pointer over the virtual machine window 

2 click in the window 

When the keyboard and mouse input is captured in the virtual machine, you cannot move the 
pointer out of the virtual machine window and all keystrokes and button clicks go to the virtual 
machine. To release the keyboard and mouse back, press Ctrl+Alt. The keyboard and mouse will 
be released immediately. 

Note: You can change the key combination for releasing the keyboard and mouse input using 
the Keyboard pane of the Preferences dialog. 

If you want to automatically capture and release the keyboard and mouse input, you should 
install Parallels Tools (p. 74) in your virtual machine. After the Parallels Tools installation, you 
can capture and release the mouse and keyboard input more easily: 

 click anywhere in the virtual machine window to capture the input 
 click anywhere outside the virtual machine window to release the input. 

 

Keyboard Shortcuts in a Virtual Machine 
If when working in a virtual machine, you press a special key combination intended for the 
guest OS ( for example, Ctrl+Alt+Del for any of the Windows guest operating systems) the 
primary operating system may intercept such a command. That is why in this version of 
Parallels Workstation Extreme, you can apply any of the main Windows and Linux shortcuts to 

your virtual machine with the help of the Keyboard icon  in the virtual machine status bar (p. 
36). Just click the icon and select the desired key combination from the drop-down list. The 
corresponding action will take place in your guest OS and your primary OS will ignore this 
event. 
 

 



 Working in a Virtual Machine 89 
 

Changing the View Mode 
Parallels Workstation Extreme provides a number of view modes to make your work with 
virtual machines more comfortable and efficient: 

 Window mode. This is the default view mode in which the virtual machine screen is 
displayed in the Parallels Workstation Extreme window. The window contains the following 
panes: 
 Summary. This pane provides basic information on the virtual machine and access to the 

Virtual Machine Configuration dialog. The Summary pane also contains buttons for the 
most frequent commands used to start, stop, and otherwise manage the virtual machine. 

 Console. In this pane, you can interact with the running virtual machine via its guest OS 
window. 

 Performance. In this pane, you can view the virtual machine CPU, memory, hard disk, 
and network usage when the virtual machine is running. 

 The Backup tab lists all virtual machine backups. It also contains the controls allowing 
you to create a new backup. 

 Full Screen mode. In this mode the virtual machine screen is expanded to occupy the whole 
of your physical computer screen. 

Switching to the Full Screen Mode 

You can run a guest operating system in the Full Screen mode when the guest operating system 
window occupies the whole screen and all controls are hidden. 

To switch to the Full Screen mode, do one of the following: 

 Click the Full Screen button  in the Parallels Workstation Extreme toolbar. 
 Choose Full Screen from the View menu. 

Note: The default hot key combinations can be configured in the Keyboard pane (p. 41) of 
the Preferences dialog. 

To return to the Window mode, press the appropriate hot key combination (Ctrl+Alt+Enter by 
default). 

Detaching the Console Pane 

In this version of Parallels Workstation Extreme, you can detach the Console pane of your 
running virtual machine from the Parallels Workstation Extreme window and work with it in a 
separate window. 

To detach the Console pane, do one of the following: 

 Choose Detach Console from the View menu. 

 Click the Detach Console button  in the Parallels Workstation Extreme toolbar. 
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Note: If this button is missing from the toolbar, you can add it by customizing the toolbar (p. 
35). 

If you want the Console pane to join the virtual machine window again, do one of the following: 

 choose Attach Console from the View menu 
 click the Attach Console button in the Parallels Workstation Extreme toolbar 
 close the separate Console window 

Locking the guest OS screen resolution 

The virtual machine screen resolution can be changed in the following situations: 

 When you adjust the guest OS display settings. 
 When you resize the virtual machine window (this feature works only when Parallels Tools 

(p. 74) are installed in your virtual machine). 
 When you run an application that automatically changes the screen resolution of your guest 

OS. 

This behaviour of the virtual machine window can be irritating. To freeze the virtual machine 
screen resolution, use the Lock Window option available from the View menu. When the Lock 
Window option is enabled, the virtual machine screen resolution can be changed by adjusting the 
guest OS display settings only. 

Switching to the Coherence Mode 

The Coherence mode provides the highest level of integration between the host and the guest 
operating systems. In this mode, you can have any applications running under these operating 
systems on one desktop. For more information on the Coherence mode, see Working in the 
Coherence Mode (p. 91). 

To switch a running virtual machine to operate in the Coherence mode, do one of the following: 

 Click the Coherence button  in the Parallels Workstation Extreme toolbar. 
 Choose Coherence from the View menu. 

To exit Coherence, click the Parallels Workstation Extreme tray icon and choose Exit 
Coherence. 
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Working in the Coherence Mode 
The Coherence mode is available only for Windows host operating systems and virtual 
machines with the Windows 2000 and later guest operating systems installed. 

Coherence is a visual mode of working with a virtual machine that enables you to use your guest 
OS applications side by side with the host OS applications. 

When you switch a running virtual machine with one or more running applications to the 
Coherence mode, you will see the guest OS applications windows on your host OS desktop 
along with the host OS applications windows. 

Switching to the Coherence Mode 

Only a running virtual machine with Parallels Tools (p. 74) installed can be switched to the 
Coherence mode. 

To switch to the Coherence mode, do one of the following: 

 click the  icon on the toolbar 
 choose Coherence from the View menu 

To exit Coherence, click the Parallels Workstation Extreme tray icon and choose Exit 
Coherence. 

Using Windows Guest OS Start Menu 

When working in the Coherence mode, you may need to access the guest OS Start menu. To this 
effect, do the following: 

1 Point the mouse to the host OS Start menu and the sign of the guest OS Start menu will pop 
up above. 

2 Click this sign and the guest OS Start menu will open. 

Distinguishing Guest OS Applications Windows From Host OS Applications Windows 

When working with a virtual machine in the Coherence mode, you may confuse guest OS 
applications windows with host OS applications windows. Parallels Workstation Extreme allows 
you to distinguish these windows by adding a colored border to the guest OS applications 
windows. 

To add a colored border, do the following: 

1 Choose Configure from the Virtual Machine menu to open the Virtual Machine Configuration 
dialog. 

2 Go to the Coherence pane (p. 126) and make sure that the Use borders option is selected. 

If you do not like the border color, you can change it in the General pane (p. 110) of the 
Virtual Machine Configuration dialog. Choose any from the available palette. 

For example, if you choose red and then switch the virtual machine to the Coherence mode, 
the borders of the guest OS applications windows will be red. 
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Note: Select different colors for different virtual machines or you may confuse the guest 
OSs applications windows if you switch two or more virtual machines to the Coherence 
mode. 
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Changing Configuration at Runtime 
Parallels Workstation Extreme allows you to connect or disconnect certain devices at runtime or 
switch some of them for using other media. 

Generally, the following virtual devices can be connected or disconnected at runtime: 

 CD/DVD-ROM drive 
 Floppy disk drive 
 Network adapter 
 Parallel port 
 Serial port 
 Sound device 
 USB device 
 Shared folders 

Note: Only devices enabled in the virtual machine configuration (p. 109) can be connected or 
disconnected at runtime. 

You can configure any of these devices in one of the following ways: 

 Click a device icon on the status bar (p. 36) and choose the necessary command from a 
device shortcut menu. 
The status bar displays the devices information when the virtual machine is running. 

 Use the necessary command from the Parallels Workstation Extreme Devices menu. This 
menu is available only when the virtual machine is running. 

 Drag and drop an image file (*.iso or *.fdd) or a shared folder on the appropriate device icon 
on the status bar. This option is available for CD/DVD-ROM drives, floppy drives and 
shared folders only. 

Connecting a CD/DVD-ROM or a Floppy Drive 

If you have several CD/DVD-ROM drives connected to your virtual machine, in the Devices 
menu they are listed in the same order as they were connected. The first CD/DVD-ROM drive 
will be CD/DVD-ROM 1, the second will be CD/DVD-ROM 2, and so on. 

Connecting a Network Adapter 

You can set up any of the three network modes: Shared Networking, Bridged Networking, or 
Host-Only Networking. If you have several network adapters used by the virtual machine, on 
the status bar (p. 36) and in the Devices menu they are listed in the same order as they were 
connected. The first network adapter will be Network Adapter 1, the second will be Network 
Adapter 2, and so on. 

Connecting a Parallel Port 
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If you have several parallel ports used by the virtual machine, on the status bar (p. 36) and in the 
Devices menu they are listed in the same order as they were connected. The first parallel port 
will be Parallel Port 1, the second will be Parallel Port 2, and so on. To change the parallel port 
emulation device at runtime, click the parallel port icon on the status bar (p. 36) and choose Real 
Parallel Port, Printer or Connect Output File from the device shortcut menu. 

Connecting a Serial Port 

If you have several serial ports used by the virtual machine, on the status bar (p. 36) and in the 
Devices menu they are listed in the same order as they were connected. The first serial port will 
be Serial Port 1, the second will be Serial Port 2, and so on. To change the serial port emulation 
device at runtime, click the serial port icon on the status bar (p. 36) and choose Real Serial Port, 
Connect to Socket or Connect Output File from the device shortcut menu. 

Connecting a Sound Device 

To connect or disconnect a sound device, choose the Activate or Mute options respectively. You 
can also choose the type of output and input devices. 

Connecting a USB Device 

Parallels Workstation Extreme automatically detects all USB devices plugged into the host 
computer. The devices that are currently connected to the virtual machine appear in the list from 
the Device menu. You cannot use a USB device in the primary operating system while it is 
being used by the virtual machine. If you want to use the USB device in the primary operating 
system again, just disconnect it from the virtual machine. 

Connecting a Shared Folder 

The Shared Folders options available at runtime are much alike the settings in the Virtual 
Machine Configuration dialog. 

You can 

 share the host computer disks or Home Folder only with the guest operating system 
 share the guest operating system disks with the primary OS 
 add a new shared folder 

You can connect or disconnect all shared folders at a time by clicking the device icon on the 
status bar (p. 36) and choosing Connect All or Disconnect All from the device shortcut menu or 
by choosing the corresponding commands from the Parallels Workstation Extreme Devices 
menu. 
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Using Devices 

Setting up a Printer in a Virtual Machine 
There are four basic ways to set up printing in a virtual machine. You can: 

 share a host computer's printer (p. 96) 
 use a network printer (p. 98) 
 set up printing via LPT port of the physical computer (p. 99) 
 set up a USB printer (p. 100) 
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Sharing a Host Computer's Printer 

You can share any printer connected to the physical computer with your Windows or Linux 
virtual machine. The printer will be available through the virtual machine's parallel port. 

To share the physical computer's printer: 

1 Launch Parallels Workstation Extreme and open the virtual machine. 

2 Open the Virtual Machine Configuration dialog by choosing Configure from the Virtual 
Machine menu. Make sure that the configuration includes a parallel port. If necessary, add it. 
See Adding a Parallel Port (p. 167). 

3 In the Parallel Port pane, make sure that the Enabled option is selected. Select Connected, if 
you want the printer to be automatically connected on the virtual machine startup. 

4 Select the Printer option. You can choose a specific printer from the printers list or use the 
Default printer option if you want to use the default printer set in the primary OS. 

Click OK to close Virtual Machine Configuration. 

5 Start the virtual machine. 

6 In a Windows guest OS, if you have Parallels Tools installed (p. 77), the HP Color LaserJet 
8500 PS printer is automatically connected to your virtual machine and you can use it at 
once. In a Linux guest OS or if you do not have Parallels Tools installed in your Windows 
guest OS, no matter what type of printer you have, install the HP Color LaserJet 8500 PS 
printer driver and then follow the procedure of adding a printer in a guest OS described 
bellow. 

Warning: Do not install the driver from the installation CD, supplied with your printer, in the 
virtual machine. 

Adding a printer in a Windows guest operating system 

To add a printer in a Windows guest OS: 

1 Start the Windows virtual machine and log in as administrator. 

2 Open the Windows Start menu, select Control Panel. 
3 In the Control Panel window, select the Printers and Faxes (or Printers, or Printers and Other 

Hardware) item. 

4 Open the Add Printer wizard: 

 In Windows XP/Vista double-click the Add a printer link. 

5 In the Add Printer wizard: 

 In Windows Vista: 

- click Add a local printer, 
- select Use an existing port and click Next. 

 In Windows XP: 

 - click Next in the wizard's first dialog, 

 - in the Local or Network Printer dialog, click Local printer attached to this computer. 
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6 Continue with the general installation procedure and install the HP Color LaserJet 8500 PS 
printer driver. 

Adding a printer in a Linux guest operating system 

To add a printer in a Linux guest OS: 

1 Start the Linux virtual machine and log in as administrator. 

2 Open the /etc/printcap/ configuration file and click the Add option. 

3 Select the type of printer to add: Local printer. Click Ok. 

4 Printtool will attempt to detect any printers which are attached to your parallel port and 
will show you the results. Click Ok. 

5 Specify the details about your printer, such as a name of the printer and its related spool 
directory, the location of the printer device and other options. 

6 The Input Filter contains information about your specific printer and its formatting 
requirements. To add your printer's information, click Select. The Configure Filter dialog will 
open. 

7 Choose the printer type: choose the HP Color LaserJet 8500 PS printer driver. You can also 
set here other printing parameters. Click Ok. 
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Setting Up a Network Printer 

You can install a network printer directly into a guest OS. 

Before installing a network printer in a guest OS, make sure that: 

 Networking in the primary and guest OSs is configured. 
 The virtual machine network adapter is connected to the corresponding virtual machine and 

enabled. To do this: 
 Select Configure from the Virtual Machine menu. 

 Click the Network Adapter item in the left pane. 

 Make sure that the Enabled and Connected options are selected. If they are cleared, 
select these options and click OK. 

 The user account in the guest OS from which you will setup the printer has permissions to 
access the network printer. 

 You know the printer's IP address. 

After that, you can log into your guest OS and install a network printer. 

In a Windows Guest Operating System 

Before adding a network printer to Windows, download and install an appropriate printer driver. 

The procedure of adding a network printer is almost the same for all Windows guest OSs. To 
add a network printer in Windows XP or Windows Vista: 

1 Choose Control Panel from the Start menu in your guest OS. 

2 Click Printers and Faxes in Windows XP or Printers in Windows Vista. 

3 Click the Add printer icon. 

4 In the Add Printer wizard introduction window, click Next. 
5 In Windows XP, select the Local printer attached to this computer option and disable 

Automatically detect and install my Plug and Play printer. 
In Windows Vista, choose the Add a Local Printer option. 

6 Select Create a new port and specify Standard TCP/IP port as the port type. 

Click Next. 
7 In the next window, specify the printer's IP address and click Next. 
8 If prompted to specify additional port information, choose Standard and select Generic 

Network Card from the list. 

9 In the next window, click Finish. 

10 In the Install Printer Software window, specify the manufacturer of the driver and select the 
model of the network printer. 

If the required printer model is not listed, click the Have Disk button and specify the path to 
the .inf file in the driver installation folder. 

When finished, click Next. 
11 Follow the wizard's instructions to complete the installation. 
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In a Linux Guest Operating System 

Make sure that the following components are installed in your guest Linux system: 

 Common UNIX Printing System (CUPS). Installation instructions can be found at CUPS 
site; 

 Samba service. Installation instructions can be found at Samba site; 
 A Web browser, since we consider controlling CUPS via web interface; 

Note: To set up a network printer, you should have the root privileges. 

Before adding a network printer to Linux, download and install an appropriate printer driver. 

To add a network printer in a Linux guest OS: 

1 Start your Linux virtual machine. 

2 Start Common UNIX Printing System. 

In a terminal, type the command: 
/etc/init.d/cups start 

3 Start a web browser and type either the IP address of your virtual machine or 
http://127.0.0.1:631. 

4 Click the Add Printer button. 

5 In the Add New Printer window, enter a printer name, location, and description. 

6 In the Device for <Printer Name> window, select the Windows Printer via Samba. 

7 In the Device URI for <Printer Name> window, specify the path to the network printer in the 
following format: 
smb://<computer name>/<printer name> 

8 In the Make/Manufacturer for <Printer Name> window, select the model of your printer. 

9 Enter the root password when prompted. 

10 CUPS performs installation. If the installation is successful, the "Printer <name> has 
been added successfully" message is displayed. 

 

Setting Up Printing via LPT Port of Physical Computer 

To set up printing through a parallel port of your physical computer: 

1 Make sure that a printer is connected to an LPT port of your real computer. 

2 Open the virtual machine configuration in Configuration Editor, make sure that the 
configuration includes a parallel port. If necessary, add it. See Adding a Parallel Port (p. 167). 

3 On the Parallel Port Options tab, make sure that the Enabled and Connected options are 
selected. 

4 Select the Real Port option and choose the necessary parallel port of your physical computer 
from the corresponding drop-down menu. 

5 Click OK and start the guest operating system. 

6 Install the native driver for your printer in the guest OS. 
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Setting Up a USB Printer 

To set up a USB printer: 

1 Launch Parallels Workstation Extreme and choose the virtual machine. 

2 Open the Virtual Machine Configuration dialog by choosing Configure from the Virtual 
Machine menu. Make sure that the configuration includes a USB controller. If necessary, add 
it. See Adding a USB Controller (p. 168). 

3 Open the USB Controller pane and make sure that the Enabled option is selected. Click OK. 
4 Start the virtual machine. 

5 Plug in the USB printer as a USB device. See Using USB Devices in a Virtual Machine (p. 
103). 

6 Install the native driver for the printer in the guest OS. 
 

 



 Working in a Virtual Machine 101 
 

Using Intel VT-d PCI Devices in Parallels Virtual Machines 
If your computer has an Intel VT-d chipset, you can set the physical PCI Express (PCIe) devices 
connected to the physical computer to be directly assigned to your virtual machine. The virtual 
machine will directly access the PCIe devices without using the resources of the primary OS. 

You can connect up to eight PCIe devices of any of the supported types to a single virtual 
machine. 

To connect a PCIe device to a virtual machine 
1 Assign the device to your virtual machines in the Intel VT-d pane (p. 51) of Parallels 

Workstation Extreme Preferences. 

Note: You are recommended to have at least two adapters of the same type (video or 
network adapters): if you reassign one adapter to your virtual machines, the other adapter 
will be left to the physical computer. Keep in mind that if you assign your video or network 
adapter to a virtual machine, this adapter will be invisible to your primary OS. 

2 Add the device to the virtual machine configuration. For more information, refer to the 
Adding a Network Adapter (p. 161), Adding a Video Adapter (p. 163), and Adding Intel VT-d 
PCI Devices (p. 169) subsections. 

Troubleshooting 

In Windows-based virtual machines, if the pass-through driver cannot be installed automatically 
after a PCIe device has been assigned to virtual machines in Preferences, install it manually by 
doing the following: 

1 Go to Start > Control Panel > System > Hardware and open the Device Manager. 

2 In the Device Manager, locate the appropriate PCIe device, right-click it and choose Update 
Driver from the context menu. 

3 In the Hardware Update wizard, choose to install the driver from the specific location. 

4 Choose to specify the driver yourself. 

5 In the next window, select the Have Disk option and specify the following path to the 
driver’s location: C:\Program Files\Parallels\Parallels 
Workstation\Drivers\prl_vtdvideo.inf or C:\Program 
Files\Parallels\Parallels Workstation\Drivers\prl_vtdnet.inf 
and click Open. 

6 Follow the wizard’s instructions to complete the installation of the driver. 

7 Restart the host computer. 

In rare cases you cannot boot the primary Linux operating system after a PCIe device is added to 
the configuration of a virtual machine. To work around the issue, do the following: 

1 In the grub loader splash screen, with your primary operating system selected in the list, 
press e on the keyboard to display the boot parameters. 

2 Select the line starting with "kernel" by pressing the down arrow on the keyboard. 

3 Press e to launch an editor for the selected line. 
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4 At the end of the line, add 
init=/bin/sh 

5 Press Enter to return to the boot parameters screen. 

6 Press b to boot the kernel. 

7 In the command line window, mount the root partition in read-write mode by entering 
mount /dev/root / -oremount,rw  

Note: If you want your root partition to be mounted to a different location, replace root 
with this location in the command above. 

8 Type the following command and press Enter: 
echo -n "" > /etc/parallels/vtd.hook 

9 Type the following command and press Enter: 
mount /dev/root / -oremount,ro  

10 Type the following command and press Enter: 
reboot 

This procedure will make your primary Linux operating system boot normally. 
 

 



 Working in a Virtual Machine 103 
 

Using USB Devices in a Virtual Machine 
Parallels Workstation Extreme provides you with the possibility to connect up to eight USB 2.0 
and eight USB 1.1 devices to a single virtual machine. This means that you can plug up to eight 
USB 2.0 devices and eight USB 1.1 devices into the host computer and use them from the 
virtual machine. To use this feature, you should add a USB controller to the virtual machine 
configuration (p. 109). If the USB controller is already present in the virtual machine 
configuration, make sure it is enabled. 

By default, when you plug a USB device into the host computer, the New USB Device dialog 
asks if you want to connect this device to the host computer or to the virtual machine you are 
currently working with. 

 Click Host Computer if you want to use this USB device in the host operating system. 
 Click Virtual Machine if you want to use this USB device in the virtual machine you are 

currently working with. 

Note: If you select to connect the detected USB device to the virtual machine and then reboot 
this virtual machine, the New USB Device dialog will not appear again after the reboot. The USB 
device will still be connected to this virtual machine. 

If you want Parallels Workstation Extreme to remember your choice, select Remember this 
association. The next time you plug this USB device into the host computer, it will be 
automatically connected to the destination you specified in this dialog. To change the 
destination, use USB Preferences in the Preferences dialog (p. 38). 
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If you do not want Parallels Workstation Extreme to display this dialog each time a USB device 
is plugged into the host computer, configure USB Preferences in the Preferences dialog (p. 38). 

To be able to use the USB device in the virtual machine, you may need to install the necessary 
drivers in the guest OS. By default, such drivers can be obtained from the manufacturers of this 
device. 

Note: If you plug a USB 1.1 device into the USB 2.0 port, the port will be identified as USB 
1.1. 

Connecting a USB device to a virtual machine running on a Windows XP host computer 

If Parallels Workstation Extreme is installed on your Windows XP host computer, perform the 
following operations to connect a USB device to a virtual machine for the first time: 

1 Connect the USB device to the host computer. 

2 In the New USB Device dialog, click Virtual Machine. 

3 In this step, you will have to install the Parallels USB Device driver into the host OS. The 
host operating system will open the Found New Hardware Wizard dialog. In this dialog: 

 Select Install from a list of specific location (Advanced) and click Next. 
 Select Search for the best driver in these locations, tick Include this location in the search, 

and indicate the C:\Program Files\Parallels\Parallels Workstation Extreme\Drivers\USB 
location. Click Next. The Parallels USB Device driver will be installed into the host OS. 

4 Unplug the USB device and replug it into the host computer. 

5 In the New USB Device dialog, click Virtual Machine. The USB device will appear in the 
guest operating system. 

Next time, you will not have to install the Parallels USB Device driver for this USB device. 

Connecting a USB device to a virtual machine running on a Linux host computer 

To connect a USB device to a virtual machine running on a Linux host computer: 

1 Connect the USB device to your physical computer. 

2 Start the virtual machine and log in to the virtual machine guest OS. 

3 When the guest OS boots up, connect the USB device by clicking the USB Controller icon 
in the virtual machine's window status bar and choosing your USB device name from the 
list. 
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Using Safe Mode 
If you do not want a virtual machine to store the changes you make to it during the working 
session, you can start this virtual machine in Safe Mode. To be able to start the virtual machine 

in Safe Mode, you need to add the Safe Mode button  to the Parallels Workstation Extreme 
toolbar first. To this effect: 

1 Right-click the toolbar in the virtual machine's window, and choose Customize Toolbar (p. 
35). 

2 Drag the Safe Mode button  to the toolbar and click Done. 

When you have added the Safe Mode button  to the toolbar, you can use this button for 
starting the virtual machine in Safe Mode. When you shut down a virtual machine operating in 
Safe Mode, you will be asked whether you want to discard the changes made to the virtual 
machine's hard disk or to apply them: 

 If you choose to discard the changes, the virtual machine's hard disk will be left intact and 
no changes made to it during your work in Safe Mode will be saved. 

 If you choose to apply the changes, the virtual hard disk will keep all the changes made to it 
during your work in Safe Mode. After applying the changes, the virtual machine will not be 
able to return to the state it had before you started this virtual machine in Safe Mode. 

If you want the virtual machine to permanently work in Safe Mode, you can enable the Undo 
Disks option in the Startup and Shutdown (p. 114) pane of Virtual Machine Configuration (p. 
109): 

1 Choose Configure from the Virtual Machine menu to open the virtual machine configuration. 

2 Click Options in Virtual Machine Configuration. 

3 Select Startup and Shutdown. 

4 In the Startup and Shutdown pane, select the Enable undo disk option and click OK. 

Fore more information about the Undo Disks option, refer to Startup and Shutdown Settings (p. 
114). 

Usage Tip 

Running the virtual machine in Safe Mode can be useful when testing the behavior of some 
applications to make sure that they cannot damage your computer. 
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Using Shared Folders 
Shared folders are folders in the host computer operating system that are visible to the guest OS 
too. These folders can be used for exchanging files between the host computer operating system 
and a virtual machine or between several virtual machines. 

In the primary OS shared folders appear as usual folders, while in the guest OS they are objects 
of the network neighborhood. 

Using shared folders is possible for the Windows and Linux guest operating systems. See the list 
of supported guest operating systems (p. 57). 
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Setting Up a Shared Folder 
Setting up a shared folder requires two steps: 

1 Installing Parallels Tools in the guest OS. The Shared Folders tool is require for viewing the 
shared folders in the guest OS. See Installing Parallels Tools (p. 74). 

2 Adding one or more shared folders to the virtual machine configuration. 

Adding a Shared Folder 
1 Open the virtual machine configuration by choosing Configure from the Virtual Machine 

menu. 

2 In the Virtual Machine Configuration dialog, select the Shared Folders tab (see Shared Folders 
(p. 120)). 

3 Select the Enable shared folders option. 

4 Click the  button to open the Shared Folder Properties window. 

5 In the Shared Folder Properties window: 

 Make sure the Enabled option is selected. 

 In the Path field, type the path to the folder you want to share with the virtual machine. 
You can also use the Choose button to locate the folder. 

 In the Name field, type the shared folder name under which the folder will be accessible 
from inside the virtual machine. 

 In the Description field, you can provide a brief description for the shared folder. 

 Select the Read-only option if you want the shared folder to have a read-only status when 
accessed from inside the virtual machine. 

 Click OK. 

 
6 Click OK in the Virtual Machine Configuration dialog. 
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Viewing Shared Folders in Guest OS 
There are three ways to view the contents of the shared folders in the guest OS. 

Easy Way 1 

Click the Parallels Shared Folders icon on the desktop of the running guest OS and you will see 
all your shared folders. 

Easy Way 2 

If you select Map folders to drive letters in the Shared Folders pane (p. 120) of Virtual Machine 
Configuration, shared folders will be displayed as new disks with drive letters assigned every 
time you open up My Computer in the guest operating system. 

General Way 
1 In the virtual machine, open Windows Explorer. 
2 In Explorer, select My Networks Places, then select Entire Network, and find Parallels Shared 

Folders. 

3 Click Parallels Shared Folders to view the list of shared folders available in your virtual 
machine. 

Note: To be able to write to a shared folder inside a virtual machine, make sure that the Read 
Only check box (p. 120) for this folder is cleared in the Virtual Machine Configuration dialog. 
 

Making Guest OS Screenshots 
If you want to make a screenshot of the guest operating system when it is running, choose Make 
Screenshot from the View menu. The first screenshot file will be named Parallels 
Picture.png and placed on the primary operating system desktop. The next screenshots will 
have the same name with an appropriate number added. 
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C H A P T E R  7  

Configuring a Virtual Machine 

This chapter provides the information on configuration options available to a virtual machine. 

In This Chapter 
Editing Virtual Machine Configuration ................................................................................ 109 
Adding and Removing Devices............................................................................................. 150 
Networking in a Virtual Machine.......................................................................................... 172
 
 

Editing Virtual Machine 
Configuration 

The configuration of an existing virtual machine can be changed in the Virtual Machine 
Configuration dialog. You can open the Virtual Machine Configuration dialog by doing one of 
the following: 

 Choose Configure from the Virtual Machine menu. 
 Click the Configure button on the toolbar of the virtual machine main window. 
 Right-clicking the virtual machine in the main window sidebar and choosing Configure from 

the context menu. 
 Selecting Configure in the Operations area of the virtual machine Summary pane or clicking 

any of the items in the Configuration area. 

Virtual Machine Configuration allows you to configure your virtual machine in a variety of 
ways. For example, you can 

 Configure the virtual machine general options in the General window (p. 110). 
 Define the virtual machine boot options in the Boot Order pane of the Hardware window (p. 

112). 
 Configure different parameters of the devices currently available inside the virtual machine: 

hard disk drives (p. 134), CD/DVD-ROM drives (p. 132), floppy disk drives (p. 131), etc. 
 Configure the resource values currently set for the virtual machine: main memory (p. 128), 

video memory (p. 129), CPU (p. 127), etc. 
 Add a new device to the virtual machine or remove an existing one (p. 150). 
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General Settings 
You can view and configure the virtual machine general settings on the General pane of Virtual 
Machine Configuration. 
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The General pane includes the following parameters: 

 VM Name. This field displays the name assigned to the virtual machine. The length of the 
name is limited to 50 characters. The name of the virtual machine is displayed on its main 
window and guest OS window. 

 OS Type. This field displays the type of the operating system installed in the virtual machine 
or declared to be installed in future. 

 OS Version. This field displays the version of the operating system installed in the virtual 
machine or declared to be installed in future. 

Note: The OS type and version fields should reflect the real operating system type and version 
installed in the virtual machine. 

 Description. This field displays additional information related to the virtual machine. 

Using the host computer's SMBIOS data 

Some applications may require the computer hardware characteristics. The host computer BIOS 
saves this information in the SMBIOS tables. These tables can be easily reached and processed 
by different applications. You can copy the SMBIOS tables from your primary OS to your guest 
OS by choosing the Use the host computer's SMBIOS data option. 

Disabling the PC speaker 

A virtual machine can utter various sounds (beeps and whistles) generated by its guest operating 
system using the PC speaker. If you want to disable these sounds, select the Disable PC speaker 
option. 

To save the changes, click OK, otherwise, click Cancel. 
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Boot Order Settings 
Using the Boot Order Settings, you can configure the virtual machine boot sequence, that is, the 
order in which the virtual machine will try to load the operating system from different boot 
devices. 

Note: These settings cannot be changed when the virtual machine is running. 
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The currently supported boot devices are listed below: 

 Hard Disk. Select this device if you want the virtual machine to boot up from its virtual hard 
disk drive. 

 CD/DVD-ROM. Select this device if you want the virtual machine to boot up from the media 
connected to its virtual CD/DVD-ROM drive. 

Note: The virtual machine will use the CD/DVD-ROM drive specified as CD/DVD-ROM 1 in 
its configuration. 

 Floppy Disk. Select this device if you want the virtual machine to boot up from a floppy disk 
image connected to its virtual floppy disk drive. 

 Network Adapter. Select this device if you want your virtual machine to boot from a network 
adapter using PXE (Pre-Execution Environment). 

Note: The virtual machine will use the network adapter specified as Network Adapter 1 in its 
configuration. 

Every time you start the virtual machine, it tries to boot from the device specified as the first one 
in the Boot order list. If the virtual machine cannot boot from the first device (for example, no 
media is connected to it), the virtual machine proceeds to the second device in the list and tries 
to boot from this device, and so on. 

On this pane, you can perform the following operations: 

 Change the currently set boot sequence by selecting the name of the corresponding boot 
device in the Boot order list and moving it up or down using the arrows to the right of the 
list. 

 Remove a boot device from the sequence by clearing the check box next to its name. 

If you choose the Select boot device on startup option, you will see the following message at the 
virtual machine startup: "Press ESC to select boot device". If you press ESC 
pending 5 seconds, you will be able to select a boot devise. If you do not press ESC, the virtual 
machine will try to boot from the devices specified in the Boot order list. 

Note: Make sure that the device you wish to use for your virtual machine booting (hard disk 
drive, CD-ROM drive, floppy disk drive, or network adapter) is available to the virtual machine 
and configured properly. If you do not have any boot devices configured in your virtual 
machine, you will see the following error message after you start the virtual machine: “No 
boot device is available”. In this case, you should stop the virtual machine and 
configure at least one boot device for it. 
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Startup and Shutdown Settings 
The Startup and Shutdown pane of Virtual Machine Configuration allows you to define a 
number of parameters related to the procedures of starting and shutting down your virtual 
machine. 
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In this pane, you can configure the following parameters: 

 The Startup view mode option defines the mode in which the virtual machine will work after 
you select it from the Parallels Workstation Extreme sidebar and start. If the Window or Full 
Screen or Coherence option is selected, the virtual machine will automatically switch to the 
specified view mode (p. 89). If the Same as last time option is selected, the virtual machine 
will start in the same mode that was applied to it before it was turned off. 

 The On application start option defines the operation to be performed on this virtual machine 
when you start Parallels Workstation Extreme. 
 Select Start/Resume if you want your virtual machine to start automatically every time 

you start Parallels Workstation Extreme. 

 Select Do Nothing if you do not want your virtual machine to start automatically when 
you start Parallels Workstation Extreme. 

 The On application exit option defines the operation to be performed when you close 
Parallels Workstation Extreme: 
 Select Suspend if you want the virtual machine to be suspended when you close the 

application. 

 Select Stop if you want the virtual machine to be shut down when you close the 
application. 

 If you select Ask me what to do, you will be prompted to choose the operation to perform 
with the virtual machine each time you close Parallels Workstation Extreme. 

Undo Disks 

The Enable Undo Disks option allows you to discard or apply the changes you made to the 
virtual machine's hard disk during your working session. If you choose to discard them, the 
changes will be discarded when you shut down the virtual machine. When you start this virtual 
machine again, its virtual hard disk will have the same data it contained before you started the 
previous working session. If you choose to apply the changes on the virtual machine shutdown, 
the next time you start this virtual machine, its virtual hard disk will store the changes you made 
during the previous working session. 

Note: When enabled, the Undo Disks feature is applied to all virtual hard disks this virtual 
machine uses. 

You can choose whether you want to discard the changes you made to the virtual machine's hard 
disk or choose the action to perform in the On shutdown field. 

 Discard changes. Select this option if you want to discard the changes when you shut down 
this virtual machine. 

 Ask me what to do. If this option is selected, you will be prompted to choose the action to 
perform with the changes (discard or apply them) each time you shut down the virtual 
machine. 

Note: You cannot create snapshots of virtual machines that have this option enabled. 
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Optimization Settings 
On the Optimization pane of Virtual Machine Configuration, you can configure two groups of 
settings related to the virtual machine performance. 
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Adaptive Hypervisor 

Select the Enabled option for Adaptive Hypervisor to automatically allocate the host computer 
CPU resources between the virtual machine and primary OS applications depending on what 
application you are working with at the moment. If the virtual machine window is in focus, the 
priority of this virtual machine processes will be set higher than the priority of the primary OS's 
processes. As a result more CPU resources will be allocated to the virtual machine. If you 
switch to the primary OS window - the priority of its working applications will be set higher and 
the CPU resources will be relocated to the primary OS. This Adaptive Hypervisor technology is 
useful when you use a lot of applications in the primary and guest OSs at a time and as a result 
lack the CPU resources. 

Optimizing Performance 
 Virtual machine. Select this option to allocate more physical computer memory resources to 

the virtual machine and its applications. Selecting this option may significantly increase the 
virtual machine performance; however, it may slow down the productivity of your host 
computer applications. 

 Host computer. Select this option to allocate more memory resources to the host computer 
and its applications. 

Power Consumption (laptops only) 

This group of settings allows you to control the virtual machine power consumption if Parallels 
Workstation Extreme is installed on a laptop computer that is running on batteries: 

 Longer battery life. If you select this option, the virtual machine power consumption will be 
automatically reduced to provide a longer life for the battery of your laptop. 

 Better performance. If you select this option, the virtual machine and its applications will 
operate at the maximum possible speed. However, enabling this option may significantly 
reduce the battery life. 

 Enable battery in virtual machine. If you enable this option, the battery status will be 
displayed in your virtual machine each time your laptop computer runs on batteries. 
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Services Settings 
The Services pane of Virtual Machine Configuration allows you to manage a number of 
Parallels Tools-related parameters. 

Note: To use the functionality available on the Services pane, you should have Parallels Tools 
installed in the virtual machine. 
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Mouse and Keyboard Synchronization 

Select the Automatically capture and release the mouse pointer option to facilitate the process of 
switching the keyboard and mouse input between the virtual machine and physical computer. 
With this option enabled, Parallels Workstation Extreme automatically grabs input from the 
keyboard and mouse and directs it to the virtual machine. 

Clipboard Synchronization 

Select the Share Clipboard option to allow sharing your clipboard between the virtual machines, 
or the virtual machine and the physical computer. With this option enabled, you can copy and 
paste text and files from the physical computer to the virtual machine, and vice versa, as well as 
copy and paste texts and files between the Parallels virtual machines. 

Note: This option is available for Windows guest operating systems only. For more details, see 
the Parallels Tools Overview section (p. 75). 

Time Synchronization 

Select the Synchronize time with the host computer option to synchronize the time settings of 
your virtual machine with those of the physical computer. You can specify the frequency of time 
synchronization checks in the Synchronize every field. 

If the time zone set in your virtual machine differs from that of the physical computer, you can 
maintain this time difference by selecting the Allow a different time than the host computer 
option. 
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Shared Folders Settings 
You can manage shared folders and their parameters in the Shared Folders pane of Virtual 
Machine Configuration. 

Shared folders and their parameters can be configured for Windows and Linux guest operating 
systems. 

You can also change the shared folders settings at runtime. To learn how to do it, refer to the 
Changing the Configuration at Runtime (p. 93) section. 

Note: To use the functionality available on the Shared Folders pane, you should have Parallels 
Tools (p. 74) installed in the virtual machine. 
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Sharing the host computer's folders with the virtual machine 

Select the Share the host computer's folders with the virtual machine option to enable access to 
the disks and folders on the physical computer from inside the virtual machine. If this option is 
selected, you can configure access to the physical computer disks and folders as follows: 

 Select the System disk option (the All disks option if Parallels Workstation Extreme is 
installed in a Linux host OS) to provide the virtual machine with access to: 
 the Windows-based physical computer disk where the operating system is installed 

 the root catalogue of the Linux-based physical computer 
 Select the Home folder only option to provide the virtual machine with access to the Home 

folder on the physical computer. 

Note: When you share the host computer's disks or folders with a virtual machine, they still 
reside and occupy space on the host computer's hard disk. 

Defining physical computer folders to be shared 

Select the User-defined folders option to manually specify one or more folders on the physical 
computer that are to be shared with the virtual machine. 

To add a shared folder: 

1 Click the Add  button. 

2 In the Add Shared Folder dialog, specify the following settings: 

 Enabled. Select this option to enable the shared folder. 

 Path. In this field, type the path to the folder you want to share with the virtual machine. 
You can also use the Choose button to locate the folder. 

 Name. In this field, type the shared folder name under which the folder will be accessible 
from inside the virtual machine. 

 Description. In this field, you can provide a brief description for the shared folder. 

 Read-only. Select this option if you want the shared folder to have a read-only status 
when accessed from inside the virtual machine. 

3 Click OK. 

To remove a shared folder, select its name and click the Remove  button. 

Mapping folders to drive letters 

Note: This functionality is available only to Windows guest operating systems with Parallels 
Tools (p. 74) installed. 

In the guest operating system, shared folders can be displayed as new disks with disk letters 
assigned. You may find it useful if you need to repeatedly access the shared folders. To display 
the shared folders as disks, select Map folders to drive letters. With this option selected, if you 
open up My Computer in the guest operating system, you will see the host computer's shared 
folders as new disks with drive letters assigned. 
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Shared Profile Settings 

 

To enable the Shared Profile functionality, select the Enabled option at the top of the Shared 
Profile pane. 

If the Shared Profile functionality is activated, you can choose one of the following options: 

 Select Desktop to use the host computer desktop as the desktop in your Windows guest OS. 
 Select Document to use the Linux host computer Documents directory or the Windows host 

computer My Documents folder as the My Documents folder in your Windows guest OS. 
 Select Pictures to use the Linux host computer Pictures directory or the Windows host 

computer My Pictures folder as the My Pictures folder in your Windows guest OS. 
 Select Music to use the Linux host computer Music directory or the Windows host computer 

My Music folder as the My Music folder in your Windows guest OS. 

Notes: 1. If there is no the Desktop, Documents, Pictures, or Music directory in the Linux 
primary OS home directory (/home/<username>), the corresponding directory will be 
automatically created before mounting. 

2. The Shared Profile functionality is available for Windows guest operating systems only. 
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SmartMount Settings 
The SmartMount pane of Virtual Machine Configuration allows you to configure the settings 
related to the automatic detection and mounting of removable devices in your virtual machines. 

Note: The SmartMount option is available for Windows and Linux virtual machines with 
Parallels Tools installed. 

 

If the SmartMount option is enabled, any device that you connect to the host computer is also 
automatically mounted to your guest operating system. For example, a USB flash drive plugged 
in to your host computer will be accessible from both the host computer and My Computer in 
the Windows virtual machine. The following devices can be automatically mounted to your 
virtual machines: 

 external storage devices such as USB hard disks and USB flash drives 
 CD-ROM and DVD-ROM drives 
 network shares 
 mounted images (ISO) 

The permissions you will have for managing the mounted device from inside the virtual 
machine will coincide with those you have for this device in the host computer. So, if you can 
read from and write to a USB flash drive in the host computer, you will have the same 
permissions for this drive from inside the virtual machine. 
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SmartGuard Settings 
Using the SmartGuard Settings, you can automate snapshots creation. You can find detailed 
information on snapshots and how to work with them in the Working with snapshots chapter (p. 
191). 

To edit these settings, perform the following: 

1 Open the Virtual Machine menu or Alt-click (Option-click) the Parallels icon in the Mac 
menu bar (in the Crystal view mode). 

2 Click Configure. 

3 In the Virtual Machine Configuration window, click Options, and select these settings name in 
the sidebar.  

Note: When your virtual machine is paused, snapshot can be created neither manually nor 
automatically. 
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To enable the SmartGuard functionality, select the Enabled option at the top of the SmartGuard 
pane. 

Note: The SmartGuard feature is available only when the Undo Disks feature is disabled and if 
the virtual machine is not runnning in Safe Mode (p. 105). 

If you want to know when it is time to make the next snapshot and to be able to reject the 
snapshot creation, enable the Notify me before snapshot creation option. 

Setting the Time Interval 

Set how often snapshots should be made in the Interval for taking a new snapshot field. You can 
set from one hour to 48 hours. 

If the time interval is less than 24 hours, SmartGuard will allow you to restore the latest hourly, 
daily and weekly snapshot. If the time interval is more than 24 hours, you will be able to restore 
the latest daily, weekly and monthly snapshot. 

To manage the snapshots and restore any of them, use Snapshot Manager (p. 193). 

Restricting the Snapshots Number 

Use the Maximum number of snapshots to keep field to set the maximum number of snapshots 
that can be stored on the host computer. The maximum available value is 100 snapshots. As 
soon as Snapshots Manager reaches the limit for snapshots and needs to make a new one over 
the limit, it deletes the oldest snapshot. 
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Coherence Settings 
The Coherence pane of the Virtual Machine Configuration dialog allows you to configure the 
following settings: 

 

 Use borders. This option is selected by default. It determines whether the guest OS 
applications windows will have the colored borders when you work in the Coherence mode 
(p. 91) or not. 

 Color. The border color of the guest OS applications windows. If you want to change the 
color, go to the General pane (p. 110) and choose any from the available palette. 

Note: Select different colors for different virtual machines or you may confuse the guest 
OSs applications windows if you switch two or more virtual machines to the Coherence 
mode. 
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CPU Settings 
You can view and configure the virtual machine's CPU settings on the CPU pane of Virtual 
Machine Configuration. 

Note: These settings cannot be changed when the virtual machine is running. 

 

This pane allows you to configure the number of virtual CPUs that will be used to handle the 
processes running in the virtual machine. To this effect, choose the necessary number of CPUs 
from the drop-down menu. The maximum allowable number of virtual CPUs depends on the 
number of physical CPU cores available to the host computer. For example, if you have the 
Core 2 Duo physical processor, the maximum allowable number of virtual CPUs will be 2. 
However,in any case, you will not be able to set more than 12 virtual CPUs to a virtual machine. 

In the Hardware Virtualization field, you can view the type of hardware virtualization technology 
used by the virtual machine to emulate the hardware. 

To view or edit other CPU settings, select the Show advanced settings check box. You can edit 
the following advanced settings: 

 System Flags. The flags you type here will change the virtual machine system behavior. 

Note: System flags can be used by the Parallels customer support team in cases when 
something goes wrong in your virtual machine. It is not recommended to type anything into 
this field without being instructed to do so by the customer support staff. 
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Memory Settings 
To view and configure the amount of RAM available to your virtual machine, use the Memory 
pane of Virtual Machine Configuration. 

Note: These settings cannot be changed when the virtual machine is running. 

 

In the Main Memory field, you can set the amount of RAM that will be available to the virtual 
machine. You can specify any value from 4 to 8192 MB, but it is recommended that you set the 
value provided in the Optimal Size field below the slider. This will provide the most optimal 
performance for your virtual machine and the host computer. 

By default, the optimal size is the amount of RAM the guest operating system needs. If some of 
the applications installed in your virtual machine need more RAM, you can set a greater amount 
of RAM for this virtual machine, provided the memory resources of the host computer are 
enough for running both the primary operating system and this virtual machine. 

Note: If the host computer has 1 GB of RAM, it is strongly recommended to assign not more 
than 512 MB to a single virtual machine. 

To configure the main memory limit, do one of the following: 

 drag the slider 
 use the Main Memory spin box arrows 
 type the value directly into the Main Memory field 
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Video Settings 
To view and configure the amount of video memory available to the virtual machine's video 
card, use the Video Settings. 

To edit these settings, perform the following: 

1 Open the Virtual Machine menu or Alt-click (Option-click) the Parallels icon in the Mac 
menu bar (in the Crystal view mode), and click Configure. 

2 In the Virtual Machine Configuration window, click Hardware, and select Video in the sidebar.  

Note: These settings cannot be changed when the virtual machine is running. 
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In the Video memory field, you can set the amount of video memory that will be available to the 
virtual machine. You can specify any value from 2 to 256 MB; however, we recommend that 
you choose the value from the range given in the Recommended size field below the slider. This 
will provide the most optimal performance for your virtual machine and the physical computer 
where this virtual machine is hosted. 

The Maximum screen resolution field shows the maximum screen resolution that will be 
supported in the virtual machine with the specified amount of video memory. 

To configure the video memory limit, do one of the following: 

 drag the slider 
 use the spin box arrows 
 type the value directly into the Video memory field 

Keeping Virtual Machine's Screen Resolution in Full Screen Mode 

The way the virtual machine is displayed in the Full Screen mode (p. 89) depends on the virtual 
machine's screen resolution and on whether Parallels Tools (p. 74) are installed or not: 

 If the virtual machine's screen resolution is lower than that of the host computer and there 
are no Parallels Tools (p. 74) installed, in the Full Screen mode (p. 89), the virtual machine's 
screen will appear on a black background. 

 If the virtual machine's screen resolution is higher than that of the host computer and there 
are no Parallels Tools (p. 74) installed, in the Full Screen mode (p. 89), the virtual machine's 
screen will have scroll bars. 

 If the virtual machine's screen resolution is lower or higher than that of the host computer 
but Parallels Tools (p. 74) are installed, in the Full Screen mode (p. 89), the virtual 
machine's screen will be displayed in the host computer's screen resolution. For example, if 
the virtual machine's screen resolution is 800x600 or 1400x1050 and that of the host 
computer is 1280x1024, in the Full Screen mode (p. 89), the virtual machine's screen 
resolution will also become 1280x1024. 

Note: If dynamic resolution does not work when switching to Full Screen mode in virtual 
machines with Linux guest operating system installed, increase the amount of video memory 
available to the virtual machine's video card up to 16 MB. 

To keep the virtual machine's screen resolution in the Full Screen mode (p. 89), select Keep the 
virtual machine's screen resolution in full screen. With this option selected, the virtual machine's 
screen resolution will remain without any changes in the Full Screen mode (p. 89) even if 
Parallels Tools (p. 74) are installed. Moreover, if the virtual machine's screen resolution is lower 
than that of the host computer, the virtual machine will be displayed fullscreen with no black 
background. 

In the second case, if the virtual machine screen resolution is lower than that of the host 
computer, in the Full Screen mode, the virtual machine's screen will appear on a black 
background. If the virtual machine's screen resolution is higher than that of the host computer, in 
the Full Screen mode, the virtual machine's screen will have scroll bars. 
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Floppy Settings 
To view and configure the virtual machine floppy disk drive settings, use the Floppy Disk pane 
of Virtual Machine Configuration. 

 

Enabled. Select this option to enable floppy disk drive operations in the virtual machine. To 
temporary disable floppy drive operations without removing the floppy drive from the virtual 
machine configuration, clear this option. 

Note: The Enabled option can be selected or cleared only when the virtual machine is stopped. 

Connected. Select this option if you want the floppy disk drive or floppy disk image to be 
automatically connected to the virtual machine on its startup. 

You can choose one of the following devices to emulate the virtual machine floppy disk drive: 

 To use a real floppy disk drive, select Real Device and specify the device to use. 
 To use a floppy disk image, select Image File and specify the path to the floppy disk image 

file in the File field. You can also use the Choose button to locate the file. 

If you want to create a new floppy disk image or to replace the currently used floppy disk image 
by a blank floppy disk image, click the Recreate button. 

Warning: Recreating the current floppy disk image deletes all the data stored on this disk 
image. 
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CD-ROM options 
To configure the virtual machine's CD/DVD-ROM drive settings, use the CD/DVD-ROM pane of 
Virtual Machine Configuration. Virtual CD/DVD-ROM drives can be connected either to 
physical CD/DVD-ROM drives or to CD/DVD images. 

Note: You can connect up to four IDE devices (hard disks or CD/DVD drives) and 15 SCSI 
devices to a virtual machine. Each device is listed separately in the Virtual Machine Configuration 
dialog and has its own number. 
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Select the Enabled option if you want the virtual machine to use this CD/DVD-ROM drive. To 
temporarily disable operations with the CD/DVD-ROM drive without removing it from the 
virtual machine configuration, clear the Enabled check box. 

Note: The Enabled option can be selected or cleared only when the virtual machine is stopped. 

Select the Connected option if you want the CD/DVD-ROM drive to be automatically connected 
to the virtual machine on its startup.  

To emulate the virtual CD/DVD-ROM drive, you can connect one of the real CD/DVD-ROM 
drives on your physical computer or a CD/DVD-ROM image file to the virtual machine. 

Note: Parallels Workstation Extreme supports ISO image files. 

Connecting a real device 

To use a real CD/DVD-ROM drive as the virtual machine's CD/DVD-ROM drive: 

1 Select the Real Device option. 

2 Choose the device to be connected to the virtual CD/DVD-ROM drive in the CD/DVD-ROM 
list. 

3 Select the type of interface for connecting the device: 

 IDE. Using this interface type, you can connect up to four virtual devices (hard disks or 
CD/DVD-ROM drives). 

 SCSI. Using this interface type, you can connect up to 15 virtual devices (hard disks or 
CD/DVD-ROM drives). 

Note: RHEL 4.7 and RHEL 5.3 guest OSs do not support the SCSI controller. 

4 Select the device position in the Location list. 

Note: The SCSI 7:0 location is not available for selecting, since it is occupied by the SCSI 
controller itself. 

5 Select the Passthrough option to connect your real CD/DVD-ROM drive to the virtual 
machine in the passthrough mode. In this mode, the CD/DVD-ROM drive is directly 
assigned to the virtual machine. If you connect a recordable optical drive to a virtual 
machine in the passthrough mode, you will be able to use it to burn CD or DVD discs in the 
virtual machine. 

Note: If you select the Passthrough option, the physical computer will have no access to this 
CD/DVD-ROM drive. 

6 Click OK. 

Note: The Interface, Location, and Passthrough options are available only if the Show advanced 
settings check box is selected at the bottom of Virtual Machine Configuration. 

Connecting an image file 

To use an image file as the virtual machine's CD/DVD-ROM drive: 

1 Select the Image File option. 
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2 Type the path to the image file in the File field or use the Choose button to locate the file. 

3 Select the type of interface to connect the image file to: 

 IDE. Using this interface type, you can connect up to four virtual devices (hard disks or 
CD/DVD-ROM drives). 

 SCSI. Using this interface type, you can connect up to 15 virtual devices (hard disks or 
CD/DVD-ROM drives). 

Note: RHEL 4.7 and RHEL 5.3 guest OSs do not support the SCSI controller. 

4 Select the device position in the Location list. 

5 Click OK. 
 

Hard Disk Settings 
To view and configure the virtual hard disk settings, use the Hard Disk pane of Virtual Machine 
Configuration. The current version of Parallels Workstation Extreme allows virtual machines to 
use hard disk images in the .hdd format. 

Note: You can connect up to four IDE devices (hard disks or CD/DVD drives) and 15 SCSI 
devices to a virtual machine. Each device is listed separately in the Virtual Machine Configuration 
dialog and has its own number. 
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Select the Enabled option if you want the virtual machine to use this hard disk drive. To 
temporarily disable operations with the hard disk without removing it from the virtual machine 
configuration, clear the Enabled check box. 

Using a hard disk image file as a virtual hard disk 
1 Type the path to the hard disk image file in the File field or use the Choose button to locate 

the file. 

2 Select the Show advanced settings option if it is not selected and choose the interface type 
for connecting the hard disk image. Two types are available: 

 IDE. Using this interface type, you can connect up to four virtual devices (hard disks or 
CD/DVD-ROM drives) to the virtual machine. 

 SCSI. Using this interface type, you can connect up to 15 virtual devices (hard disks or 
CD/DVD-ROM drives) to the virtual machine. 

Note: In some Linux distributions (e.g. RHEL 5.3), the SCSI driver may be not installed. In this 
case, you should install this driver in your Linux guest OS to be able to use the SCSI controller. 

1 Select the device location in the Location list. 

Note: The SCSI 7:0 location is not available for selecting, since it is occupied by the SCSI 
controller itself. 

2 Click OK. 

Note: The Interface and Location options are available only if the Show advanced settings check 
box is selected at the bottom of the Virtual Machine Configuration dialog. 
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Support for Virtual and Real Disks 

This section lists the types of disks that can be used by Parallels virtual machines and provides 
the information about basic operations you can perform on these disks. 

Supported Types of Hard Disks 

Parallels virtual machines use virtual hard disks as their hard disks. 

Virtual Hard Disks 

The capacity of a virtual hard disk can be set from 100 MB to 2 TB. 

Virtual hard disks can be of either plain or expanding format. When you create a virtual 
machine in Express Windows or Typical mode (in the New Virtual Machine wizard (p. 58)), the 
disk is created in the expanding format. 

plain A plain virtual hard disk image file has a fixed size.  The size is determined when the 
disk is created. Plain disks can be created with the help of New Virtual Machine wizard 
(the Custom mode.)  

expanding An expanding virtual hard disk image file is small initially. Its size grows as you add 
applications and data to the virtual hard disk in the guest OS. 

Split disks 

A virtual disk of either format can be a single-piece disk or a split disk. A split disk is cut into 2 
GB pieces and is stored as a single .hdd file. 

CD/DVD Discs and Their Images 

Parallels Workstation Extreme can access real CD/DVD discs and images of CD/DVD discs. 

Parallels Workstation Extreme has no limitations on using multisession CD/DVD discs. Virtual 
machine can play back audio CDs without any limitations on copy-protected discs. 

If your host computer has a recordable optical drive, you can use it to burn CD or DVD discs in 
a virtual machine. 

Note: To burn CD or DVD discs in a virtual machine, the recordable optical drive should be 
connected to the virtual machine in the passthrough mode (p. 132). 

Parallels Workstation Extreme supports CD/DVD disc images in the ISO format. Parallels 
Workstation Extreme may also support CD/DVD disc images in the CUE and CCD formats. 

Floppy Disks and Floppy Disk Images 

Parallels Workstation Extreme can use two types of floppy disks: 

 Real diskettes inserted into a real floppy disk drive that is connected to the virtual machine. 
 Floppy disk image files with the .fdd extension connected to the virtual machine. 
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Parallels Workstation Extreme treats floppy disk images like real diskettes. Parallels 
Workstation Extreme supports floppy disk image files that have .fdd extension and 1.44 MB 
size. 

With Parallels Workstation Extreme, you can also create an image of a blank floppy using 
Floppy Disk pane (p. 131) of the Virtual Machine Configuration dialog (p. 109). 

Note: Parallels Workstation Extreme cannot create images of real diskettes. 
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Serial Port Settings 
In the Serial Port pane, you can configure the virtual machine serial port settings. 

Using serial ports, you can establish a connection between 

 the virtual machine and the host computer devices (using a real port) or 
 between two virtual machines located on the same host computer (using a socket). 

If you want to connect your virtual machine to the host computer device, you should create a 
serial port emulated by a real port. The Serial Port list comprises the devices on the host 
computer that are available for connection. The connected device, being used in any virtual 
machine, cannot be used by the host computer. To be able to use it in the host computer, you 
should first disconnect it from the virtual machine. To do that, use the virtual machine status bar 
(p. 36). 

If you want to connect two virtual machines with each other, you need to create a serial port 
emulated by a socket in each virtual machine. The names of the serial ports should be identical. 
The connection between the virtual machines via serial ports is bidirectional. It means that the 
working modes of the sockets set during the port creation can be changed later in the Serial Port 
pane. 

If you need to log the performance activity of your virtual machine or to record the data from it 
and use this information later on, you can connect your virtual machine serial port to an output 
file on the physical server. You will be able to view and analyze the activity history of the 
virtual machine any time you need it by exploring this file. 

You can add a new serial port to your virtual machine using Add Hardware Assistant. For the 
instruction on how to create serial ports, refer to Adding and Removing Devices. 

Note: You can connect up to four serial ports to a virtual machine. 
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Enabled. Select this option if you want to enable this serial port in the virtual machine. To 
temporarily disable the serial port without deleting it from the virtual machine configuration, 
clear this option. 

Note: The Enabled option can be selected or cleared only when the virtual machine is stopped. 

Connected. Select this option if you want the virtual machine to start up with the serial port 
connected. 

Serial ports can be emulated by the following devices: 

 Real Port. Select this option to connect the virtual machine serial port to one of the existing 
serial ports on the host computer. In this case, you will need to choose the appropriate port 
on the host computer in the Serial port list. 

 Socket. Select this option to connect two virtual machines through the sockets. When 
connecting the virtual machine to a socket, you can use the default path to the socket or type 
a new one in the Socket field. You can also configure the role the virtual machine will play 
in the connection by selecting the necessary role in the Mode list. Selecting Server enables 
you to use this virtual machine to direct the other one. Selecting Client enables you to direct 
this virtual machine from the other one. 

Note: If you change the socket mode of the first virtual machine, make sure that the socket 
mode of the second virtual machine is also modified. 

 Output File. Select this option to connect the virtual machine serial port to an output file. 
You can accept the default path or type your own one in the File field. You can also use the 
Choose button to locate the necessary file. 
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Network Adapter Settings 
The Network Adapter pane of Virtual Machine Configuration allows you to manage the virtual 
machine's network settings. 
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Enabled. Select this option if you want to enable this network adapter in the virtual machine. If 
you want to temporarily disable the network adapter without deleting it from the virtual machine 
configuration, clear the Enabled check box. 

Note: The Enabled option can be selected or cleared only when the virtual machine is stopped. 

Connected. Select this option if you want the virtual machine to start up with this network 
adapter connected. 

You can choose one of the following types of networking for the virtual machine network 
adapter: 

 Shared Networking. Select this option to enable the Network Address Translation (NAT) 
feature for the virtual machine. In this case, your virtual machine will share whatever 
network connection is currently used by the host computer. 
See Shared Networking (p. 173) to learn how to configure this type of networking. 

 Bridged Networking. Select this option to allow the virtual machine to access the local 
network and Internet through one of the network adapters installed on the host computer. In 
this case, the virtual machine is treated as a stand-alone computer on the network and should 
be configured in the same way as a real one. You can choose the physical adapter where the 
virtual machine adapter will be bridged in the list below the Bridged Networking option. 
See Bridged Ethernet Networking (p. 175) to learn how to configure this type of networking. 

 Host-Only Networking. Select this option to allow the virtual machine to connect to the host 
computer and the virtual machines residing on it and to make it invisible outside the host 
computer. 
See Host-Only Networking (p. 176) to learn how to configure this type of networking. 

 Direct Assignment (using Intel VT-d). Select this option to allow the virtual machine to access 
the local network and Internet through a PCIe network adapter with the help of the Intel VT-
d technology. See Networking Using a PCIe Adapter (p. 177) to learn how to configure this 
type of networking. 

In the MAC address field, you can change the MAC address currently assigned to the virtual 
machine. MAC addresses are automatically generated during the virtual machine creation. 
However, you can modify the default MAC address by typing another value in the MAC address 
field or clicking the Generate button. When entering a new MAC address, make sure that it is 
unique within your network. 

WiFi Bridging Support 

To be able to connect to wireless networks from your virtual machine: 

1 Select the Bridged Ethernet option. 

2 Choose the WiFi adapter from the drop-down list and click OK to apply the changes. 

After you perform these steps, your virtual machine will be able to connect to the Internet 
through the WiFi adapter of your host computer. 

When you try to connect to the Internet via WiFi, and the WiFi Access Point has the Validate 
DHCP packets option enabled, you may experience problems with connecting to the Internet. In 
this case, enable the Send the host's MAC address to DHCP server option to ensure that your 
virtual machine gets an IP address for accessing the Internet. 
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Note: Enabling the Send the host's MAC address to DHCP server option will not work with some 
DHCP servers - your virtual machine may get the same IP address as the host computer has. 

If you cannot configure your virtual machine to work in the Bridged Ethernet mode, you can 
consider using another networking mode: Shared Networking mode (p. 173) or Host-Only 
Networking mode (p. 176). 
 

Parallel Port Settings 
On the Parallel Port pane of Virtual Machine Configuration, you can configure the virtual 
machine's parallel port settings. A virtual machine can have up to three parallels ports. 
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Enabled. Select this option if you want to enable this parallel port in the virtual machine. To 
temporarily disable the parallel port without deleting it from the virtual machine configuration, 
clear this option. 

Note: The Enabled option can be selected or cleared only when the virtual machine is stopped. 

Connected. Select this option if you want the virtual machine to start up with the parallel port 
connected. 

A parallel port can be emulated by one of the following devices: 

 Real Port. Select this option to connect one of the host computer parallel ports to the virtual 
machine parallel port. In this case, you will need to specify the appropriate physical port in 
the Parallel port field. 

 Printer. Select this option to connect a printer using the virtual machine parallel port. In this 
case, you will need to select the appropriate printer in the Printer list. 
By default, the HP Color LaserJet 8500 PS printer supporting PostScript is installed in 
Windows virtual machines, irrespective of the real printer model and version. In most cases, 
modern printers support PostScript and that is why you should disregard the printer name 
you see in the Windows printing wizard and complete the procedure. As long as you have a 
printer connected to the host computer, the documents will be printed on this printer. 

 Output File. Select this option to emulate the parallel port by using an output file. In this 
case, a new output file with the default name will be created in the virtual machine folder. 
The path to the output file will be displayed in the File field. If you want to use another 
output file, type the full path to it in the File field or use the Choose button to locate the file. 
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Sound Settings 
The Sound pane of Virtual Machine Configuration allows you to configure the virtual machine 
sound device parameters. 
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Enabled. Select this option if you want to enable the sound device in the virtual machine. To 
temporarily disable operations with the sound device without deleting it from the virtual 
machine configuration, clear this option. 

Note: The Enabled option can be selected or cleared only when the virtual machine is stopped. 

Connected. Select this option to have the sound device automatically connected on the virtual 
machine startup. 

Output. Use the output list to choose the necessary device. You can choose one of the following 
devices: 

 Default. Select this option if you want to use the input device set as default in the primary 
operating system. 

 Null device. Select this option if you want to mute the output device. 
 Built-in output. Select this option if you want to use one of the output devices connected to 

the primary operating system. 

Input. Use the input list to choose the necessary device. You can choose one of the following 
devices: 

 Default. Select this option if you want to use the input device set as default in the primary 
operating system. 

 Null device. Select this option if you want to mute the input device. 
 Built-in input. Select this option if you want to use one of the input devices connected to the 

primary operating system. 
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USB Settings 
In the USB Controller pane of the Virtual Machine Configuration dialog, you can enable the USB 
controller support in your virtual machine. A virtual machine can emulate only one USB 
controller, which provides you with the possibility to connect up to eight USB 2.0 and eight 
USB 1.1 devices to the virtual machine. 

 

Enabled. Select this option to allow using USB devices in the virtual machine. If you want to 
temporarily disable USB operations without deleting the USB controller from the virtual 
machine configuration, clear this option. 

If the USB controller is disabled, such USB devices as keyboard, mouse, microphone will still 
be available to the virtual machine with other emulated subsystems, such as sound, keyboard or 
mouse emulation, etc. 

Note: The Enabled option can be selected or cleared only when the virtual machine is stopped. 
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Intel VT-d PCI Device Settings 
To view and edit the settings of an Intel VT-d PCI device used by the virtual machine, use the 
Intel VT-d PCI device pane of the Virtual Machine Configuration dialog. 

 

Select the Enabled option to enable this PCI device in the virtual machine. If you want to 
temporarily disable the device, clear this option. 

The PCI Device list displays the PCI devices available in the hardware configuration of the host 
computer. You may change the device connected to the virtual machine's PCI device by 
choosing it from the list. 

Note: If you start the virtual machine with the PCI device disabled, you cannot change this 
option when the virtual machine is running. 

For the instructions on adding Intel VT-d PCI devices to virtual machines, see Adding Intel VT-d 
PCI Devices (p. 169). 

For more information about using Intel VT-d PCI devices in Parallels virtual machines, see 
Using Intel VT-d PCI Devices in Parallels Virtual Machines (p. 101). 
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Generic SCSI Device Settings 
To view and edit the settings of a generic SCSI device used by the virtual machine, use the 
Generic SCSI pane of the Virtual Machine Configuration dialog. 

 

Select the Enabled option to enable this SCSI device in the virtual machine. If you want to 
temporarily disable the device, clear this option. 

The SCSI device list displays the SCSI devices available in the hardware configuration of the 
host computer. You may change the device connected to the virtual machine's SCSI device by 
choosing it from the list. 

You may add a brief description of the device in the Description field. 

Note: If you start the virtual machine with the SCSI device disabled, you cannot change this 
option when the virtual machine is running. 

For the instructions on adding generic SCSI devices to virtual machines, see Adding a Generic 
SCSI Device (p. 170). 
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Video Adapter 
To view and configure the virtual machine video adapter settings, use the Video Adapter pane of 
Virtual Machine Configuration. Before using a PCIe video adapter device in the virtual 
machine, you should assign it to your virtual machines in the Intel VT-d pane (p. 51) of Parallels 
Workstation Extreme Preferences. 

 

Enabled. Select this option if you want to enable this video adapter in the virtual machine. If you 
want to temporarily disable the video adapter without deleting it from the virtual machine 
configuration, clear the Enabled check box. 

Note: If the video adapter is assigned to the host computer in the Intel VT-d pane (p. 51) of 
Parallels Workstation Extreme Preferences, you will not be able to use this video adapter with 
the virtual machine. 

In the Adapter list, you can choose the physical video adapter that will be used by your virtual 
machine. 

For the instructions on adding a directly assigned video adapter to virtual machines, see Adding 
a Video Adapter (p. 163). 
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Adding and Removing Devices 
Adding new devices to the virtual machine configuration is easier than connecting new devices 
to a real computer. Removing or disconnecting devices is also easy. The following virtual 
devices can be added to the configuration or removed from it: 

 virtual hard disk drive (p. 152) 
 CD/DVD-ROM drive (p. 158) 
 floppy disk drive (p. 160) 
 network adapter (p. 161) 
 video adapter (p. 163) 
 sound device (p. 164) 
 serial port (p. 166) 
 parallel port (p. 167) 
 USB controller (p. 168) 
 generic SCSI (p. 170) 

Any of the aforementioned devices can be added to the corresponding virtual machine only 
when it is stopped. 
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Add Hardware Wizard 
You can add new devices to your virtual machines using Add Hardware Wizard. The wizard 
allows you to add only one device at a time. 

Note: To be able to connect any virtual device to a real one, you should have system privileges 
to access the real device. Otherwise, the real device will not appear in the list of available 
devices even though it is installed on your computer. 

To add a new device to a virtual machine: 

1 Choose Configure from the Virtual Machine menu to open the Virtual Machine Configuration 
dialog. 

2 Click the Add button  in the bottom part of the Virtual Machine Configuration dialog to 
launch Add Hardware Wizard. 

3 The Select Device window displays the list of virtual hardware devices that can be added to 
the virtual machine. Select the device to be added to your virtual machine and click Next. 

Note: If the virtual machine does already have the allowed number of devices of a particular 
type, the corresponding device icon is dimmed in the Select Device window. 

 
4 Follow the wizard's instructions to add and configure the selected device. 

If you want to add a device that will have typical settings to the virtual machine, select the 
device and click the Add Typical Device button in the Select Device window. 
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Adding a Virtual Hard Disk Drive 
You can add to your virtual machine a real hard disk, an existing hard disk image, or create a 
new, blank one. 

Note: A virtual machine can have up to four IDE devices (hard disks or CD/DVD-ROM drives) 
and 15 SCSI devices (hard disks or CD/DVD-ROM drives). 

To add a hard disk to a virtual machine: 

1 Choose Configure from the Virtual Machine menu to open the Virtual Machine Configuration 
dialog. 

2 Click the Add button  in the bottom part of the Virtual Machine Configuration dialog to 
launch Add Hardware Wizard. 

3 In the Select Device window, select Hard Disk and click Next 
To add a hard disk that will have a typical configuration, choose the Hard Disk icon and click 
the Add Typical Device button. The wizard will create a typical hard disk ready for use. 

Note: A typical virtual hard disk is in the expanding format (p. 136) and its capacity is 32 
GB. 

4 In the Add Hard Disk window, select the resource for the new virtual hard disk and click 
Next. You can choose one of the following options: 

 New image file. In this case, the wizard will create a new image that will emulate the hard 
disk. 

 Existing image file. In this case, an existing image file will be added to the virtual 
machine configuration and used to emulate the hard disk. If you selected this option, go 
to Step 7. 

 Real disk. In this case, one of the host computer's real hard disks will be added to the 
virtual machine configuration. If this disk has an operating system installed, you will be 
able to boot the virtual machine from this disk. 

Note: The virtual machine boot sequence can be configured in the Boot Order pane (p. 112) 
of Virtual Machine Configuration. 

If you selected this option, go to Step 8. 

5 If you selected the New image file option, on the next step you need to set the virtual hard 
disk size in the Capacity field and define its format. You can choose one of the following 
formats for the disk: Expanding or Plain. If you want the virtual hard disk to be splitted, 
select the Split the hard disk image into 2 GB files option. For more information on hard disk 
formats, refer to Support of Virtual and Real Disks (p. 136). 
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When you are ready, click Next. 
6 In the next window, you can configure the location of the hard disk image file and specify its 

interface type.You can choose one of the following interface types for the disk: 

 If you select the IDE option, you will be able to define the IDE device identifier in the 
Location list. 

 If you select the SCSI option, you will be able to select the SCSI device identifier in the 
Location list. 

Note: The SCSI 7:0 location is not available for selecting, since it is occupied by the SCSI 
controller itself. 
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Note: In some Linux distributions (e.g. RHEL 5.3), the SCSI driver may be not installed. In 
this case, you should install this driver in your Linux guest OS to be able to use the SCSI 
controller. 

Click Add Device to add a new hard disk to the virtual machine. 

7 If you selected the Existing image file option in Step 4, in the Add Hard Disk window you will 
need to specify the full path to the image file you wish to use in your virtual machine. You 
can type the path manually or use the Choose button to locate the image file. You will also 
need to specify the interface type and the corresponding device identifier. 

8 If you selected the Real disk option in Step 4, in the Add Hard Disk window you will need to 
specify which hard disk and its partitions you want to add to the virtual machine. You will 
also need to specify the interface type and the corresponding device identifier. 

 

If you added a new blank virtual hard disk, you need to initialize it before you can use it. For 
more information about initializing the newly added disk, see Initializing the Newly Added Disk 
(p. 156). 

If you added an existing disk, make sure that its file system is compatible with the guest OS 
installed in the virtual machine. 
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Initializing the Newly Added Disk 

After you added a new blank virtual hard disk to the virtual machine configuration, it will be 
invisible to the operating system installed inside the virtual machine until the moment you 
initialize it. 

Initializing the New Virtual Hard Disk in Windows 

To Initialize the new virtual hard disk in a Windows guest OS, you will need the Disk 
Management utility available through: 

 In Windows Vista: Start > Control Panel > System and Maintenance > Administrative Tools > 
Create and Format Hard Disk Partitions > Disk Management. 

 In Windows XP: Start > Control Panel > Administrative Tools > Computer Management > 
Storage > Disk Management. 

When you open the Disk Management utility, it automatically detects that a new hard disk was 
added to the configuration and launches Initialize and Convert Disk Wizard: 

1 In the introduction window, click Next. 
2 In the Select Disks to Initialize window, select the newly added disk and click Next. 
3 In the Select Disks to Convert window, select the newly added disk and click Finish. 

The added disk will appear as a new disk in the Disk Management utility window, but its 
memory space will be unallocated. To allocate the disk memory, right-click this disk name in 
the Disk Management utility window and select New Simple Volume in Windows Vista or New 
Volume in Windows XP. The New Simple Volume Wizard/New Volume Wizard window will 
appear. Follow the steps of the wizard and create a new volume in the newly added disk. 

After that your disk will become visible in Computer/My Computer and you will be able to use it 
as a data disk inside your virtual machine. 

Initializing the New Virtual Hard Disk in Linux 

Initializing the new virtual hard disk in a Linux guest OS comprises two steps: allocating the 
virtual hard disk space and mounting this disk in the guest OS. 

To allocate the space, you will need to create a new partition on this virtual hard disk, using the 
fdisk utility. 

Note: To use the fdisk utility, you need the root privileges. 

1 Launch Terminal. 

2 To list the IDE disk devices present in your virtual machine configuration, enter: 
fdisk /dev/hd* 

Note: If you added a SCSI disk to the virtual machine configuration, use the fdisk 
/dev/sd* command instead. 

3 By default, the second virtual hard disk appears as /dev/hdc in your Linux virtual 
machine. To work with this device, enter: 

fdisk /dev/hdc 
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Note: If this is a SCSI disk, use the fdisk /dev/sdc command instead. 

4 To get extensive information about the disk, enter: 
p 

5 To create a new partition, enter: 
n 

6 To create the primary partition, enter: 
p 

7 Specify the partition number. By default, it is 1. 

8 Specify the first cylinder. If you want to create a single partition on this hard disk, use the 
default value. 

9 Specify the last cylinder. If you want to create a single partition on this hard disk, use the 
default value. 

10 To create a partition with the specified settings, enter: 
w 

When you allocated the space on the newly added virtual hard disk, you should format it by 
entering the following command in the terminal: 
mkfs -t <FileSystem> /dev/hdc1 

Note: <FileSystem> stands for the file system you want to use on this disk. It is 
recommended to use ext3 or ext2. 

When the added virtual hard disk is formatted, you can mount it in the guest OS. 

1 To create a mount point for the new virtual hard disk, enter: 
mkdir /mnt/hdc1 

Note: You can specify a different mount point. 

2 To mount the new virtual hard disk to the specified mount point, enter: 
mount /dev/hdc1 /mnt/hdc1 

When you mounted the virtual hard disk, you can use its space in your virtual machine. 
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Adding a CD/DVD-ROM Drive 
To the virtual machine configuration, you can add a virtual CD/DVD-ROM drive that is either 
connected to a real CD/DVD-ROM on your physical computer or to an existing image file. 

Note: A virtual machine can have up to four IDE devices (hard disks or CD/DVD-ROM drives) 
and 15 SCSI devices (hard disks or CD/DVD-ROM drives). 

To add a new CD/DVD-ROM drive to a virtual machine: 

1 Choose Configure from the Virtual Machine menu to open the Virtual Machine Configuration 
dialog. 

2 Click the Add button  in the bottom part of the Virtual Machine Configuration dialog to 
launch Add Hardware Wizard. 

3 In the Select Device window, select CD/DVD-ROM and click Next.  
To add a CD/DVD-ROM drive that will have a typical configuration, choose the CD/DVD-
ROM icon and click the Add Typical Device button. The wizard will create a typical 
CD/DVD-ROM drive ready for use. 

4 In the Add CD/DVD-ROM window, select the resource for the new CD/DVD-ROM drive and 
click Next. You can choose between the following options: 

 Real Device: select this option if you wish to add a real CD/DVD-ROM drive to your 
virtual machine. 

 Image File: select this option if you wish to use an existing image file as a virtual 
CD/DVD-ROM drive inside your virtual machine. 

Note: Parallels Workstation Extreme supports ISO image files and may also support 
CD/DVD disc images in the CUE and CCD formats. 

If you want the device to be connected to the virtual machine automatically at startup, select 
the Connected option. If you clear this option, the drive will be enabled in the configuration, 
but not connected to the virtual machine. You can connect it later when running the virtual 
machine. 

5 Your next window will be different depending on what option (Real Device or Image File) 
you chose in the previous step: 

 If you chose to add a real device, select the corresponding device from the list in the 
Drive Name field. 

 If you chose to use an image file, type the path to the corresponding file in the Image File 
field or use the Choose button to locate the file. 

In both cases, you should specify the interface type for the CD/DVD-ROM device or image 
file: 

 IDE. Using this interface type, you can connect up to four virtual devices (hard disks or 
CD/DVD drives) to the virtual machine. 

 SCSI. Using this interface type, you can connect up to 15 virtual devices (hard disks or 
CD/DVD drives) to the virtual machine. 
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Note: In some Linux distributions (e.g. RHEL 5.3), the SCSI driver may be not installed. In 
this case, you should install this driver in your Linux guest OS to be able to use the SCSI 
controller. 

You can also define the device position in the Location list or accept the position offered by 
Add Hardware Wizard. 

Note: The SCSI 7:0 location is not available for selecting, since it is occupied by the SCSI 
controller itself. 

If you selected the Real Device option, you can connect your physical computer CD/DVD-
ROM drive directly to your virtual machine. In this case, you will be able to fully use this 
CD/DVD-ROM drive in the virtual machine (e.g. record data on discs). For these purposes, 
select the Passthrough option. 

Note: If you connect your physical computer CD/DVD-ROM drive directly to your virtual 
machine, this drive will not be available in the primary OS. 

 
When you are ready, click the Add Device button to add a new virtual CD/DVD-ROM drive 
to your virtual machine. 
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Adding a Floppy Disk Drive 
You can add an existing floppy disk drive or floppy disk image to your virtual machine. You 
can also create a new floppy disk image and add it to the virtual machine. 

Note: Any virtual machine can have only one floppy disk drive. 

To add a floppy disk to a virtual machine: 

1 Choose Configure from the Virtual Machine menu to open the Virtual Machine Configuration 
dialog. 

2 Click the Add button  in the bottom part of the Virtual Machine Configuration dialog to 
launch Add Hardware Wizard. 

3 In the Select Device window, select Floppy Disk and click Next. 
4 In the Add Floppy Disk window, select the resource for the new virtual floppy disk and click 

Next. You can choose one of the following resources for the floppy disk: 

 Real Floppy Disk. In this case, the wizard will use a real disk to emulate the floppy disk 
drive. 

 Existing Image File. In this case, the wizard will use an existing image file for the floppy 
disk drive emulation. 

 New Image File. In this case, the wizard will create a new image that will emulate the 
floppy disk drive. To create a new floppy disk drive and add it to your virtual machine, 
just click Add Device in the Add Floppy Disk window. 

If you want the device to be connected to the virtual machine automatically at startup, select 
the Connected option. If you clear this option, the drive will be enabled in the configuration, 
but not connected to the virtual machine. You can connect it later when running the virtual 
machine. 

5 Your next window will be different depending on what option (Existing Image File or Real 
Floppy Disk) you selected in the previous step: 

 If you selected Existing Image File, you will need to specify the location of the 
corresponding image file and click Add Device to add a new floppy disk drive to your 
virtual machine. 

 If you selected Real Floppy Disk, specify the floppy disk drive on your physical computer 
and click Add Device to add a new floppy disk drive to your virtual machine. 
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Adding a Network Adapter 
A virtual machine can have up to 16 virtual network adapters simultaneously. 

To add a network adapter to a virtual machine: 

1 Choose Configure from the Virtual Machine menu to open the Virtual Machine Configuration 
dialog. 

2 Click the Add button  in the bottom part of the Virtual Machine Configuration dialog to 
launch Add Hardware Wizard. 

3 In the Select Device window, select Network Adapter and click Next.  
To add a network adapter that will have a typical configuration, choose the Network Adapter 
icon and click the Add Typical Device button. The wizard will add a typical network adapter 
ready for use. 

4 In the Add Network Adapter window, select the type of networking you want to use in the 
virtual machine. The current version of Parallels Workstation Extreme allows you to choose 
one of the following networking types: 

 Shared Networking. If you select this option, the virtual machine will use the host 
computer's network connections and will be visible only for the host computer and the 
other virtual machines running on this server. This option is selected by default. 

 Bridged Networking. If you select this option, the virtual machine will be visible on the 
network as a separate computer. 

 Host-Only Networking. If you select this option, the virtual machine will be able to access 
only the host computer and the virtual machines running on it. 

 Direct Assignment (using Intel VT-d). If you select this option, the virtual machine  will be 
able to access the local network and Internet through a PCIe network adapter. This 
option is available only if you have a PCIe network adapter and the Intel VT-d 
technology is enabled in your host computer. 

If you want the device to be connected to the virtual machine automatically at startup, select 
the Connected option. If you clear this option, the drive will be enabled in the configuration, 
but not connected to the virtual machine. You can connect it later when running the virtual 
machine. 

If you choose the Shared Networking or Host-Only Networking option, click Add Device to 
add a new shared networking adapter to the virtual machine. 

If you choose the Bridged Networking option, click Next and proceed to Step 6. 

If you choose the Direct Assignment (using Intel VT-d) option, click Next and select the PCIe 
network adapter you want to use in the Adapter list on the next screen. Click Add Device to 
add the adapter to the virtual machine. After adding the PCIe adapter, you should start the 
virtual machine and install the manufacturer's driver for this PCIe device inside it. The 
driver should support the Intel VT-d technology. 

Note: Before adding the PCIe network adapter, you should assign it to your virtual machines 
in the Intel VT-d pane (p. 51) of Parallels Workstation Extreme Preferences. 
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5 If you chose the Bridged Networking option, on the next step you will need to specify the 
virtual network adapter properties. The wizard will prompt you to specify the adapter to use. 
Select the appropriate adapter in the Adapter to Bind list and specify the MAC address in the 
MAC Address field. If you wish Add Hardware Wizard to generate the MAC address for you, 
click the Generate button. 

 
Click the Add Device button to add a new network adapter to the virtual machine. 

 

 



 Configuring a Virtual Machine 163 
 

Adding a Video Adapter 
If your computer has an Intel VT-d chipset and an additional PCIe video adapter (except for the 
one used by the host computer) in its configuration, you can add this video adapter to your 
virtual machine. The virtual machine will directly access this video adapter without using the 
resources of the primary OS. Before adding a video adapter to the virtual machine, you should 
assign it to your virtual machines in the Intel VT-d pane (p. 51) of Parallels Workstation Extreme 
Preferences. 

Note: You are recommended to have at least two video adapters: if you reassign one device to 
your virtual machines, the other device will be left to the physical computer. Keep in mind that 
if you assign your video adapter to a virtual machine, this adapter will be invisible to your 
primary OS. 

To add a video adapter to a virtual machine: 

1 Choose Configure from the Virtual Machine menu to open the Virtual Machine Configuration 
dialog. 

2 Click the Add button  in the bottom part of the Virtual Machine Configuration dialog to 
launch Add Hardware Wizard. 

3 In the Select Device window, select Video Adapter and click Next. 
4 In the Add Video Adapter window, select the appropriate adapter in the Adapter list. Click the 

Add Device button to add the video adapter to your virtual machine configuration. 

5 Start the virtual machine and install the manufacturer's driver for this PCIe device inside the 
virtual machine. The driver should support the Intel VT-d technology. 

Note: Parallels Workstation Extreme officially supports the NVIDIA Quadro® FX 3800, 
4800, and 5800 video cards for virtual machines. For these video cards, use the latest drivers 
available on the manufacturer's website. 

Notes: 1. If the video adapter is assigned to the host computer in the Intel VT-d pane (p. 51) of 
Parallels Workstation Extreme Preferences, you will not be able to enable it in the virtual 
machine configuration untill you assign it to your virtual machines. 

2. You can assign one video adapter to several virtual machines but only one virtual machine 
can use this adapter at a time. 
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Adding a Sound Device 
Parallels Workstation Extreme allows you to add sound devices to your virtual machines. 

Note: Any virtual machine can have only one sound device. 

To add a sound device to a virtual machine: 

1 Choose Configure from the Virtual Machine menu to open the Virtual Machine Configuration 
dialog. 

2 Click the Add button  in the bottom part of the Virtual Machine Configuration dialog to 
launch Add Hardware Wizard. 

3 In the Select Device window, select Sound and click Next. 
To add a sound device that will have a typical configuration, click the Add Typical Device 
button. The wizard will add a typical sound device ready for use. 

4 In the Add Sound window, specify the sound input and output devices the virtual machine 
will use: 

Output device. Use the output list to choose the necessary device: 

 Default. Select this option if you want to use the input device set as default in your 
primary OS. 

 Null Device. Select this option if you want to mute the output device inside the virtual 
machine. 

 Built-in Output. Select this option if you wish to use other output devices connected to 
your primary OS. 

Input device. Use the input list to choose the necessary device: 

 Default. Select this option if you want to use the input device set as default in your 
primary OS. 

 Null Device. Select this option if you want to mute the input device inside the virtual 
machine. 

 Built-in Input. Select this option if you wish to use other input devices connected to your 
primary OS. 

You can also select the Activated option to have the sound device automatically activated on 
the virtual machine startup. 
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When you are ready, click the Add Device button to add a new sound device to your virtual 
machine. 
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Adding a Serial Port 
You can add to your virtual machine a serial port that will be connected to a real port on your 
physical computer, a socket, or an output file. 

Note: A virtual machine can have up to four serial ports. 

To add a serial port to a virtual machine: 

1 Choose Configure from the Virtual Machine menu to open the Virtual Machine Configuration 
dialog. 

2 Click the Add button  in the bottom part of the Virtual Machine Configuration dialog to 
launch Add Hardware Wizard. 

3 In the Select Device window, select Serial Port and click Next.  
To add a serial port that will have a typical configuration, click the Add Typical Device 
button. The wizard will add a typical serial port ready for use. 

4 In the Add Serial Port window, specify the resource to be used for the serial port emulation 
and click Next. You can choose one of the following resources: 

 Real Port. Select this option to connect the virtual machine's serial port to the serial port 
of the physical computer. You will be able to choose the serial port in the next window. 

 Output File. Select this option to connect the virtual machine's serial port to an output 
file. You will be able to locate the file in the next window. 

 Socket. Select this option to create and connect the virtual machine's serial port to a 
socket of the physical computer. 

Note: When you connect two virtual machines via serial ports, both virtual machines should 
have serial ports emulated by sockets with the identical names. 

If you want the device to be connected to the virtual machine automatically at startup, select 
the Connected option. If you clear this option, the drive will be enabled in the configuration, 
but not connected to the virtual machine. You can connect it later when running the virtual 
machine. 

5 In the next window, specify the resource properties: 

 If you chose Real Port, specify the port to be used for the virtual serial port device in the 
Serial Port list. 

 If you chose Output File, define the file to be used for the virtual serial port device in the 
Output File field or leave the default file offered by Add Hardware Wizard. 

 If you chose Socket, specify the name of the socket to be used for the virtual serial port 
device and its mode. The socket mode defines the role the virtual machine will play 
when establishing a network connection to another computer. It can be set to one of the 
following: Server or Client. The Server socket enables you to use the given virtual 
machine to direct the other one. The Client socket enables you to direct the given virtual 
machine from the other one. 

Note: When you establish a connection between two virtual machines, one virtual machine 
socket should function in the Server mode, and the other one - in the Client mode. 
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When you are ready, click the Add Device button to add a new serial port to your virtual 
machine. 

 

Adding a Parallel Port 
You can add a parallel port to your virtual machine that will be connected to a real port, a 
printer, or an output file. 

Note: A virtual machine can have up to three parallel ports. 

To add a parallel port to a virtual machine: 

1 Choose Configure from the Virtual Machine menu to open the Virtual Machine Configuration 
dialog. 

2 Click the Add button  in the bottom part of the Virtual Machine Configuration dialog to 
launch Add Hardware Wizard. 

3 In the Select Device window, select Parallel Port and click Next. 
To add a parallel port that will have a typical configuration, click the Add Typical Device 
button. The wizard will add a typical parallel port ready for use. 

4 In the Add Parallel Port window, specify the resource to be used for the parallel port 
emulation and click Next. You can choose one of the following resources: 

 Real Port. Select this option to connect the virtual machine's parallel port to a real 
parallel port of your physical computer. 

 Output File. Select this option to emulate the parallel port by using an output file. In this 
case, a new output file with the default name will be created in the virtual machine's 
folder. 

 Printer. Select this option to connect a printer using the virtual machine's parallel port. 

If you want the device to be connected to the virtual machine automatically at startup, select 
the Connected option. If you clear this option, the drive will be enabled in the configuration, 
but not connected to the virtual machine. You can connect it later when running the virtual 
machine. 

5 In the next window, specify the resource properties: 

 If you chose the Real Port option on the previous step, you should choose the appropriate 
parallel port name in the Parallel Port list. 

 If you chose the Output File option on the previous step, you should set the path to the 
corresponding file in the Output File field. You can leave the file offered by Add 
Hardware Wizard or specify another one by using the Choose button or manually typing 
the full path to it in the field provided. 

 If you chose the Printer option on the previous step, you should choose the appropriate 
printer name in the Printer list. 

Click the Add Device button to add a new parallel port to your virtual machine. 
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Adding a USB Controller 
You can add a USB controller to your virtual machine. USB controllers installed inside your 
virtual machines allow USB devices plugged into the USB drives of your physical computer to 
be automatically connected to the corresponding virtual machines. 

Note: A virtual machine can have only one USB controller. If you removed it for any reason, 
you can add it back to the configuration. 

To add a USB controller to a virtual machine: 

1 Choose Configure from the Virtual Machine menu to open the Virtual Machine Configuration 
dialog. 

2 Click the Add button  in the bottom part of the Virtual Machine Configuration dialog to 
launch Add Hardware Wizard. 

3 In the Select Device window, select USB Controller and click Add Device. 
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Adding Intel VT-d PCI Devices 
If the host computer's hardware includes Intel VT-d chipset, you can add a physical Intel VT-d 
PCI device (p. 101) to your virtual machine. Before adding an Intel VT-d PCI device to a virtual 
machine, you should assign it to your virtual machines in the Intel VT-d pane (p. 51) of Parallels 
Workstation Extreme Preferences. 

To add an Intel VT-d PCI device to a virtual machine: 

1 In the Virtual Machine Configuration dialog, click the Add button  to launch Add Hardware 
Wizard. 

2 In the Intorduction window, click Next. 
3 In the Select Device window, select Intel VT-d PCI Device and click Next. 
4 In the next window, select the device to connect to the virtual machine from the PCI Device 

list and click Add Device. You may also type a brief description of the added device in the 
Description field. 

 
5 When the PCI device is added to the virtual machine configuration, you need to start the 

virtual machine and install an appropriate driver for this PCI device. After that you will be 
able to use it with your virtual machine. 

The maximum number of PCI devices you can add to your virtual machine is 8. 
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Adding a Generic SCSI Device 
If the host computer's hardware includes any SCSI device (except for SCSI hard disks or 
CD/DVD-ROM drives), you can add to your virtual machine a generic SCSI device. 

Note: 1. A virtual machine can have up to four IDE devices and 15 SCSI devices. 

2. Red Hat Linux Enterprise 4.7 and 5.3 guest OSs do not support SCSI controller. 

To add a generic SCSI device to a virtual machine: 

1 Choose Configure from the Virtual Machine menu to open the Virtual Machine Configuration 
dialog. 

2 Click the Add button  in the bottom part of the Virtual Machine Configuration dialog to 
launch Add Hardware Wizard. 

3 In the Select Device window, select Generic SCSI and click Next. 
To add a generic SCSI device that will have a typical configuration, choose the Generic SCSI 
icon and click the Add Typical Device button. The wizard will create a typical SCSI device 
ready for use. 

4 In the Add Generic SCSI window, choose the SCSI device you want to add to your virtual 
machine from the SCSI Device list. 

You can also define the device position in the Location list or accept the position offered by 
Add Hardware Wizard. 

Note: The SCSI 7:0 location is not available for selecting, since it is occupied by the SCSI 
controller itself. 

You may also type a brief description of the added device in the Description field. 
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When you are ready, click the Add Device button to add a generic SCSI device to your 
virtual machine. 

 

Removing Devices 
Most virtual machine devices can be removed from the virtual machine configuration (except 
for the main memory, CPU, and video memory). 

Note: You can disable any device, except for the memory, without removing it from the virtual 
machine configuration. To this effect, clear the Enabled option on the corresponding device's 
pane in Virtual Machine Configuration. 

To remove a device: 

1 Open the virtual machine the virtual device of which you wish to remove. Make sure that 
the virtual machine is stopped. 

2 Open Virtual Machine Configuration by choosing Edit Configuration from the Virtual 
Machine menu. 

3 Select the device you wish to remove and click the Remove button  in the bottom part of 
the Virtual Machine Configuration dialog. 

Note: If you accidentally click the Remove button , click Cancel in Virtual Machine 
Configuration. Once you click OK, the device will be removed. 
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Networking in a Virtual Machine 
To configure networking in your virtual machines, you should first configure networking for 
Parallels Workstation Extreme. You should also configure Parallels Workstation Extreme 
networking to have the possibility to send problem reports and get Parallels Workstation 
Extreme updates. If you have a network connection on your physical computer and do not use a 
proxy server, the Parallels Workstation Extreme network connection is set automatically. If you 
use a proxy server for network connections on your host computer, you should provide this 
proxy server settings in the Proxy Server pane (p. 52) of Parallels Workstation Extreme 
Preferences. 

After setting networking for Parallels Workstation Extreme, you should configure networking 
for your virtual machines. Parallels Workstation Extreme allows you to use the following types 
of networking in your virtual machines: 

 Shared Networking (p. 173). This type of networking allows the virtual machine to use the 
current network connections of your physical computer. 

 Bridged Ethernet (p. 175). This type of networking allows the virtual machine to use one of 
the physical computer's network adapters, which makes it appear as a separate computer on 
the network the physical computer belongs to. 

 Host-only networking (p. 176). This type of networking allows the virtual machine to access 
only the physical computer and other virtual machines residing on it. 

 Networking using a PCIe network adapter (p. 177). This type of networking allows the virtual 
machine to access the local network and Internet through an Intel VT-d PCIe network 
adapter. 

By default, the virtual machine uses Shared Networking, because configuring it requires 
minimal effort from the users. The Bridged Ethernet networking mode is more complex, and 
you may need to contact your system administrator to set it up properly. 

Detailed information on these types of networking and the way to configure them is provided in 
the following subsections. 
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Shared Networking 
By default, all virtual machines created using the Express Windows and Typical modes are set to 
work in the Shared Networking mode. In this mode your virtual machine can access other 
computers on your local network and the Internet by using the IP address of the physical 
computer. The virtual machine itself does not have its own IP address on the network. This 
mode allows you to specify port forwarding rules (p. 43) for the virtual machines running on the 
host computer, which can be especially useful when running HTTP, FTP, or other types of 
servers in virtual machines. 
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The Shared Networking mode does not require any additional configuration. With this mode 
enabled, your virtual machine will share whatever network connection your physical computer 
uses at the moment. 

You may wish to use the Shared Network mode in the following cases: 

 your computer accesses the Internet via a modem or another non-Ethernet device 
 you need to access the Internet from inside your virtual machine but are concerned about 

security 
 you have problems with working in the Bridged Ethernet mode 

To configure your virtual machine to use Shared Networking: 

1 Open the Virtual Machine Configuration dialog by choosing Virtual Machine > Configure. 

2 Select Network Adapter in the Hardware list. 

3 On the Network Adapter pane, make sure that the Enabled, Connected and Shared Networking 
options are selected. 

Note: In the MAC address field, you can change the MAC address currently assigned to the 
virtual machine. MAC addresses are automatically generated during the virtual machine 
creation. However, you can modify the default MAC address by typing another value in the 
MAC address field or clicking the Generate button. When entering a new MAC address, 
make sure that it is unique within your network. 

4 Click OK. 

For the information about troubleshooting networking problems, refer to the Parallels 
knowledge base http://kb.parallels.com/ available at the Parallels website. 
 

 

http://kb.parallels.com/
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Bridged Ethernet Networking 
When operating in the Bridged Ethernet mode, your virtual machine appears on the network as a 
stand-alone computer with its own IP address and network name. 

Note: The Bridged Ethernet networking mode is more complex than the Shared Networking 
mode (p. 173), and you may need to contact your system administrator to configure it properly. 

 

To configure your virtual machine to work in the Bridged Ethernet mode: 

1 Open the Virtual Machine Configuration dialog by choosing Virtual Machine > Configure. 

2 Select Network Adapter in the Hardware list. 

3 On the Network Adapter pane, make sure that the Enabled, Connected and Bridged Ethernet 
options are selected. 

4 Select the appropriate network adapter from the list. To connect the virtual machine's 
adapter to the active network adapter of your physical computer, choose Default Adapter. 

Note: In the MAC address field, you can change the MAC address currently assigned to the 
virtual machine. MAC addresses are automatically generated during the virtual machine 
creation. However, you can modify the default MAC address by typing another value in the 
MAC address field or clicking the Generate button. When entering a new MAC address, 
make sure that it is unique within your network. 

5 Click OK. 

If you cannot configure your virtual machine to function in the Bridged Ethernet mode, you can 
consider using another networking mode: Shared Networking (p. 173), Host-Only Networking 
(p. 176), or Networking using a PCIe Adapter (p. 177). 

For the information about troubleshooting networking problems, refer to the Parallels 
knowledge base http://kb.parallels.com/ available at the Parallels website. 
 

 

http://kb.parallels.com/
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Host-Only Networking 
Parallels Workstation Extreme provides a closed network that is accessible only to the primary 
operating system and virtual machines running on it. The primary operating system is connected 
to this network via the Parallels Host-Only Networking adapter automatically created on the 
physical computer during the Parallels Workstation Extreme installation. The addresses for the 
virtual machines connected to this network are provided by the Parallels DHCP server. 

 

To configure your virtual machine to use Host-Only Networking: 

1 Open the Virtual Machine Configuration dialog by choosing Virtual Machine > Configure. 

2 Select Network Adapter in the Hardware list. 

3 On the Network Adapter pane, make sure that the Enabled, Connected and Host-Only 
Networking options are selected. 

Note: In the MAC address field, you can change the MAC address currently assigned to the 
virtual machine. MAC addresses are automatically generated during the virtual machine 
creation. However, you can modify the default MAC address by typing another value in the 
MAC address field or clicking the Generate button. When entering a new MAC address, 
make sure that it is unique within your network. 

4 Click OK. 

For the information about troubleshooting networking problems, refer to the Parallels 
knowledge base http://kb.parallels.com/ available at the Parallels website. 
 

 

http://kb.parallels.com/
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Networking Using a PCIe Network Adapter 
If your computer has an Intel VT-d chipset, you can use a PCIe network adapter to connect your 
virtual machine to the local network and Internet. The virtual machine will directly access the 
PCIe network adapter without using the resources of the primary OS. Before adding a PCIe 
network adapter device to the virtual machine, you should assign it to your virtual machines in 
the Intel VT-d pane (p. 51) of Parallels Workstation Extreme Preferences. 

 

To configure your virtual machine to use the PCIe network adapter: 

1 Open the Virtual Machine Configuration dialog by choosing Virtual Machine > Configure. 

2 Select Network Adapter in the Hardware list. 

3 On the Network Adapter pane, make sure that the Enabled and Direct Assignment (using Intel 
VT-d) options are selected. 

4 Select the appropriate PCIe network adapter from the list. Click OK. 

5 Start the virtual machine and install the manufacturer's driver for this PCIe device inside the 
virtual machine. The driver should support the Intel VT-d technology. 

After performing these steps you will be able to use the PCIe network adapter directly from the 
guest OS. 

Note: You can assign one PCIe network adapter to several virtual machines but only one virtual 
machine can use one PCIe network adapter at a time. 
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C H A P T E R  8  

Managing Virtual Machines 

This chapter provides the information on cloning, removing from the regirested VMs list, and 
deleting your virtual machines. 
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Cloning a Virtual Machine 
An exact copy of a virtual machine can be created using Clone Virtual Machine Wizard. The 
clone is a separate virtual machine that includes as many virtual hard disks as were connected to 
the original machine. The wizard places the cloned virtual machine into a default folder, but you 
may specify a different one. 

In the virtual machine clone, the names of all devices, drivers, and virtual hard disk images 
remain the same as they were in the original machine. All connections between the devices in 
the cloned VM will be the same as in the original virtual machine. 

If a device in the original machine was connected to an external resource, this device in the 
clone will be connected to the same resource. The only exception is serial/parallel port log files. 
If such files are used by the original virtual machine, Parallels Workstation Extreme creates a 
new set of empty log files for the clone. 

If the original virtual machine has a snapshot tree, the virtual machine clone will have the same 
structure of snapshots. 

If a network adapter was enabled in the original configuration, Parallels Workstation Extreme 
generates a new Mac address for the clone. 

You can also make a clone of a clone, and give it a unique name. The resulting clone will have 
the same configuration and the same devices connected as the initial clone. 

Unlike snapshots (p. 191), a virtual machines and its clones are used separatly and there is no 
any connection between them after the clones creation. If you need to delete an initial virtual 
machine from which you have made clones, you can do it without any threat to the clones. 

Before cloning a virtual machine, make sure that the virtual machine is turned off. If the virtual 
machine is running, the Clone option in the File menu is disabled. 

To make a clone of a virtual machine: 

1 Open the virtual machine you want to clone. 

2 From the File menu, select Clone or right-click the virtual machine name in the virtual 
machines list and select Clone in the context menu. The Clone Virtual Machine Wizard 
window appears. If you do not want the Introduction window to appear in future, select 
Always skip introduction. Click Next. 

3 In the Name and Location window, specify the name and folder for the virtual machine 
clone. The name suggested by the wizard is made by adding "Copy of" to the original 
virtual machine name. You can specify another name but it should not be longer than 50 
characters. 
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Click Clone to start the process. 

4 When the copying is complete, the Cloning Finished window appears. Click Done to close 
the wizard. 
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Removing a Virtual Machine 
When you launch Parallels Workstation Extreme, you can see the currently registered virtual 
machines in the Parallels Workstation Extreme sidebar. 

If a virtual machine is not used, it can be temporarily removed from the list. When you need this 
virtual machine again, you will be able to add it to the list again. 

To temporarily remove a virtual machine from the virtual machines list, perform the following 
operations: 

1 Launch Parallels Workstation Extreme, choose the virtual machine you want to remove in 
the virtual machines list, right-click its name, and choose Remove from the context menu. 

Note: The virtual machine you want to delete should be stopped or the Remove option will 
be disabled. 

2 The Delete Virtual Machine Wizard introductory window appears. If you do not want this 
window to appear the next time you start this wizard, select Always skip introduction. Click 
Next. 

3 Select the Remove from list option and click Remove. 

 
4 The wizard removes the virtual machine from the virtual machines list. If the operation was 

successful, the Removal Succeeded window appears. 

5 Click Done to close the wizard. 
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Deleting a Virtual Machine 
You can delete a virtual machine using the Delete Virtual Machine wizard or by deleting its file 
manually. 

The Delete Virtual Machine wizard removes the following virtual machine files by default: 

 configuration file 
 virtual hard disk file(s) 
 snapshots 
 floppy disk image file(s), if any 
 output files of serial and parallel ports, if any 
 folder where this virtual machine files are stored 

The wizard can delete an open virtual machine that is not running. If it is running, the Remove 
command in the context menu is disabled. 

To delete a virtual machine: 

1 Open the virtual machine that you want to delete. 

2 Right-click the virtual machine name in the virtual machines list and select Remove in the 
context menu. The Delete Virtual Machine Wizard introductory window appears. If you do not 
want it to appear in future, select Always skip introduction. Click Next. 

3 In the Delete Options window, select Delete and click Next. 
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4 The wizard finds all files related to the virtual machine and displays the list of them in the 
Files Selection dialog. The configuration file, virtual hard disk, output files of serial and 
parallel ports, and the home folder are pre-selected for deleting. However, the .iso image 
is not selected by default, because it can be used by other virtual machines. If you want to 
delete it too, select it in the list. 
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Note: Make sure you are not going to delete the virtual hard disk that is also used by other 
virtual machines. 

If you want to select all items in the list of files related to the virtual machine at a time, click 

the Select All button  displayed below the list. 

If you want to clear all items in the list of files related to the virtual machine at a time, click 

the Clear All button  displayed below the list. 

Review the selection and click Delete. 

5 The wizard removes the selected files from the hard disk of the host computer. If the 
operation was successful, the Deletion Succeeded window appears. 

The virtual machine is considered as successfully deleted if all selected components or all 
selected components except the home folder (if it was chosen for deleting) have been 
removed. If the home folder contains any other files, the folder will not be deleted. 

Click Done to close the assistant. 

Deleting virtual machines manually 

Though it is strongly recommended to use Delete Virtual Machine wizard for deleting your 
virtual machines, you may also delete virtual machines manually. 

If you have virtual machines that are not registered in Parallels Workstation Extreme but their 
files are stored on your physical computer, you can permanently delete the unnecessary virtual 
machines by deleting their files. The virtual machine files (PVM files) are stored in the 
following folder by default: C:\Documents and Settings\<Username>\My 
Documents\Parallels\. Each virtual machine is represented by a single PVM file. 

Warning! Before deleting the virtual machine manually, make sure that this virtual machine 
is not registered in Parallels Workstation Extreme and none of its files (like virtual hard 
disks) are used by other virtual machines. 
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Working With Virtual Machine 
Templates 

Parallels Workstation Extreme makes your work with virtual machines even more convenient by 
enabling you to create templates of Parallels virtual machines. 

A template, like a virtual machine, has hardware and may have operating system and software 
installed. The only difference is that it cannot be started. A template can be easily converted to 
an ordinary virtual machine and vice versa. 

Using one template, you can create as many virtual machines as you need and the disk space of 
the host computer allows. The virtual machines created using such a template will have the same 
hardware configuration, operating system, and software that this template has. 

You can convert an existing virtual machine into a template or make a clone of the virtual 
machine that will be used as a template and continue using the original virtual machine. 
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Creating a Virtual Machine Template 
If you need to create a number of virtual machines with same configuration, you can create a 
virtual machine template and use it to create new virtual machines. 

There are two ways of creating a virtual machine template: 

 Convert an existing virtual machine into a virtual machine template. 
 Clone an existing virtual machine to a virtual machine template. 

If you choose to convert a virtual machine into a template, this virtual machine will change its 
operating system icon to a template icon in the list of virtual machines and it will be available as 
a template only. You will not be able to run it as a virtual machine. 

If you do not want to convert a virtual machine into a template but need to make a copy of it 
with the same configuration, you can make a clone of this virtual machine that will be used as a 
template. 

To convert an existing virtual machine into a template: 

1 Launch Parallels Workstation Extreme. 

2 Choose the virtual machine you want to convert into a template in the left pane of the 
Parallels Workstation Extreme window. 

3 Choose Convert to Template from the File menu or right-click the virtual machine's name in 
the left pane of the Parallels Workstation Extreme window and choose Convert to Template 
from the shortcut menu. 

4 The virtual machine will become a template and will have a different icon indicating that it 
is a template. 

To clone a virtual machine to a template: 

1 Launch Parallels Workstation Extreme. 

2 Choose the virtual machine you want to clone to a template in the left pane of the Parallels 
Workstation Extreme window. 

3 Start Clone to Template Virtual Machine Wizard by choosing Clone to Template from the 
File menu or by right-clicking the virtual machine's name in the left pane of the Parallels 
Workstation Extreme window and choosing Clone to Template from the shortcut menu. 

4 In the Introduction window, click Next. To skip this window next time you start the wizard, 
select Always skip introduction. 

5 In the Name and Location window, specify the name and location for the virtual machine 
template and click Clone. You can use the Choose button to change the location. 
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6 In the Creation Finished window, click Done to quit the wizard. 
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Deploying a Virtual Machine Template 
A virtual machine template cannot be run as a virtual machine. To be able to run it as a virtual 
machine, you should create a virtual machine that will have the same configuration as the 
template has. 

There are two ways of creating a virtual machine from a template: 

 Convert a template into a virtual machine. 
 Deploy a template to a new virtual machine. 

If you convert a virtual machine template into a virtual machine, its icon will be moved from the 
virtual machines list, and you will be able to use it as a virtual machine. 

If you deploy a virtual machine template to a virtual machine, the Deploy Virtual Machine 
Template wizard will create a new virtual machine, but the template will not be removed from 
the Parallels Virtual Machines list. 

To convert a virtual machine template into a virtual machine: 

1 Launch Parallels Workstation Extreme. 

2 Select the virtual machine template you want to convert into a virtual machine in the left 
pane of the Parallels Workstation Extreme window. 

3 Choose Convert to Virtual Machine from the File menu or right-click the template's icon in the 
left pane of the Parallels Workstation Extreme window and choose Convert to Virtual 
Machine from the shortcut menu. 

4 The virtual machine template will be processed into a virtual machine and will change its 
icon. 

To deploy a virtual machine template to a new virtual machine: 

1 Launch Parallels Workstation Extreme. 

2 Select the virtual machine template you want to be deployed to a virtual machine in the left 
pane of the Parallels Workstation Extreme window. 

3 Start Deploy Virtual Machine Template Wizard by choosing Deploy to Virtual Machine from 
the File menu or by right-clicking the virtual machine template's name in the left pane of the 
Parallels Workstation Extreme window and choosing Deploy to Virtual Machine from the 
shortcut menu. 

4 In the Introduction window, click Next. To skip this window next time you start the wizard, 
select Always skip introduction. 

5 In the Name and Location window, specify the name and location for the virtual machine and 
click Deploy. You can use the Choose button to change the location. 
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6 In the Deployment Finished window, click Done to close the wizard. 

The resulting virtual machine will have the same configuration that the original template had. 
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Managing Virtual Machines From 
the Tray 

When working with Parallels Workstation Extreme, you can use the Parallels Workstation 
Extreme tray icon (p. 38) to easily manage your running and paused virtual machines. This may 
be very useful when the Parallels Workstation Extreme window is minimized or when you use a 
separate display for your virtual machines. 

You can manage your virtual machines by doing one of the following: 

 Double-click the tray icon to bring the Parallels Workstation Extreme window (p. 31) to 
focus. However, it does not bring the detached virtual machine window (p. 31) to focus. 

 Right-click the tray icon to open its context menu where you can see your running and 
paused virtual machines. 

Note: Suspended and stopped virtual machines are not listed in the tray icon context menu. 

Point to a virtual machine and do one of the following: 

 Choose Show Window to bring the virtual machine window to focus. If this window is 
detached, only the detached window will be brought to focus. 

 If the virtual machine is paused, choose the corresponding item to resume, suspend, shut 
down or restart this virtual machine. 

 If the virtual machine is running, choose the corresponding item to pause, suspend, shut 
down or restart this virtual machine. 

 
 If the virtual machine has a PCIe video adapter assigned, you can manage its CD/DVD-

ROM drive or USB Controller. Point to the corresponding item and choose the necessary 
command. 

 If the virtual machine has a PCIe video adapter assigned, choose Grab Input to grab the 
mouse and keyboard input to the virtual machine. It may be very useful to switch over to 
the virtual machine when you work with two displays: one display for the host 
computer, the other for the virtual machine. 
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Optimizing Performance With 
Adaptive Hypervisor 

If you use a lot of applications in the primary and guest OSs at a time, you may lack the CPU 
resources. The current version of Parallels Workstation Extreme presents you the Adaptive 
Hypervisor technology that helps you to distribute the CPU resources between the primary and 
guest OS in the most efficient way.  

The Adaptive Hypervisor technology automatically allocate the host computer CPU resources 
between the virtual machine and primary OS applications depending on what application you 
are working with at the moment. If your virtual machine window is in focus, the priority of this 
virtual machine processes will be set higher than the priority of the primary OS's processes and 
as a result more CPU resources will be allocated to the virtual machine. If you switch to the 
primary OS window - the priority of its working applications will be set higher and the CPU 
resources will be relocated to the primary OS. 

You can enable the Adaptive Hypervisor option in the Optimization pane (p. 116) of Virtual 
Machine Configuration. In this pane, you can also configure the host computer memory 
resources distribution. 
 

Working With Snapshots 
A snapshot is a saved state of the virtual machine. Snapshots can be created manually or 
automatically when the virtual machine is running. After you make a snapshot, you can continue 
working with the virtual machine and revert to the created snapshot at any time of your work. 

Snapshots are stored in the primary OS inside the virtual machine bundle (p. 14), in the 
Snapshots subfolder. Each snapshot has a number of files, including the .sav file that 
contains the virtual machine's state, the .mem file that contains the memory dump for the virtual 
machine, and other different files of the virtual hard disk. 

Note: Snapshots are not backup copies or clones (p. 179) of your virtual machine. You cannot 
use them alone without your virtual machine or move them from the virtual machine bundle. 

You may need to make snapshots in the following cases: 

 If you are configuring a software that requires a lot of settings, you may want to explore the 
settings functions before selecting them. For testing the settings, create snapshots at 
branching points. 

 If you want to mark milestones in the development process. If something goes wrong, you 
can always revert to the previous state or create a branch of snapshots starting with the 
particular milestone snapshot. 
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Making Snapshots 
Snapshots can be created manually or automatically using SmartGuard. 

Note: You cannot create a snapshot manually or automatically or revert to a snapshot when your 
virtual machine is paused. 

To make a snapshot manually: 

1 Make sure that you completed all operations of installing, downloading, or writing to 
external devices before taking a snapshot. 

Note: You can create a snapshot at any time. But it is recommended to complete all 
operations of installing, downloading, or writing to external devices before taking a 
snapshot. You should also complete or cancel any transactions performed via the virtual 
machine in external data bases. 

2 Choose Take Snapshot from the Virtual Machine menu or use the Take Snapshot button 

 on the toolbar of your virtual machine's window. If the toolbar does not contain this 
button, you can add it to the toolbar. For more information, refer to the Customizing Toolbar 
section (p. 35). 

Note: To make a snapshot, you can also use Snapshot Manager. Just open the manager by 
choosing Snapshot Manager from the Virtual Machine menu and click the New button. A new 
snapshot will be created. 

3 In the Snapshot Parameters window, you can provide a name and a short description for the 
snapshot. This information and the date of creation will be visible in Snapshot Manager 
when you hover the pointer over the snapshot icon. 

4 Click OK to take a snapshot. 

After the snapshot is created, you can continue working with your virtual machine's current state 
or use any of its snapshots. 

To revert to a snapshot, open Snapshot Manager by choosing Snapshot Manager from the Virtual 

Machine menu or by clicking the Snapshot Manager button  on the toolbar of the virtual 
machine window. 

To create snapshots automatically, configure the SmartGuard settings. 
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Managing Snapshots 
You can use Snapshot Manager to revert to a specific snapshot, as well as to manage the 
snapshots. To open Snapshot Manager: 

 Choose Snapshot Manager from the Virtual Machine menu, or 

 Click the Snapshot Manager button  on the toolbar of the virtual machine window. 

Note: To add this button in the toolbar, you should customize it. To learn how to do that, 
refer to the Customizing Toolbar section. 

Using Snapshot Manager, you can: 

 create new snapshots and delete the unused ones 
 view the snapshot tree of a particular virtual machine 
 select a snapshot to revert to 
 Note: You cannot create a snapshot manually or automatically or revert to a snapshot when 

your virtual machine is paused. 

The Virtual Machine Snapshots window consists of the following areas: 

 The snapshots tree pane. 
 The snapshots management pane. 

Snapshots Tree Pane 

Snapshot icons appear as screen shots of the guest OS window if the virtual machine was 
running at the time you created a snapshot. 

The left icon with a flag is the root of the snapshots tree - it is the initial state of the virtual 
machine used as the reference point. You cannot delete the root icon. The root icon is visible if 
at least one snapshot exists. If you want to delete a snapshot which is parental for some other 
snapshots, you can decide whether to delete only this snapshot or delete it with all the 
subsequent snapshots. 

All snapshots in the snapshots tree are descendants of the root state of the virtual machine. The 
first snapshot contains "differences" with respect to the root state. The second successive 
snapshot contains differences with respect to the first snapshot. You may want to return to one 
of the previous snapshots and work with it. If you then create a new snapshot, a new snapshots 
branch will be created. 

An icon that represents the current state of the virtual machine is marked by a red flag. 

When you hover the pointer over an item, you will see a tooltip message with a short 
description. 

Snapshots Management Pane 

The snapshots management pane includes the buttons necessary for managing the snapshots. 

 The New button. Click this button to create a new snapshot for the present state of your 
virtual machine. 
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 The Go To button. Select the snapshot you want to go to in the snapshots tree and click this 
button to move from the present state of your virtual machine to the state saved in this 
snapshot. 

Note: Before you go to a specific snapshot, decide what you want to do with the current 
state of the virtual machine - by default, it will not be saved. To retain the changes made 
since the last snapshot, make a new snapshot. 

 The Delete button. Select the snapshot you want to delete and click this button. If you delete 
an intermediate snapshot, the information it contains will be merged into the subsequent 
snapshot. 

Note: You cannot delete the root icon. It disappears only when you delete all snapshots in 
the tree. 

You can also manage snapshots by right-clicking them in the tree: 

 If you right-click the icon that shows the present state of the virtual machine, you can create 
a new snapshot for this state. 

 If you right-click any other intermediate snapshot, you can choose to go to it, to delete it 
alone or with all the subsequent snapshots. 

Going to a Snapshot 
1 Launch Parallels Workstation Extreme and open a virtual machine. 

2 Open Snapshot Manager by 

 choosing Snapshot Manager from the Virtual Machine menu, or 

 clicking the Snapshot Manager icon in the toolbar of the virtual machine main window. 

3 In the Virtual Machine Snapshots window, choose the snapshot and click the Go To button. 
You can also right-click the snapshot and choose Go to Snapshot from the shortcut menu or 
just double-click the snapshot. 

Note: If, after the Parallels Workstation Extreme update, you decided to revert to one of the 
snapshots made before the update, you will see the message that a new Parallels Tools 
update is available. We recommend you to install them to work effectively with the virtual 
machine. 

4 If you revert to a snapshot from an unsaved state of the virtual machine, you will see the 
notification about that. Click Yes if you want to proceed without saving the state. Click No if 
you want to save the state and then go to the needed snapshot. 

If you want to revert to the previous snapshot made on the same branch of snapshots, use the 
Revert To Snapshot option from the Virtual Machine menu or from the virtual machine main 
window toolbar. If you want to know to what exactly snapshot you will revert, you can always 
see your snapshots tree in Snapshot Manager. 

Note: If you revert to the previous snapshot from an unsaved state of the virtual machine, you 
will see the notification about that. Click Yes if you want to proceed without saving the state. 
Click No if you want to save the state and then revert to the snapshot. 

After reverting to a snapshot, it is recommended to update Parallels Tools in the virtual machine. 

Deleting a Snapshot 
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1 Launch Parallels Workstation Extreme and choose a virtual machine. 

2 Open Snapshot Manager by 

 choosing Snapshot Manager from the Virtual Machine menu, or 

 clicking the Snapshot Manager button in the toolbar of the virtual machine window. 

3 Select the snapshot you want to delete and click the Delete button if you want to delete only 
this snapshot. If you want to delete all the snapshots that come after it, right-click the 
snapshot and choose the Delete Snapshot with children option. 

If you delete an intermediate snapshot, the information it contains will be merged into the 
snapshot that follows it. 

Note: You cannot delete the root icon, but it gets automatically deleted after you delete all the 
other snapshots. 

Merging Snapshots 

Merging is performed automatically when you delete any snapshot except the last one in the 
branch. When you delete an intermediate snapshot, the information it contains is merged into the 
next snapshot of the same branch. 

If you delete the snapshot belonging to two branches, the information is merged into the next 
snapshot of each branch. 

Note: If you delete the snapshot that comes after the root icon and that belongs to two branches, 
the branches will start from the initial state icon directly. 

The snapshots are also merged automatically if you manage the capacity of your virtual hard 
disk with the help of Parallels Image Tool. Before applying any changes to the virtual hard disk, 
Parallels Image Tool merges and deletes all the snapshots except for the last one. Unlike 
merging the snapshots in Snapshot Manager, the results of merging process via Parallels Image 
Tool are not reflected in the snapshots tree, and the icons of already deleted snapshots are still 
present in the tree. 
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C H A P T E R  9  

Using Parallels Add-Ons 

This chapter provides information on how and when you can use Parallels Transporter, Parallels 
Compressor, and Parallels Image Tool. 

In This Chapter 
Using Parallels Image Tool ................................................................................................... 196 
Using Parallels Transporter................................................................................................... 200 
Using Parallels Compressor .................................................................................................. 204
 
 

Using Parallels Image Tool 
Virtual machines use virtual hard disks that are actually hard disk image files. After using your 
virtual machine for some time, you may find that your virtual machine hard disk does not fit 
your needs anymore, and you want to increase its capacity, or change its type and properties. 
Parallels designed a special utility for increasing the virtual hard disk capacity and managing its 
properties - Parallels Image Tool. 

Note: The virtual hard disk image file can be found inside the virtual machine's PVM bundle. In 
the Windows primary OS PVM bundles are stored in the C:\Documents and 
Settings\<Username>\My Documents\Parallels\ folder. In the Linux primary 
OS they are stored in the /<username>/parallels directory. 

Parallels Image Tool is installed automatically during the Parallels Workstation Extreme 
installation. 

To start Parallels Image Tool in the Windows primary OS: 

 From the Windows Start menu, choose Programs > Parallels > Parallels Workstation Extreme 
> Parallels Image Tool. 

To start Parallels Image Tool in the Linux primary OS: 

 From the Applications menu, choose System Tools > Parallels Image Tool. 
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Increasing the Virtual Hard Disk Capacity 
If you find that the capacity of your virtual machine's hard disk does not fit your needs anymore, 
you can increase it using Parallels Image Tool. 

To increase the capacity of the virtual hard disk: 

1 Start Parallels Image Tool. 

2 In the Introduction window, click Continue. 

3 Specify the source virtual disk image file with the .hdd extension in the Source Virtual Disk 
window. You may type the path and file name or use the Choose button to locate the file. 
The virtual hard disk image file can be found inside the virtual machine's PVM bundle. 
PVM bundles are stored by default: 

 in the /<Username>/Documents/Parallels/ folder or in the /Users/Shared 
folder in Mac OS X. 

 in the C:\Documents and Settings\<Username>\My 
Documents\Parallels\ folder in the Windows primary OS. 

 in the /<username>/parallels directory in the Linux primary OS. 

Note: The virtual machine using this virtual hard disk should be stopped before proceeding. 

4 Select the Increase the disk capacity option in the Select Action window. 

5 Specify the new capacity for the disk. The Add the unallocated space to the last volume 
check box, which is selected by default, means that the additional disk space will be added 
to the last volume. If you clear it, the added space will appear as unallocated space. To 
allocate this space, you can either create a new partition or expand an existing partition. For 
instructions on allocating the added space, see the Using the Added Space section. 

Note: If you choose a hard disk used by a virtual machine that has snapshots, all snapshots, 
except the last one, will be deleted. 

To start the process of increasing the disk capacity, click Start. You can view the operation 
progress in the Processing the File window. Clicking Cancel terminates the operation. 

Note: If the virtual hard disk image file you specified is in the old format, it will be 
automatically converted to the new format. 

6 After the disk image has been successfully modified, the Execution is Completed window 
appears. Click Finish to close Parallels Image Tool. 
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Managing the Virtual Hard Disk Properties 
With Parallels Image Tool, you can manage the properties of your virtual machine hard disk. 
You can change the virtual hard disk type from plain to expanding and vice versa, split or merge 
the disk parts, or merge snapshots of the virtual machine that uses this virtual hard disk. 

To change the type of the virtual hard disk: 

1 Start Parallels Image Tool. 

2 In the Introduction window, click Continue. 

3 Specify the source virtual disk image file with the .hdd extension in the Source Virtual Disk 
window. You may type the path and file name or use the Choose button to locate the file. 
The virtual hard disk image file can be found inside the virtual machine's PVM bundle. 
PVM bundles are stored by default: 

 in the /<Username>/Documents/Parallels/ folder in Mac OS X. 

 in the C:\Documents and Settings\<Username>\My 
Documents\Parallels\ folder in the Windows primary OS. 

 in the /<username>/parallels directory in the Linux primary OS. 

Note: The virtual machine using this virtual hard disk should be stopped before proceeding. 

4 Select the Manage disk properties option in the Select Action window. 

5 In the Select Operations window, choose one or several of the following operations to 
perform on the disk and click Start: 

Note: The operations with the virtual hard disk are irreversible. 

 If the virtual hard disk image you specified is an expanding virtual hard disk, the Split 
virtual hard disk image file option is selected by default. 

 If it is an expanding disk, you can select the Convert to Plain option. 

 If it is a plain disk, the Convert to Expanding option is selected by default. 

 If the hard disk image you selected has snapshots, the Merge snapshots option is selected 
by default. You cannot clear this option. 

Note: The merging process deletes all the snapshots, except the last one. 

Parallels Image Tool needs to merge all the snapshots of the current virtual hard disk before 
performing any actions with it. The information from all the snapshots will be merged to the 
last one, and all the other snapshots will be deleted. Parallels Image Tool does not change 
the snapshots tree in Snapshot Manager, so if you attempt to revert to any snapshot of the 
tree, it will be no longer accessible, and you can remove it manually.Note: If the virtual hard 
disk image file you specified is in the old format, it will be automatically converted to the 
new format. 

You can view the operation progress in the Processing the File window. Clicking Cancel 
terminates the operation. 

6 After the disk image has been successfully modified, the Execution is Completed window 
appears. Click Finish to close Parallels Image Tool. 
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Changing the Virtual Hard Disk Format 
If you want to use your virtual machine with an earlier version of Parallels Workstation 
Extreme, use Parallels Image Tool to convert its hard disk image file to the old format. Image 
Tool can be also used to convert virtual hard disk image files created with Parallels Workstation 
2.2 to the new format, supported by Parallels Workstation Extreme 4. 

Warning: If you have Parallels Tools installed on your virtual hard disk, remove them before 
processing the disk. 

To change the format of your virtual hard disk image file: 

1 Launch Parallels Image Tool. 

2 In the Introduction window, click Continue. 

3 Specify the source image file of the virtual hard disk in the Source Virtual Disk Image File 
window. You may type the path and file name or use the Choose button to locate the file. 

4 In the Select Action window, select: 

 Convert to the old format if your hard disk image file is in the Parallels Workstation 
Extreme 4 format and click Start. In this case, the hard disk will be converted into the 
Parallels Workstation 2.2 format. 

 Convert to the new format if your hard disk image file is in the Parallels Workstation 2.2 
format and click Start. In this case, the hard disk will be converted into the Parallels 
Workstation Extreme 4 format. 

Note: If you are converting the disk to the old format, you may need to reconfigure the guest 
OS installed on it. To do that, you will need the installation media for the guest OS installed 
on the disk. You may insert it into the CD/DVD-ROM drive of your computer or select the 
installation media to use in the More Options area. When finished, click Start. 

You can view the operation progress in the Processing the File window. Clicking Cancel 
terminates the operation. 

5 After the disk image has been successfully modified, the Execution is Completed window 
appears. Click Finish to close Parallels Image Tool. 
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Reducing the Virtual Hard Disk Size 
With Parallels Image Tool, you can manage the properties of your virtual machine hard disk.  

If you have an expanding virtual hard disk and need to reduce its size by removing unused space 
on the disk, you can compact it. 

Note: A plain virtual hard disk cannot be compacted. 

To reduce the virtual hard disks size: 

1 Start Parallels Image Tool. 

2 In the Introduction window, click Continue. 

3 Specify the source virtual disk image file with the .hdd extension in the Source Virtual Disk 
window. You may type the path and file name or use the Choose button to locate the file. 
The virtual hard disk image file can be found inside the virtual machine's PVM bundle. 
PVM bundles are stored by default: 

 in the /<Username>/Documents/Parallels/ folder in Mac OS X. 

 in the C:\Documents and Settings\<Username>\My 
Documents\Parallels\ folder in the Windows primary OS. 

 in the /<username>/parallels directory in the Linux primary OS. 

Note: The virtual machine using this virtual hard disk should be stopped before proceeding. 

4 Select the Compact the disk option in the Select Action window and click Start. 

Note: If the virtual hard disk has one or several snapshots, Parallels Image Tool needs to 
merge them before performing the required action with the disk. The information from all 
snapshots will be merged to the last one, and all the rest will be deleted. Parallels Image 
Tool does not change the snapshots tree in Snapshot Manager, so if you attempt to revert to 
any snapshot of the tree, it will be no longer accessible, and you can remove it manually. 

The disk compacting procedure starts. 

5 Click Finish in the Execution is Completed window to exit Parallels Image Tool. 
 

Using Parallels Transporter 
Parallels Transporter is an easy-to-use application which helps you migrate physical or virtual 
computers with the whole information they contain to Parallels virtual machines on the host 
computer. This chapter contains an overview of Parallels Transporter usage scenarios and 
working principles. 

Parallels Transporter is provided as a Parallels Workstation Extreme utility and installed 
automatically during the Parallels Workstation Extreme installation. 
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Parallels Transporter Working Principles 
Parallels Transporter package includes two applications: 

 Parallels Transporter. This application transfers data stored on a physical computer or a 
volume to a Parallels virtual machine or virtual hard disk. 

 Parallels Transporter Agent. This application collects essential system data on the remote 
computer (the source computer) or volume you are planning to migrate and transfers it to 
Parallels Transporter installed on the computer that will host the resulting virtual machine or 
virtual hard disk (the host computer). 

Parallels Transporter is provided as a Parallels Workstation Extreme utility and is installed 
automatically on the host computer during the Parallels Workstation Extreme installation. 

On the source computer, you can install a separate package containing Parallels Transporter and 
Parallels Transporter Agent. You can download the most recent version of Parallels Transporter 
package from Parallels Download Center: 

 for a PC with a Windows OS installed - Parallels-Transporter-Full-
x.x.xxxx-en_US.exe 

 for a PC with a Linux OS installed - parallels-transporter-xxxx.xxxxxx.run 

Each of these packages contains Parallels Transporter and Parallels Transporter Agent. 
Depending on what scenario will be used, install Parallels Transporter Agent or both on the 
source PC. Before you start the migration, make sure that your the host computer and the source 
PC are connected by a network cable and can access each other over the network. Check that 
you have enough free disk space on the host computer to allocate the resulting images of the 
migrated volumes. 

For more detailed information, please refer to Parallels Transporter User's Guide. 
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Migration Scenarios 
Parallels Transporter offers you several typical migration scenarios depending on the purpose of 
migration. After you make up your mind and choose the scenario, you can refer to Parallels 
Transporter Help for further instructions on the selected scenario of migration. 

Using Parallels Transporter, you can migrate: 

 from a remote computer 
 from a third-party virtual machine 
 from a remote computer locally 

Parallels Transporter has two migration modes: 

 Express. This mode allows quick migration of one active volume. As a result, you will get a 
ready-to-use Parallels virtual machine which will have the guest operating system installed 
and all the applications and data you used on that volume. 

 Advanced. This mode allows migration of several volumes at once. In one session of 
migration, only one active volume (if selected so) can be made bootable. The new virtual 
machine will be created with this volume as its virtual hard disk. Other volumes will be 
migrated as data disks if they have file systems supported by Parallels Transporter Agent. 

Migrating from a remote computer 

In this scenario, you should use Parallels Transporter on the host computer and Parallels 
Transporter Agent on the PC you want to migrate. 

The volume where Parallels Transporter Agent is installed is called the active volume. The 
operation is supported for the active volumes with the following operating systems: 

 Windows 2000 
 Windows Server 2003 
 Windows XP 
 Windows Vista. 

Parallels Transporter can apply necessary changes only to the listed operating systems so that 
the images of active volumes can be bootable in Parallels virtual machines. 

If you want to use a migrated disk as a boot volume (system disk) in your virtual machine you 
must provide an installation disc for the operating system that runs on the active volume of the 
source computer (you can also use an ISO image of such an installation disc). Parallels 
Transporter may need to reinstall a few drivers, because hardware on the source computer and 
default virtual hardware of a virtual machine are different. 

Warning: If you migrate a volume with a Windows OS installed on it and want to use its 
image as a bootable virtual disk, please note that there may be activation problems: a 
Windows OS migrated to a virtual machine may detect that the hardware has changed and 
require that you reactivate your copy of Windows. 
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Parallels Transporter Agent enables you to migrate data from non-active volumes of a source 
computer and to create images of these volumes. The resulting image can be connected as a data 
disk to a virtual machine that has an operating system compatible with the file system on this 
volume. Disk images of non-active volumes with supported operating systems can be made 
bootable later (in a Parallels virtual machine). 

Migrating from a third-party virtual computer 

You can use Parallels Transporter for converting a third-party virtual computer into a Parallels 
virtual machine (Express and Advanced migration modes), and for converting a third-party 
virtual disk to a Parallels virtual machine or disk (Advanced migration mode). If you select to 
convert the entire third-party virtual computer, the configuration of the resulting Parallels virtual 
machine will be the similar to the original one. This operation is supported for VMware virtual 
machines and Microsoft Virtual PC computers. 

You can also process an already existing non-bootable Parallels virtual disk image (result of 
migration from a system volume of a remote PC), so that this image can be used as a bootable 
volume in a Parallels virtual machine (Advanced mode only). 

Migrating from a remote computer locally 

The operation can be useful, when the computer you want to migrate and the host computer are 
not connected by a network. This scenario can be performed on a remote source computer that 
has both Parallels Transporter Agent and Parallels Transporter installed. 

You should download the proper Parallels Transporter package for PC and install both Parallels 
Transporter and Transporter Agent on the boot volume of the remote computer. You can migrate 
one or several volumes during one session (Advanced mode) or only the active volume (Express 
mode). As a destination for storing the resulting image, you can specify an external USB drive 
connected to the remote computer in case you don't have local network to transfer the image 
right to the host computer. 

Note: After the migration is finished, you are recommended to install Parallels Tools (p. 74) in 
your new virtual machine before starting to work with it. 
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Starting Parallels Transporter 
To start Parallels Transporter in Windows: 

 If Parallels Transporter was installed together with Parallels Workstation Extreme, click the 
Windows Start menu and choose All Programs > Parallels > Parallels Workstation Extreme > 
Parallels Transporter or choose Run Parallels Transporter from the Parallels Workstation 
Extreme File menu. 

 If Parallels Transporter was installed as a separate package, click the Windows Start menu 
and choose All Programs > Parallels > Parallels Transporter. 

To start Parallels Transporter in Linux, click the Applications menu and choose System Tools > 
Parallels Transporter. 

To start Parallels Transporter Agent: 

 In Windows, click the Windows Start menu and choose All Programs > Parallels > Parallels 
Transporter Agent. 

 In Linux, click the Applications menu and choose System Tools > Parallels Transporter 
Agent . 

 

Using Parallels Compressor 
Parallels Compressor is an easy-to-use Parallels utility which will help you keep your virtual 
machines efficient for many purposes. 

Parallels Compressor is a part of the Parallels Tools set and is installed, updated, and removed 
with Parallels Tools. To start Parallels Compressor, choose Run Parallels Compressor from the 
Virtual Machine menu. 

Parallels Compressor allows users to: 

 effectively clean up disk space in a virtual machine 
 significantly reduce the size of virtual hard disks files 
 efficiently use the resources of a physical hard disk 

Note: Compressing of a virtual machine cannot be performed if the virtual machine has the 
Undo disks option enabled, or if it has snapshots. Compressing is also unavailable for the virtual 
machines with plain disks. 

If, nevertheless, you want to compress the virtual machine that has snapshots, delete all the 
snapshots with the help of Snapshot Manager before you start compressing the virtual machine's 
disks. For more information, refer to Managing Snapshots (p. 193). 

To compress the virtual machine with Undo Disks (p. 114), first disable the Undo disks feature 
in Virtual Machine Configuration. 
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Guest Operating System Requirements 
Parallels Compressor supports the following guest operating systems: 

32-bit operating systems: 

 Windows 2000 Server SP4, Professional SP4 
 Windows XP Professional SP2, SP3, Home SP2, SP3 
 Windows Server 2003 Web, Standard, Enterprise, Datacenter SP2, R2 
 Windows Vista Home, Business, Ultimate, Enterprise SP0, SP1 
 Windows 2008 

64-bit operating systems: 

 Windows XP Professional SP2 
 Windows Server 2003 Web, Standard, Enterprise, Datacenter SP2, R2 
 Windows Vista Home, Business, Ultimate, Enterprise SP0, SP1 
 Windows 2008 

 

Parallels Compressor Working Principles 
Compressor processes a virtual machine in the following way: 

 defragments virtual disks and cleans up unused space 
 compacts virtual disks 

The actions performed on your particular virtual machine depend upon the running mode: 

 in automatic mode Parallels Compressor compresses only the current system disk 
performing the pre-defined set of actions 

 in manual mode you are able to choose disks to compress and actions to perform 

More about running modes and other Compressor properties can be found in Parallels 
Compressor Help. 

Steps of the Compression Procedure 

Parallels Compressor is designed to perform the most efficient compression of a virtual 
machine. The procedure consists of two steps: 

 a preparatory step performed in the guest operating system (deleting temporary and 
unnecessary files, defragmenting virtual disks and cleaning unused disk space); 

 a compacting step (reducing the size of the virtual disk files) performed in the primary 
operating system. 
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How to Run Parallels Compressor 

Before Starting Parallels Compressor 

Before starting the utility, back up your virtual machine by cloning it or by copying its hard disk 
files to a safe location. This will allow you to restore your virtual machine in case you do not 
like the results of the compression. 

Warning: The result of virtual machine compression is irreversible. 

To start Parallels Compressor: 

1 Start the virtual machine you want to compress. 

2 Log in to the guest operating system as a user with administrator rights. 

Note: To run Parallels Compressor in a virtual machine you must have administrator rights 
in the guest operating system. 

3 Choose Run Parallels Compressor from the Virtual Machine menu. 

Running Parallels Compressor 

Parallels Compressor has the following running modes: 

 automatic, the default mode. In this mode Compressor uses the default compression 
options. 

  manual, Parallels Compressor runs as a wizard which helps you select the options of 
virtual machine compression. 

When you start Parallels Compressor, you will see the dialog box with a time indicator. The 
time indicator shows the time remaining until Parallels Compressor will run in automatic mode 
(timeout is about 10 seconds). 
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To run Parallels Compressor: 

 in automatic mode, do not do anything, just wait until the timeout expires. 
 in manual mode, press the ESC key or click the Manual Mode button on the dialog box 

before the timeout expires. 
 Detailed information about running Compressor in these modes is given in Parallels 

Compressor Help. 

After Compressing Is Finished 

When the compressing is complete, click Finish to exit Parallels Compressor. 
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Troubleshooting and Limitations 

This chapter describes how to troubleshoot known issues. 

In This Chapter 
Getting Technical Support .................................................................................................... 208 
Reporting a Problem to Parallels Team................................................................................. 209 
Configuring Network in Linux.............................................................................................. 210 
Switching Into the Hibernate Mode ...................................................................................... 211 
Increasing the Virtual Machine Screen Resolution............................................................... 211 
Memory Usage Problems...................................................................................................... 212 
Problems With Antivirus Software ....................................................................................... 213 
Installing the GCC package and kernel sources in Linux ..................................................... 213
 
 

Getting Technical Support 
Our friendly technical support team is ready to help. Describe your problem and submit a FREE 
request to Parallels Support Team (http://www.parallels.com/support/). 

To find solutions of common problems, explore Parallels Knowledge Base 
(http://kb.parallels.com/). This online-resource comprises valuable articles about using Parallels 
Workstation Extreme. 

Telephone support is available on a per incident fee basis. Please visit the support team's page of 
the Parallels web site for details. 
 

 

http://www.parallels.com/support/
http://kb.parallels.com/
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Reporting a Problem to Parallels 
Team 

To help improve the quality of Parallels Workstation Extreme, you can send problem reports to 
Parallels support team. If a fatal error occurs in a virtual machine, Parallels Workstation 
Extreme automatically opens the Parallels Problem Report window prompting you to send a 
report. If you notice an unusual virtual machine behavior, you can create a report manually by 
choosing Report a Problem from the Help menu and filling out the form. Parallels Workstation 
Extreme will create a status report and make a screen shot of the running virtual machine. 

Note: Parallels team collects error reports and uses them for identifying performance issues, but 
does not respond to them. If you need assistance in resolving the issue, visit Parallels forum or 
Support page, or log us a support call. 
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In the Specify the problem type field, you can select the type of your problem from the list. In the 
next field, you can add a short problem description. These two fields are optional. 

The Technical Data option includes the .txt status report file that has been generated for the 
error. The status report contains the product version and activation data, primary and guest OSs 
information, virtual machine configuration and system data information, processor status, etc. 
Click the Technical Data icon to view the .txt file and to choose the sections that will be added 
to the report. The file is saved on the host computer. If you want to locate it, click the Go To File 
button. 

The Guest OS Screenshot option includes the session screen shot of the guest OS in a .png 
format. This option is available if you create a problem report during the virtual machine 
session. Click the Guest OS Screenshot icon to see the screen shot and the path to its location on 
the host computer. 

The Primary OS Screenshot option includes the session screen shot of the primary OS in a .png 
format. This screen shot is made and put on the primary OS desktop whenever you create a 
problem report. Click the Primary OS Screenshot icon to see the screen shot. 

In the Contact Name and Contact e-mail fields, type your name and e-mail. This information will 
be used by the Parallels support team to address you for more technical details if needed. 

Sending a Report 

After you revise the problem report components, click Send Report. The report will receive its 
unique id number and will be sent to the Parallels support team. 
 

Configuring Network in Linux 
When setting up network in Linux, you may need to configure the DHCP client to send the 
virtual machine's ID in DHCP requests. For information on how to configure your DHCP client, 
refer to the DHCP client documentation. 

For example, in Red Hat Linux guest OSs, you need to edit the DHCP client configuration file. 

1 Open the dhclient.conf file and make sure that the following lines are present. 
interface "eth0" { 
 send dhcp-client-identifier 1:<MAC address>; 
}  

2 If there are no such lines, add them manually to the file and save it.  

When the dhclient.conf file contains these lines, DHCP client sends the virtual machine's 
ID to the DHCP server. The DHCP server sends an IP address in response. 

Tip 

To locate the dhclient.conf file, in a terminal, enter: 
strings /sbin/dhclient | grep etc | grep dhclient.conf 

or: 
rpm -ql dhclient 
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Switching Into the Hibernate Mode 
If your running virtual machine with a Windows guest OS has an Intel PCIe network card in its 
configuration, you may experience problems with putting your primary OS into the Hibernate 
mode (the Sleep mode). To fix these problems, perform the following actions: 

1 In the guest OS,  go to Start > Control Panel > Network Connections and open Local Area 
Connections. 

2 In the Local Area Connections window, click Properties. 

3 In the General tab of the Local Area Connections Properties window, click Configure next to 
the network card name. 

4 In the network card properties window, open the Power Management tab and disable the 
Wake on Direct Packet option in the Wake on LAN settings. 

Note: These actions will help you to put your primary OS into the Hibernate mode only if 
Parallels Tools (p. 74) are installed in the Windows guest OS. 
 

Increasing the Virtual Machine 
Screen Resolution 

In virtual machines with Linux guest operating systems installed, dynamic resolution may not 
work when increasing the size of the guest OS window or switching to Full Screen mode. It 
happens because, by default, only 3 MB of video memory are allocated to such virtual machines' 
video cards. If you need the virtual machine screen resolution more than 1024x768, go to the 
Video pane (p. 129) of Virtual Machine Configuration and increase the amount of video memory 
available to the virtual machine's video card up to 16 MB. 
 

 



 Troubleshooting and Limitations 212 
 

Memory Usage Problems 
The amount of the host computer physical memory required for each virtual machine operation 
can be represented as follows: 

Virtual Machine Memory = Guest OS Memory + Video Memory + Virtual Machine Monitor 
Memory 

 Guest OS Memory is the amount of RAM available to your guest OS. You can configure the 
guest OS memory amount in the Memory pane (p. 128) of Virtual Machine Configuration. 

 Video Memory is the amount of physical memory available to the virtual machine's video 
card. You can adjust the video memory amount in the Video pane (p. 129) of Virtual 
Machine Configuration. 

 Virtual Machine Monitor is the module responsible for the guest operating system 
virtualization. It consumes memory to peform operations of guest virtual devices and  hadle 
virtual paging emulation. The amount of memory required for the Virtual Machine Monitor 
operation depends on the guest OS and varies from 50 MB to 200 MB. 

You can configure the whole amount of physical memory available for all running virtual 
machines in the Memory tab of the application Preferences.  

Memory Overcommitment 

If you have several virtual machines running at a time, and you are trying to start one more 
virtual machine, you can come across the memory over commit. The application will inform you 
with the corresponding message. This means that all your running virtual machines require more 
memory that is configured in the Memory tab of the application Preferences. If you start one 
more virtual machine, this may significantly slow down all your virtual machines. To solve this 
problem, you can: 

 stop one or several of your running virtual machines, or 
 edit your virtual machines' configurations to make them consume less memory, or 
 edit the application memory preferences to allocate more memory to your virtual machines. 
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Problems With Antivirus Software 
Because of the close integration with the host operating system, some actions performed by the 
Parallels Workstation Extreme processes may be detected as malicious by the antivirus software 
installed on the host computer. 

However, such actions are necessary to ensure the proper functioning of Parallels Workstation 
Extreme. That is why you should prevent the antivirus software from blocking them. If you do 
not want the alerts to appear in future, perform a full system scan using the antivirus software 
and add these processes to the list of trusted ones if no viruses are detected. To find out how to 
do it, refer to your antivirus software Help. 

Note: The names of Parallels Workstation Extreme processes usually start with prl or 
parallels. 
 

Installing the GCC package and 
kernel sources in Linux 

When installing or upgrading Parallels Tools in a Linux virtual machine, you may need to install 
the gcc package and kernel sources in your Linux guest OS. Kernel sources can be either 
downloaded from the Internet, or installed from Linux distribution disks. 

To install the gcc package and kernel sources in the RHEL/Fedora/CentOS Linux distribution, 
enter the following command in a terminal: 
yum install gcc kernel-devel 
make 

To install the gcc package and kernel sources in the Debian/Ubuntu Linux distribution, enter the 
following command in a terminal: 
apt-get install gcc make linux-headers-$(uname -r) 

For information how to install the gcc package and kernel sources in other Linux distributions, 
refer to the corresponding Linux distribution documentation. 

If you still experiencing problems, try to find a solution in Parallels Knowledge Base 
(http://kb.parallels.com/) or refer to the Parallels support team 
http://www.parallels.com/en/support/desktop/. 
 

 

http://kb.parallels.com/
http://www.parallels.com/en/support/desktop/
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Glossary 

This glossary defines terms and spells out abbreviations used in Parallels Workstation Extreme 
documentation. References to terms defined elsewhere in the glossary appear in italics. 

Administrator. A user with administrative privileges. 

Activation key. A unique set of symbols that activates the Parallels Workstation Extreme 
application on the host computer and lets you use the Parallels Workstation Extreme 
functionality to its full extent. 

Active operating system. The operating system where Parallels Transporter Agent is launched. 

Active volume: The volume of the physical source computer that is used as a boot volume for the 
active operating system.  

Bootable hard disk. A disk used by the operating system to boot from, usually a disk that has an 
operating system installed. 

Boot Volume. A hard disk partition from which the operating system boots. 

Boot Camp partition. A partition on the hard disk of the host computer that can be used for 
installing a Windows operating system on it (for Mac host computers only). 

Bridged networking. Virtual machine network connection mode that enables the virtual machine 
to appear as any other computer on the network, with it own IP address and network name. 

Configuration file. A file specifies the virtual machine's hardware configuration, the devices it 
uses, and other settings. It is created automatically when you create a new virtual machine. See 
also PVS file.  

CPU. Stands for central processing unit. It is an internal part of the computer. See also 
Processor. 

Disks in the old format. Disks of virtual machines that were created in Parallels Desktop 2.5 and 
earlier or Parallels Workstation 2.2. 

Disks in the new format. Disks of virtual machines that were created or used in Parallels 
hardware virtualization products starting from version 3.0. 

Expanding format. A virtual hard disk format. An expanding virtual hard disk image file resides 
on your host computer and is small initially. Its size grows as you add applications and data to 
the virtual machine. 

FireWire connection. A wired connection that enables a high-speed data transmission between 
computers. 

Guest operating system (guest OS). An operating system installed inside your virtual machine. 
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Host computer: The computer that is used to run virtual machines. In case of Parallels 
Workstation Extreme for Mac, it is your Mac. In case of Parallels Workstation Extreme for 
Windows or Parallels Workstation Extreme for Linux, it is the Windows- or Linux-based 
physical computer where Parallels Workstation Extreme is installed. In the Parallels Transporter 
documentation, this term may define the computer that hosts the result of migration. 

Hot key. A user-defined key or combination of keys that provides quick access to applications 
and commands. See also Shortcut. 

HDD file. During the creation, the virtual machine acquires a virtual hard disk file with the .hdd 
extension. See also virtual hard disk file. 

Host-only networking. Virtual machine network connection mode that creates a private network 
between the host computer and its virtual machines, which makes the virtual machines available 
from the host computer only. 

ISO Image. A special file that contains the entire contents of a CD or DVD disc commonly used 
to install an operating system. 

Image file. A single file containing the complete contents and structure of a data storage medium 
or device, such as a hard disk drive, CD, or DVD. 

IP address. A unique address that is assigned to a physical computer or a virtual machine that 
participates in computer networking. 

Linux computer. A physical computer that has a Linux operating system installed. 

Merged disk. A split disk whose parts were merged into a single disk. 

Migration. The process of transferring data from a physical computer or a third-party virtual 
machine into a Parallels virtual machine or virtual disk. 

OS. An operating system. 

Parallels Desktop for Mac. An application that enables you to create, manage, and use virtual 
machines on your Mac. 

Parallels Desktop for Windows. An application that enables you to create, manage, and use 
virtual machines on a Windows-based physical computer. 

Parallels Desktop for Linux. An application that enables you to create, manage, and use virtual 
machines on a Linux-based physical computer. 

Parallels Explorer. An application that enables you to browse and manage the contents of your 
virtual machines without starting them. 

Parallels Image Tool. An application that enables you to manage the capacity and properties of 
your virtual machine's hard disk.  

Parallels Mounter. An application that enables you to to browse the contents of your virtual 
machines and virtual hard disks directly in Mac OS X Finder. 

Parallels Tools. A set of Parallels utilities that ensures a high level of integration between the 
primary and the guest operating systems. 
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Parallels Transporter. An application that uses data of a physical or virtual computer for creating 
a Parallels virtual clone of this physical or virtual computer. The resulting virtual machines can 
be used with Parallels Workstation Extreme. 

Parallels Transporter Agent. An application that collects data on a physical computer and 
transfers it to Parallels Transporter installed on the host computer. 

Parallels Workstation Extreme. An application that enables you to create, manage, and use virtual 
machines on a Windows or Linux computer. 

PCIe device. A video or network adapter corresponding to the PCI Express computer expansion 
card standard introduced by Intel in 2004. 

Plain format. A virtual hard disk format. A plain virtual hard disk image file resides on the host 
computer and has a fixed size that cannot be changed. 

Preboot Execution Environment (PXE). An environment to boot computers using a network 
interface independently of available data storage devices (like hard disks) or installed operating 
systems. 

Primary operating system (primary OS). Operating system that controls the I/O devices of the 
computer and that is loaded when the physical computer is turned on. It is the operating system 
of the physical computer where the Parallels Workstation Extreme application is installed. 

Processor. The central processing unit, or CPU. It is an internal part of the computer. 

PVS file. A virtual machine configuration file that contains information about the virtual machine 
resources, devices and other settings. 

Shared networking. Virtual machine network connection mode that allows the virtual machine to 
use the host computer network connections. In this mode, the virtual machine is invisible to 
other computers on the network the host computer belongs to. 

Shortcut. A user-defined key or combination of keys that provides quick access to applications 
and commands. See also Hot key. 

Snapshot. A copy of the virtual machine state at a particular point of time. The files related to 
snapshots are stored in a special subfolder in the virtual machine's folder. 

Source computer or source operating system: The computer that you are going to migrate data 
from. On physical source computers, Parallels Transporter Agent should be installed. 

System disk. A floppy disk that allows your computer to load the operating system. 

Split disk. A split disk is cut into 2 GB pieces, but is stored as a single HDD file. Split disks 
allow you to transfer the data stored on a split disk piece by piece using a USB drive or other 
media that have limited space and cannot store a large virtual hard disk image file. 

Terminal. In Mac OS and GNU/Linux operating systems, a utility that enables you to access the 
command line.  

Virtual hard disk (virtual disk). A file or group of files that emulates the virtual machine's hard 
disk. 
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Virtual machine. The computer emulated using Parallels Workstation Extreme. A virtual machine 
has its own virtual hardware and requires an operating system to control its hardware. The 
installed operating system and its applications are isolated inside the virtual machine and share 
physical hardware resources of the host computer. 

Third-party virtual machine. A virtual machine created in a third-party virtualization product, that 
can be converted to Parallels virtual machines with the help of Parallels Transporter. 

Virtual Machine Configuration. Like any physical computer, a virtual machine has it's own 
configuration which is set during the creation and can be later modified. The virtual machine 
configuration settings are stored in a PVS file. 

Virtual machine files. Files stored in a virtual machine folder. A virtual machine has at least two 
files: configuration file and virtual hard disk file. 

Virtual hard disk file. During the creation, the virtual machine acquires a virtual hard disk file 
with the .hdd extension. This file performs the functions of a real hard disk. See also HDD file. 

Virtual machine template. A virtual machine that can be cloned to multiple virtual machines that 
will have the same configuration and data that the virtual machine template had. 

VM. See Virtual Machine. 

Windows computer. A physical computer that has a Windows operating system installed. 
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